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About the Textbook

This textbook introduces students to the application methods of control charts to improve
quality in health care. The textbook is written to be accessible to any student in the
areas of health information management, health care informatics, and health care indus-
trial engineering. Having a basic background in statistics would be beneficial, but such
training is not a prerequisite to understanding how to apply the techniques discussed
here. Several How-To sections are included to demonstrate the implementation of the
given control charts using software such as Minitab and Excel. Additionally, samples
of a Python code are included and can directly be accessed in a Jupyter Notebook at
https://github.com/JeromeNN.

The textbook starts with Chapter 1, which contains introductory concepts of quality im-
provement using control charts. Chapter 2 reviews the Shewhart model and the related
charts. Chapter 3 shows how to apply time-weighted control charts to detect small shifts
in the process. Chapter 4 appraises various techniques for adjusting control charts to
account for factors such as autocorrelation and patient risk. Chapter 5 considers other
quality improvement techniques that relate to control charts. The Appendix presents fac-
tors for constructing variable control charts.

This textbook is not meant to be a comprehensive manuscript regarding quality improve-
ment in health care. Instructors and students can supplement the chapter reading with
additional resources, such as those referenced in the bibliography section of this text.
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CHAPTER 1

Basics of quality improvement

In this chapter, we introduce key concepts of quality improvement using
control charts. Our discussion includes background information about
control charts, the definition of the word “quality”, and the frameworks of
quality improvement. We also review basic notions of statistics that are
required to apply control charts to improve quality in health care.

Key concepts and tools: Quality; Quality improvement; Variability; Control charts;
DMAIC1; PDCA2; Shewhart model; Hypothesis testing; Central limit theorem; Out-
of-control behaviors; Special cause variation; Common cause variation; OCAP3

Major objectives
After studying this chapter, you will be able to:

1. Define critical concepts of quality improvement and control charts

2. Understand statistical measures of variability

3. Explain the basic notion of the central limit theorem

4. Compute and interpret standard sample statistics

5. Understand the construct of the Shewhart control chart model

6. Differentiate between special and common cause variation

7. Distinguish different types of control charts

8. Develop implementation strategies of control charts

9. Propose a quality improvement policy using control charts

10. Create an out-of-control action plan (OCAP)

1DMAIC: Define, Measure, Analyze, Improve, and Control
2PDCA: Plan, Do, Check, and Act
3OCAP: Out-of-control action plan

9



10 1.1. Introduction

1.1 Introduction

This book discusses applications of control charts to improve quality in health care. Con-
trol charts are essential tools of SPC4 that we utilize to monitor and improve quality.

1.1.1 What is quality?

The word quality is a broad term that means different things depending on the context.
For example, regarding a product, quality is often characterized using the following di-
mensions [29, 44]:

1. Performance: Will the product do the intended job?

2. Reliability: How often will the product fail?

3. Durability: How long will the product last?

4. Serviceability: How easily is the product fixed?

5. Aesthetics: What is the visual appeal of the product?

6. Features: What more can the product do?

7. Perceived quality: What is the reputation of the product or the company?

8. Conformance to standards: Is the product made as the designer intended?

A “quality product” is expected to be highly rated in all of the above dimensions. The
dimensions of a “quality service” are not as well defined. But, the following features are
often utilized to measure quality in general services [51]:

1. Tangibles: How is the physical appearance of the structure used to deliver a ser-
vice such as equipment, building, personnel, and communication materials?

2. Reliability: Is the service as advertised, and is it accurate?

3. Responsiveness: Is the service responsive to the immediate needs of the cus-
tomers?

4. Assurance: Is the service courteous, and do employees convey a sense of trust
and confidence?

5. Empathy: Does the service exhibit care about the individual needs of the cus-
tomer?

4SPC: Statistical Process Control
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In health care, we can apply these general dimensions of service quality to evaluate
administrative services such as patient registration, billing, bed management, and others.
But, we cannot easily apply these dimensions to measure the quality of medical care,
especially the reliability dimension, since, in most cases, we (patients) lack the technical
knowledge to determine the accuracy of the care that we receive. This phenomenon is
commonly known as information asymmetry.5 Even for experts, the task of measuring
the quality of health care is a daunting one given several factors to consider. One of
the commonly accepted methods for measuring health care quality is the Donabedian’s
Structure-Process-Outcome model depicted in Figure 1.1.

Structure Process Outcome

exa

Figure 1.1: Donabedian’s Structure-Process-Outcome model for measuring health care
quality

At the structure level of Donabedian’s paradigm, we measure the efficacy of re-
sources and administrative processes used to provide medical care. At the process
level, we evaluate the degree to which the applied medical standards are state-of-the-
art. At the outcome level, we measure the result of care, such as the patient’s health
status and satisfaction [23]. Specific quality measures that relate to different levels of the
Donabedian’s model can be found at the websites of the Joint Commission [18] and the
Centers for Medicare and Medicaid Services (CMS) [17].

1.1.2 Quality and variability

We can conceptualize quality as the state of meeting the desired standard, within
some acceptable tolerance. Accordingly, we apply the following definition to most cases
of quality improvement that we consider in this book:

Definition 1.1 (Quality)
Quality inversely relates to variability around the standard [44].

One implication of Definition 1.1 is that too much variability is associated with low
quality, whereas little variability relates to high quality. Another implication is that before
we can improve quality, we must know or be able to estimate the desired standard. In
other words, we need to understand what the customer expects or is willing to pay
for. In medical care, we must stay informed about the latest evidence-based standards
of delivering care. Additionally, we must be able to measure variability around these
standards. Then, to improve quality Definition 1.2:

5Information asymmetry in health care is the phenomenon where patients know less about the med-
ical care they buy than health care providers who provide it [28, 6, 7, 53].
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Definition 1.2 (Quality improvement)
Quality improvement is the reduction of variability around the desired standard
[44].

1.1.3 Variability in the process

Several methods exist to help assess variability in the process, including various sta-
tistical measures of variance and graphical tools. Among the most common graphical
techniques are control charts and histograms. We will return to statistical measures and
control charts later. Here, we briefly review how histograms work.

Constructing a histogram

A histogram is a type of bar chart that we use to asses variability in processes that gen-
erate continuous data. To construct this chart, we first group data into bins, also called
intervals or classes. We must choose an appropriate binning strategy for a histogram to
be informative. Given the lack of a universal agreement about how to structure the bins,
one common rule of thumb to select the number of bins 𝑘 such that:

𝑘 =
⌈︂√

𝑛
⌉︂

(1.1)

where 𝑛 is the number of observations in the data and the ceiling symbols ⌈.⌉ signify
rounding up. Another formula that we can use follows from Sturges’ rule and looks like
this [44]:

𝑘 = 1+ log2𝑛 (1.2)

where log is a mathematical symbol for logarithm. After deciding on the number of bins,
we calculate the width of each bin ℎ like this:

ℎ =
max(𝑥)−min(𝑥)

𝑘
(1.3)

where 𝑥 represents the sample data. Subsequently, we determine the range of the bins
as follows:

𝑏𝑖𝑛1 = [min(𝑥), min(𝑥) + ℎ+1) (1.4)
𝑏𝑖𝑛2 = [min(𝑥) + ℎ+1, 𝑚𝑖𝑛(𝑥) + 2ℎ+1) (1.5)

...

𝑏𝑖𝑛𝑘 = [min(𝑥) + (𝑘 − 1)ℎ+1, min(𝑥) + 𝑘ℎ+1) (1.6)

Finally, we throw each observation into the bin with a suitable range, and construct a
histogram by graphing a bar chart in ascending order of the bin index (e.g., 𝑏𝑖𝑛1, . . . , 𝑏𝑖𝑛𝑘).
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Interpreting a histogram

By visually examining the shape of a histogram, we can make inferences about the pro-
cess variability regarding the skewness, kurtosis, modality, and the likely probability distri-
bution. We can also learn about other characteristics of the process, such as the central
tendency (e.g., mean or median) and outliers. We show examples of typical histograms
in Figure 1.2.

Figure 1.2: Examples of histograms

(a) Unimodal (b) Multimodal

(c) Left skewed (d) Right skewed

Figure 1.2a shows a bell-shaped unimodal (one peak) histogram suggesting a normal
distribution with the mean around 100. Figure 1.2b shows a multimodal histogram that
suggests a mixture of probability distributions. Figure 1.2c shows a histogram with a
left-skewed distribution. Figure 1.2d displays a histogram with a right-skewed distribution
and a possible outlier in bin 100. Histograms with fewer outliers will generally have a
low kurtosis measure. The latter quantity describes the degree of the peakedness and
flatness (e.g., heavy-tail or light-tail) of the given distribution as compared to the normal
distribution [22].

1.1.4 Frameworks of quality improvement

The most commonly used models of quality improvement are the Plan, Do, Check, Act
(PDCA) cycle, and the Define, Measure, Analyze, Improve, Control (DMAIC) frame-
work.
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1.1.5 PDCA

Figure 1.3 portrays a graphical representation of the PDCA cycle, also called the She-
whart cycle or PDSA (where S stands for Study).

Figure 1.3: The PDCA cycle

Act Plan

Check Do

The arrow on the circle signifies the concept of “continuous” quality improvement. In
the Plan phase of this cycle, we propose changes or experiments to run. In the Do
phase, we carry out our plan, usually on a small scale. In the Check phase, we analyze
the results from the Do phase. In the Act phase, we fully implement changes or abandon
them. The cycle is iterated as many times as necessary to improve quality [44].

1.1.6 DMAIC

Figure 1.4 shows the basic phases of the DMAIC framework.

Figure 1.4: Phases of the DMAIC framework

Define Measure Analyze ControlImprove

The definition of each one of these phases follows [9, 30, 44].
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Define: In this phase, we define opportunities for improvement. Additionally, we create
flow charts, a project charter,6 and a SIPOC7 diagram.

Measure: In this phase, we collect data on key process input variables (KPIV) and key
process output variables (KPOV). We attempt to establish baseline measures for
WIP,8 VOC,9 PCE,10 cycle time, process completion rate, sigma level, and financial
metrics. At the end of the project, we will refer back to these initial measures to
assess how much improvement we have made.

Analyze: In this phase, we try to make sense of the data we collected in the Measure
phase by analyzing root cause, correlation, risk, stability, capability, and hypothesis
tests. One of the tools that we may apply here is the cause-and-effect diagram
to evaluate the causes of the quality problem. Another essential tool that we may
deploy is a preliminary control chart to assess the stability of the process.

Improve: This phase is probably the most difficult since we have to turn our analysis into
actions to improve the process. Creative thinking is imperative. To generate ideas
for improvement, we may have to hold brainstorming sessions, not only with current
process stakeholders but also with experts and the crowd [42]. One particularly
useful statistical tool that we can employ here is DOE11 [44]. For problems related
to efficiency and cycle times, we can employ Lean techniques to eliminate non-
value-added activities from the process. We continue to apply these improvement
tools until control charts signal that the process is stable.

Control: In this phase, we implement tools to monitor the process, such as control
charts, run charts, and dashboards. To the extent possible, we should automate
this phase. Otherwise, we must develop a sampling plan to audit and monitor
the new process. Additionally, we must create an out-of-control plan (OCAP) to
prescribe actions to be taken when out-of-control behaviors arise in the improved
process.

1.1.7 Technical aspects of quality improvement

We have previously mentioned that we cannot improve quality if we don’t know the stan-
dard. If the standard is not given, we need to know how to approximate it from the
process samples. Additionally, we must be able to measure variability if we are to reduce
it to improve quality. All these activities require technical skills that, without them, quality
improvement efforts may fail. Indeed, it is believed that the movement of total quality
improvement (TQM) in the 1980s was not overly successful, partly because of the lack

6Project charter: a short document with clear statements about the goal, the business case, the op-
portunity, the project scope, plan, and team for quality improvement [44]

7SIPOC: Suppliers, Inputs, Process, Outputs, and Customers
8WIP: Work-in-Process (e.g., work yet to be finished)
9VOC: Voice of the Customer (e.g., customer feedback)

10PCE: Process Cycle Efficiency
11DOE: Design of Experiments
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of emphasis on statistical aspects of quality improvement [44]. The strategy that tends
to emphasize technical skills more is Lean Six-Sigma. The Lean part of this strategy
focuses on making processes efficient. The Six-Sigma part utilizes statistical techniques
to reduce variability in the process to reach a performance state of no more than 3.4
defective parts per million (PPM) opportunities (DPMO) in the process [30]. Statistical
process control (SPC) is another strategy that emphasizes the reduction of variation to
achieve the stability and capability of the process. The seven primary tools of SPC, which
are also encountered in the Lean Six-Sigma strategy, are [44]:

1. Histograms or stem-and-leaf plots to visually assess the distribution of the pro-
cess given the central tendency and variance. These tools may also help evaluate
the process capability to meet the given quality specifications.

2. Checksheets to help collect and tabulate the process data by frequency, time,
location, and cause.

3. Pareto charts to identify the “vital few” factors causing the majority of quality prob-
lems. A common analytical method applied here is the 80/20 rule that implies that
20% of the factors cause 80% of the problems.

4. Cause-and-effect diagrams to help analyze the root causes of the given effect.
The causes are often categorized by factors such as materials, machines, mea-
surement, people, methods, and policy.

5. Defect concentration diagrams to model the spatial distribution of defects on a
particular product.

6. Scatter diagrams to characterize the relationship between two variables in the
process. We often seek to conclude positive correlation, negative correlation, or no
correlation between the variables under study.

7. Control charts to monitor the process behaviors over time or by the sample num-
ber. Control charts help detect and reduce special cause variation in the process.

In this book, we focus on the applications of control charts to improve quality in
health care. In the next section, we review the basic statistical concepts that we will need
to put these charts into practice.

1.2 Statistical background

In this section, we introduce basic statistical concepts that are requisite for the imple-
mentation of control charts. Some of the topics we highlight include process sampling,
common probability distributions, point estimation, confidence intervals, hypothesis test-
ing, correlation analysis, and regression.
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1.2.1 Process sampling

Sample

In most quality improvement projects, it is not practical to observe and record everything
that is happening in the process at all times. Even if such efforts were practical, they
would likely be prohibitively expensive and time-consuming. A simplified approach is to
use portions of the process to infer the performance of the entire process.

Definition 1.3 (Sample)
A sample, also referred to as subgroup, is a smaller set of measurements that we
take from a larger set of the population measurements.

Terminology

We use the word population to suggest the entire process and the term statistic to
indicate a statistical measure of the process, such as the mean (or the average) and the
variance. The words infer and inference imply that we are making conclusions about
the population using sample statistics. We will frequently use the expression sampling
distribution to refer to the probability distribution of any sample statistic, most often the
sample mean. We use letter 𝑛 to denote the sample size (e.g., number of features) and
letter 𝑚 to symbolize the total number of samples that we call sample number (e.g.,
number of training examples).

Sampling techniques

Several sampling techniques apply to quality improvement, such as random sampling,
where each item in the process has an equal chance of being selected. In systematic
sampling, we set conditions for including an item in the sample (e.g., selecting every item
in a prescribed position). In stratified sampling, we create distinct strata (e.g., groups)
and choose an item from each stratum randomly or systematically. In cluster sampling,
we group the population into naturally occurring clusters (e.g., geographical regions) and
then sample from each cluster randomly or systematically. Both the stratified and cluster
sampling techniques tend to reduce bias by representing all relevant segments of the
population [39].

Sampling musts

We must choose the proper sample size and the frequency of sampling to allow for
more accurate inferential conclusions about our process. This requirement is particularly
important for successful deployments of control charts to monitor the stability of the pro-
cess. One rule of thumb is to take at least 25 samples before drawing any conclusions
about the stability of a process [44]. In general, the larger the sample size, the more
likely we are to detect unstable instances or out-of-control behaviors in the process. But,
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the practicality of large samples is not always feasible. Instead, we try to take smaller
samples, but more frequently [44].

It is also imperative that when sampling, we ensure rational subgroups to promote
the independence of the samples. By this, we imply that we should seek to maximize the
difference between the samples while minimizing the difference within each sample. A
natural approach to obtaining rational subgroups is sampling from units produced dur-
ing the same time interval (e.g., same day). Another approach is sampling only from
units produced since the last subgroup [44]. Without rational subgroups, erroneous
conclusions about the stability of the process are likely, especially when samples were
initially assumed to be independent.

1.2.2 Sample statistics

Typical sample statistics include the mean 𝑥, the variance 𝑠2, and the standard devia-
tion 𝑠 =

√
𝑠2. Given a sample of size 𝑛, say (𝑥1,𝑥2, . . . ,𝑥𝑛), we calculate the statistics 𝑥,

𝑠2, and 𝑠, as follows:

𝑥 =
1
𝑛

𝑛∑︁
𝑖=1

𝑥𝑖 (1.7)

𝑠2 =
1

𝑛− 1

𝑛∑︁
𝑖=1

(𝑥𝑖 − 𝑥)2 (1.8)

𝑠 =

⎯⎷
1

𝑛− 1

𝑛∑︁
𝑖=1

(𝑥𝑖 − 𝑥)2 (1.9)

We commonly refer to
∑︀𝑛

𝑖=1(𝑥𝑖 − 𝑥)2 as the sum of squares (SS) and 1
𝑛−1

∑︀𝑛
𝑖=1(𝑥𝑖 − 𝑥)2

as the mean square (MS). Here, 𝑛 − 1 signifies the degrees of freedom or simply the
number of independent values in a statistic [38]. We use the sample mean to estimate
the average behavior of the process. Both the variance and standard deviation are non-
negative measures of variability in the process. The bigger these quantities, the more
variable the process and thus the inferior the quality. Unlike the variance which expresses
squared variation measures, the standard deviation quantifies the process variability in
the original units.

How-To 1.1 (Sample statistics in Excel 2013)

1. To calculate the sample mean, use the 𝐴𝑉𝐸𝑅𝐴𝐺𝐸() function.

2. To calculate the sample variance, use the 𝑉𝐴𝑅.𝑆() function.

3. To calculate the sample standard deviation, use the 𝑆𝑇𝐷𝐸𝑉 .𝑆() function.

You can also calculate sample statistics via the Data Analysis add-in > Descriptive
Statistics > select your input range > check the option of Statistics summary > OK.

If the Data Analysis add-in is not loaded in your Excel spreadsheet, you can
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add it by clicking on File >Options > Add-ins > Analysis ToolPak > Manage: Excel
Add-in > Check the box of Analysis ToolPak >OK.

How-To 1.2 (Sample statistics in Minitab 18)
To calculate the sample mean, variance, and standard deviation in Minitab 18, click
on Stat > Basic Statistics > Display Descriptive Statistic > load your data into Vari-
ables >OK.

How-To 1.3 (Python 3.6)

Script 1.1: A script for running descriptive statistics in Python 3.6

#Python 3.6 has several modules that one could use to compute sample

statistics.

#One of these modules is Pandas that allows for the calculation of

descriptive statistics as follows

#import pandas

from pandas import *
#import your sample data from Excel. The column name in Excel is

Defects. The Sheet name is Data.

data = read_excel(r’C:\..\How-To1.3.xlsx’,’Data’)

data = data.Defects

#print the sample mean, variance, and standard deviation,

respectively

print (data.mean(), data.var(), data.std())

1.2.3 Probability distributions

Several probability distributions apply for quality improvement in health care.

Definition 1.4 (Probability distribution)
A probability distribution is a mathematical function that relates each value of a
random variable to a real number between 0 and 1 to express the relative chances
of that value occurring.

In Box 1.1, we grouped the most common probability distributions into classes of dis-
crete and continuous. We apply discrete distributions to model processes that generate
random attribute data (e.g., number of data entry errors), whereas we use continuous
distributions to model processes that generate random variable data (e.g., duration of
system downtime).
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Box 1.1 Common Probability Distributions

Type Name
Probability
Distribution

Mean
𝜇 =

Variance
𝜎2 =

Discrete

Bernoulli 𝑝(𝑥) =

⎧⎪⎪⎨⎪⎪⎩𝑝 𝑥 = 1
1− 𝑝 𝑥 = 0

𝑝 𝑝(1− 𝑝)

Binomial
𝑝(𝑥) =

(︃
𝑛
𝑥

)︃
𝑝𝑥(1− 𝑝)𝑛−𝑥

𝑥 = 0,1, . . . ,𝑛
𝑛𝑝 𝑛𝑝(1− 𝑝)

Geometric 𝑝(𝑥) = (1− 𝑝)𝑥−1𝑝
𝑥 = 1,2, . . .

1
𝑝

1− 𝑝
𝑝2

Poisson 𝑝(𝑥) =
𝑒−𝜆𝜆𝑥

𝑥!
𝑥 = 0,1, . . . ;𝜆 > 0

𝜆 𝜆

Continuous
Normal

𝑓 (𝑥) =
1

𝜎
√
2𝜋

𝑒−
1
2(

𝑥−𝜇
𝜎 )2

−∞ < 𝑥 <∞
−∞ < 𝜇 <∞,𝜎 > 0

𝜇 𝜎2

Exponential 𝑓 (𝑥) = 𝜆𝑒−𝜆𝑥

𝑥 ≥ 0;𝜆 ≥ 0
1
𝜆

1
𝜆2

It follows that for discrete distributions, 0 ≤ 𝑝(𝑥) ≤ 1 and
∑︀

𝑥 𝑝(𝑥) = 1. For continu-

ous random variables, 0 ≤ 𝑝(𝑎 ≤ 𝑥 ≤ 𝑏) =
∫︀ 𝑏

𝑎
𝑓 (𝑥)𝑑𝑥 ≤ 1 and

∫︀∞
−∞ 𝑓 (𝑥)𝑑𝑥 = 1.

1.2.4 Normal distribution

During quality improvement projects, we tend to assume that our samples were drawn
from a normally distributed process. This common assumption is the result of the
central limit theorem (CLT).

CLT

Definition 1.5 (CLT and the sample mean)
Regardless of the population probability distribution, the sampling distribution of the
sample mean 𝑥 with size 𝑛, drawn from a population with mean 𝜇 and variance 𝜎2,
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is about normally distributed and can be modeled as follows [44].

𝑥 ∼𝑁𝑜𝑟𝑚𝑎𝑙

(︃
𝜇,

𝜎2

𝑛

)︃
(1.10)

It follows that as 𝑛→∞,

𝑍 =
𝑥 −𝜇
𝜎/
√
𝑛
∼𝑁𝑜𝑟𝑚𝑎𝑙(0,1) (1.11)

We commonly refer to the 𝑍 statistic in Definition 1.5 as the Z-score. The numerator
of this statistic, 𝑥 − 𝜇, is known as the sampling error whereas its denominator, 𝜎/

√
𝑛,

is referred to as the standard error [38]. By mapping 𝑍 into a probability space, as
Φ(𝑍), we obtain the probability 𝑝 of a given standard value being less than 𝑍. To find the
probability of a standard value being greater than Z, we calculate 1−Φ(𝑍). It follows that
𝑍 = Φ−1(𝑝).

How-To 1.4 (Φ(𝑍) in Minitab 18)
Store your Z-score value in a given column then click on Calc > Probability Distri-
butions > Normal > Input column >OK.

How-To 1.5 (Φ(𝑍) in Excel 2013)
To calculate Φ(𝑍) in Excel 2013, use this cumulative distribution function: =
𝑁𝑂𝑅𝑀.𝑆.𝐷𝐼𝑆𝑇 (𝑍,1).

How-To 1.6 (Python 3.6)

Script 1.2: A script for computing the inverse of Z-score in Python 3.6

#import norm from Scipy

from scipy.stats import norm

Z = x#some given constant x

#print the standard inverse of Z, which is a probability.

print norm.cdf(Z)

Sampling distributions related to Normal

Typical sampling distributions that relate to Normal are Chi-square ( 𝜒2), t-distribution,
and F-distribution. We characterize these distributions as follows:

1. Given independent and normally distributed sample data points 𝑥1,𝑥2, . . . ,𝑥𝑛, where
𝜎 is known, 𝑦 = 𝑥21 +𝑥22 + · · ·+𝑥2𝑛 is distributed according to 𝜒2 with 𝑛−1 degrees of
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freedom (𝜒2
𝑛−1). We can express 𝑦 as follows [44]:

𝑦 =
1
𝜎2

𝑛∑︁
𝑖=1

(𝑥𝑖 − 𝑥)2 (1.12)

≡ (𝑛− 1)𝑠2

𝜎2 ∼ 𝜒2
𝑛−1 (1.13)

2. If 𝜎 is unknown, if follows that:

𝑥 −𝜇
𝑠/
√
𝑛
∼𝑁 (0,1)

⧸︃√︃
𝜒2
𝑛−1

𝑛− 1
(1.14)

We refer to Equation 1.14 as the t-distribution, or Student’s t-distribution, with
𝑛 − 1 degrees of freedom [44]. We typically use this distribution to compare the
means between two small samples, where we don’t know the population standard
deviation.

3. The ratio between two independent Chi-square random variables 𝑤 and 𝑦 with
respective degrees of freedom 𝑢 and 𝑣, is distributed according to F-distribution,
as follows [44]:

𝐹𝑢,𝑣 =
𝑤/𝑢
𝑦/𝑣

(1.15)

We often use the F-distribution in the analysis of variance (ANOVA) to test the
equality of the means from independent samples drawn from normally distributed
populations with equal variances.

1.2.5 Probability plots

A probability plot is a visual statistical tool that we can employ to validate our assumptions
regarding the probability distribution of our process. We can approximate a probability
plot by fitting a line to data (e,g., data that fall between the 25th and the 75th percentiles)
[44]. If the hypothesized probability distribution were reasonable, points would fall along
the fitted line. We will often use this technique to verify the normality assumption.

How-To 1.7 (Python 3.6)

Script 1.3: A script for graphing a normal probability plot in Python 3.6

#import stats from scipy

from scipy import stats

import matplotlib.pyplot as plt #a plotting module

import seaborn as sns # an optional module to prettify the plot

fig = plt.figure()

ax = fig.add_subplot(111)
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x = [...] #x is an array of your data

stats.probplot(x, plot=ax)

sns.despine(offset=10, trim=False)

plt.show()

How-To 1.8 (Normal probability plot in Minitab 18)
Click on Graph > Probability Plot > Single >Select your data > OK. To change the
type of distribution, click on the Distribution tab. See the snapshot in Figure 1.5.

Figure 1.5: Options for a normal probability plot in Minitab 18

1.2.6 Point estimators

In this subsection, we review the point estimation methods for the population mean and
standard deviation parameters.

Definition 1.6 A point estimator is a statistic that we calculate from the process
samples to estimate the population parameter [44].

The sample mean 𝑥 and variance 𝑠2 are unbiased point estimators of the correspond-
ing population mean 𝜇 and variance 𝜎2 since

𝐸(𝑥) = 𝜇 (1.16)
𝐸(𝑠2) = 𝜎2 (1.17)
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Here, 𝐸 symbolizes expectation. But, the sample standard deviation is a biased point
estimator of the population standard deviation 𝜎 , since

𝐸(𝑠) , 𝜎 (1.18)

Continuous process

For continuous processes with the sample size 𝑛 > 10, we can approximate the unbiased
estimator of 𝜎 this way:

𝜎 ≈ 𝑠
𝑐4

(1.19)

where 𝑠 is the mean of the sample standard deviations and 𝑐4 is a constant that varies
with 𝑛, as indicated in Appendix Table 12. When the sample size 𝑛 ≤ 10, we approximate
the unbiased estimator of 𝜎 as follows:

𝜎 ≈ 𝑅̄
𝑑2

(1.20)

where 𝑅̄ is the mean of sample ranges and 𝑑2 is a constant that also varies with 𝑛, as
indicated in Appendix Table 12 [44].

Discrete processes

For processes that generate attribute data, we can approximate the mean 𝜇 like this:

𝜇 ≈ 𝑝̄ (1.21)

where 𝑝̄ is the mean of the corresponding Bernoulli distribution. We apply the following
approximation for the standard deviation 𝜎 :

𝜎 ≈ 𝜎 =

√︂
𝑝̄(1− 𝑝̄)

𝑛
(1.22)

where 𝑛 denotes sample size as before.

1.2.7 Confidence interval

In the previous subsection, we discussed point estimators. In this subsection, we extend
this concept into the related topic of the confidence interval.

Definition 1.7 A confidence interval is a range constructed from sample statistics
to estimate a probabilistic interval that covers a given population parameter [38]

We create a confidence interval by setting lower and upper confidence limits of a param-
eter of interest. Here, we only review how to generate the confidence intervals of the
population mean 𝜇 and variance 𝜎2 when the population is normally distributed.
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Given a lower confidence limit 𝐴 and an upper confidence limit 𝐵, we denote the
probability of the population mean 𝜇 falling between 𝐴 and 𝐵 as follows:

𝑃 {𝐴 ≤ 𝜇 ≤ 𝐵} = 1−𝛼 (1.23)

where 𝛼 is the significance level or the error that we are willing to commit. Using 𝛼, we
calculate the percentage of our confidence level this way: 100(1-𝛼)%. Equation 1.23
reflects a two-sided confidence interval. A one-sided confidence interval looks like this:

𝑃 {𝐴 ≤ 𝜇} = 1−𝛼 or 𝑃 {𝜇 ≤ 𝐵} = 1−𝛼 (1.24)

The confidence interval of the population mean 𝜇

Assuming normally distributed population, we construct a confidence interval of 𝜇 by
considering the following two cases:

Case 1: a confidence interval of 𝜇 when 𝜎 is known
From the notion of CLT in Definition 1.5, we use the standardized value 𝑍 to con-
struct the confidence interval of 𝜇 this way:

𝜇 = 𝑥 ±𝑍𝛼/2
𝜎
√
𝑛

(1.25)

where 𝛼/2 signifies a two-sided confidence interval. In a one-sided confidence
interval, we replace 𝛼/2 with 𝛼. We typically construct this confidence interval
when the sample size 𝑛 is large enough to allow for good point estimation of the
population standard deviation (e.g., 𝑛 ≥ 30 [38]).

Case 2: a confidence interval of 𝜇 when 𝜎 is unknown
In this case, we use the t-distribution to determine the confidence interval of 𝜇.
Using Equation 1.14, we proceed as follows:

𝜇 = 𝑥 ± 𝑡𝛼/2,𝑛−1
𝑠
√
𝑛

(1.26)

where 𝑠 is the sample standard deviation, and 𝑛 − 1 represents the degrees of
freedom. In a one-sided confidence interval, we replace 𝛼/2 with 𝛼. We typically
employ this confidence interval technique for smaller sampler sizes (e.g., 𝑛 < 30
[38])

The confidence interval of the population variance 𝜎2

When the population is normally distributed, and we know neither the mean 𝜇 nor the
variance 𝜎2, we use sample statistics and the Chi-square distribution 𝜒2 to create a two-
sided confidence interval for 𝜎2, as follows [44]:
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(𝑛− 1)𝑠2

𝜒2
𝛼/2,𝑛−1

≤ 𝜎2 ≤ (𝑛− 1)𝑠2

𝜒2
1−𝛼/2,𝑛−1

(1.27)

Here, 𝑠2 is the sample variance, and 𝑛 − 1 represents the degrees of freedom. We
determine a one-sided confidence interval this way:

𝜎2 ≤ (𝑛− 1)𝑠2

𝜒2
1−𝛼,𝑛−1

(1.28)

How-To 1.9 (Confidence intervals of 𝜇 and 𝜎2 in Minitab 18)
Click on Stats > Basic Statistics. For the confidence interval of 𝜇 when 𝜎 is known,
choose 1-Sample Z. For the confidence interval of 𝜇 when 𝜎 is unknown, choose
1-Sample t. For the confidence interval of 𝜎2, choose 1 Variance. Note: Minitab
may give you the confidence interval of the standard deviation, instead of that of
the variance. Simply square the given limits to obtain the confidence interval of the
variance. See the snapshot in Figure 1.6.

Figure 1.6: Options for the confidence intervals of 𝜇 and 𝜎2 in Minitab 18

How-To 1.10 (Confidence intervals of 𝜇 and 𝜎2 in Excel 2013)
There is no special option in Excel to calculate confidence intervals, but we can use
the built-in functions to estimate the interval of interest. For example, we estimate
the confidence interval for the population mean like this:
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1. When 𝜎 is known, we use the function = −𝑁𝑂𝑅𝑀.𝑆.𝐼𝑁𝑉 (𝛼/2) to de-
termine 𝑍𝛼/2. For example, when 𝛼 = 0.05, we find 𝑍0.05/2 = 𝑍0.025 by
= −𝑁𝑂𝑅𝑀.𝑆.𝐼𝑁𝑉 (0.025) = 1.96.

2. When 𝜎 is unknown, we use the function = −𝑇 .𝐼𝑁𝑉 (𝛼/2,𝑛−1) to obtain the
critical value of the t-distribution. For example, when 𝛼 = 0.05, and 𝑛 = 10, we
find the critical value by = −𝑇 .𝐼𝑁𝑉 (𝛼/2,𝑛− 1) = −𝑇 .𝐼𝑁𝑉 (0.025,9) = 2.262.

We can use Excel to construct the confidence interval for the population variance
𝜎2 by first determining the pertaining values of the Chi-square distribution. For
example, we determine 𝜒2

1−𝛼/2,𝑛−1 as = 𝐶𝐻𝐼𝑆𝑄.𝐼𝑁𝑉 .𝑅𝑇 (1−𝛼/2,𝑛−1). To obtain
𝜒2
𝛼/2,𝑛−1, we use this function: = 𝐶𝐻𝐼𝑆𝑄.𝐼𝑁𝑉 .𝑅𝑇 (𝛼/2,𝑛− 1).

How-To 1.11 (Python 3.6)

Script 1.4: A script for calculating confidence intervals in Python 3.6

#modules to import

from scipy.stats import norm

from scipy.stats import t

from scipy.stats import chi2

from numpy import *
from pandas import *
#confidence interval of mu when sigma is known

data = read_excel(your directory) #import data from Excel

data = data.Defects# The column name in Excel is Defects.

xbar = data.mean()

sigma = ...#given

alpha = ...#given (e.g., alpha = 0.05)

Z = norm.ppf(1-alpha/2.)

N = len(data)#sample number

A = xbar -Z*sigma/sqrt(N)#lower confidence limit

B = xbar +Z*sigma/sqrt(N)#upper confidence limit

print (A, B)

1.2.8 Hypothesis testing

We conduct a hypothesis test to evaluate the likelihood of our belief about the value of
the population parameter. During hypothesis testing, we make two statements. Our first
statement that we call the null hypothesis or 𝐻0 expresses our belief that the population
parameter equals a particular value or falls within a given range. Our second statement
that we call an alternative hypothesis or 𝐻1, opposes the first statement. We reject 𝐻0,
when a derived test statistic is greater than a given critical value or when the 𝑝-𝑣𝑎𝑙𝑢𝑒
< 𝛼. Otherwise, we fail to reject 𝐻0. As before, 𝛼 is the significance level, or simply the
error that we are willing to commit.
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Hypothesis test for the process mean

We start by assuming that 𝜇 = 𝜇0, where 𝜇0 is the conjectured value. We formulate a
two-tailed or two-sided hypothesis test as follows:

𝐻0 : 𝜇 = 𝜇0 (1.29)
𝐻1 : 𝜇 , 𝜇0 (1.30)

Alternatively, we can create a one-tailed or one-sided test this way:

𝐻0 : 𝜇 = 𝜇0 (1.31)
𝐻1 : 𝜇 < 𝜇0 (1.32)

or as:

𝐻0 : 𝜇 = 𝜇0 (1.33)
𝐻1 : 𝜇 > 𝜇0 (1.34)

Next, we find and compare the test statistic 𝑍0 to the corresponding critical value 𝑍𝛼.
In a normally distributed process where 𝜎 is known, we refer to our hypothesis test as
the Z-test. We obtain the test statistic 𝑍0 as follows:

𝑍0 =
𝑥 −𝜇
𝜎/
√
𝑛

(1.35)

The critical value is given by 𝑍𝛼/2 in a two-sided test or 𝑍𝛼 in a one-sided test. We reject
𝐻0 when |𝑍0| > 𝑍𝛼/2 in a two-sided test or when |𝑍0| > 𝑍𝛼 in a one-sided test. We use |.|
symbols to denote the absolute value function. When the population standard deviation
𝜎 is unknown, we conduct a t-test, instead of a Z-test, and obtain the test statistic 𝑡0
this way:

𝑡0 =
𝑥 −𝜇
𝑠/
√
𝑛

(1.36)

Given the degrees of freedom 𝑛−1, the critical value is obtained by 𝑡𝛼/2,𝑛−1 in a two-sided
test or 𝑡𝛼,𝑛−1 in a one-sided test. In a two-sided test, we reject 𝐻0 when |𝑡0| > 𝑡𝛼/2,𝑛−1. In
a one-sided test, we reject 𝐻0 when |𝑡0| > 𝑡𝛼,𝑛−1.

Hypothesis test for the process variance

We structure a hypothesis test for the process variance like this:

𝐻0 : 𝜎
2 = 𝜎2

0 (1.37)
𝐻1 : 𝜎

2 , 𝜎2
0 (1.38)

where 𝜎2
0 is the variance that we have conjectured. Alternatively, we could set 𝐻1 : 𝜎2 >

𝜎2
0 or 𝐻1 : 𝜎2 < 𝜎2

0 . Assuming normal distribution and unknown population mean and
variance, we use the Chi-square distribution to obtain the test statistic, 𝜒2

0 , as follows:

𝜒2
0 =

(𝑛− 1)𝑠2

𝜎2
0

(1.39)
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We recall that 𝑠2 is the sample variance, and 𝑛 − 1 represents the degrees of freedom.
The two-sided critical value is given by 𝜒2

𝛼/2,𝑛−1. We reject the null hypothesis when
𝜒2
0 > 𝜒2

𝛼/2,𝑛−1 or 𝜒2
0 < 𝜒2

1−𝛼/2,𝑛−1. The critical value in a one-sided test is 𝜒2
𝛼,𝑛−1. For

𝐻1 : 𝜎2 > 𝜎2
0 , we reject the null hypothesis when 𝜒2

0 > 𝜒2
𝛼,𝑛−1. For 𝐻1 : 𝜎2 < 𝜎2

0 , we reject
the null hypothesis when 𝜒2

0 < 𝜒2
1−𝛼,𝑛−1 [44].

1.2.9 P-value

We have briefly introduced p-value before as a probability measure of a hypothesis test.
We formally define this quantity next.

Definition 1.8 (P-value)
𝑝-𝑣𝑎𝑙𝑢𝑒 is the probability that one would observe a test statistic that was greater or
equal to the given critical value, if the null hypothesis were true [38]

We recall that the critical value is a statistic that we construct using the confidence
level 𝛼. When 𝑝-𝑣𝑎𝑙𝑢𝑒 < 𝛼, we reject the null hypothesis. Most statistical packages,
such as Minitab, provide us with p-values automatically when we run hypothesis tests. In
a normal distribution, we calculate p-values as follows [44]:

1. 𝐻1 : 𝜇 , 𝜇0, p-value = 2(1−Φ(|𝑍0|))

2. 𝐻1 : 𝜇 > 𝜇0, p-value = 1−Φ(𝑍0)

3. 𝐻1 : 𝜇 < 𝜇0, p-value = Φ(𝑍0)

𝑍0 is the test statistic that we obtain per Equation 1.35.

1.2.10 The type of error

While testing our hypothesis, we are likely to make two types of errors:

Type I error (𝛼): we reject 𝐻0 when 𝐻0 is true.

Type II error (𝛽): we fail to reject 𝐻0 when 𝐻0 is false.

Operationally speaking, the 𝛼 error is equivalent to erroneously rejecting the quality of a
good product or service. In control chart applications, this type of error is also referred to
as false alarm and signifies the chances of observing erroneous out-of-control signals.
The 𝛽 error is equivalent to mistakenly delivering a bad product or service to the customer
[44]. We choose 𝛼 to indicate the error probability that we are willing to tolerate. When
our process is normally distributed, we typically set 𝛼 = 0.05 and determine 𝛽 this way
[44]:

𝛽 = Φ

(︃
𝑍𝛼/2 −

𝛿
√
𝑛

𝜎

)︃
−Φ

(︃
−𝑍𝛼/2 −

𝛿
√
𝑛

𝜎

)︃
(1.40)



30 1.2. Statistical background

Here, 𝛿 is the difference between the true process parameter and the hypothesized pa-
rameter. For example in the context of the mean, 𝛿 = 𝜇1 − 𝜇0, where 𝜇1 is the true
mean and 𝜇0 is the hypothesized mean. From the 𝛽 error, we obtain the power of our
statistical test as like this:

𝑃 𝑜𝑤𝑒𝑟 = 1− 𝛽 (1.41)

This power test expresses the probability of rejecting the null hypothesis correctly. To
increase the power test, we increase the sample size 𝑛, which in turn decreases 𝛽 per
Equation 1.40. The operating-characteristic (OC) curves can help us choose the proper
sample size to satisfy a particular value of 𝛽 [44]. Minitab has an option for obtaining the
appropriate sample size 𝑛 when the desired power test is provided. Minitab instructions
for the power of 1-sample Z test are shown in 1.12.

How-To 1.12 (Power for 1-sample Z test in Minitab 18)
Click on Stat > Power and Sample Size > select the test of interest. For example,
to determine the sample size in 1-Sample Z Test, leave the sample size field blank,
and specify the difference that you want to detect 𝛿. You also need to specify the
population standard deviation and the desired power value. See the snapshot in
Figure 1.7.

Figure 1.7: Power and Sample Size for 1-Sample Z Test in Minitab 18

How-To 1.13 (Python 3.6)

Script 1.5: A script for the power of 1-sample t test in Python 3.6
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#import tt_solve_power from statsmodels to run power test one sample

t test

from statsmodels.stats.power import tt_solve_power

#https://www.statsmodels.org/stable/generated/statsmodels.stats.power

.tt_ind_solve_power.html

delta = ...#absolute difference given by mu1 - mu0

sigma = ... #standard deviation

effect_size = delta/sigma

alpha = ...#given (e.g., 0.05)

#solve for the sample size (nobs), given the target power

power =...#given (e.g., 0.8)

sample_size = tt_solve_power(effect_size=effect_size, nobs= None,

alpha=alpha, power=power, alternative=’two-sided’)

print (sample_size)

#solve for the power, given the sample size

sample_size = ...#given

sample_power = tt_solve_power(effect_size=effect_size, nobs=

sample_size, alpha=alpha, power=None, alternative=’two-sided’)

print (sample_power)

1.2.11 Comparing the means of two independent samples

We can use hypothesis testing to check whether the means of two independent samples
were drawn from the same population or two similarly distributed populations. To test
whether the population means, 𝜇1 and 𝜇2, are equal, we obtain two samples of sizes 𝑛1
and 𝑛2 and means 𝑥1 and 𝑥2, respectively. We formulate the null hypothesis like this:

𝐻0 : 𝜇1 = 𝜇2 (1.42)

We frame alternative hypotheses as 𝐻1 : 𝜇1 , 𝜇2, 𝐻1 : 𝜇1 > 𝜇2, or 𝐻1 : 𝜇1 < 𝜇2. Assuming
a normally distributed population with the known variance 𝜎2, we apply the Z-test and
obtain the test statistic as follows:

𝑍0 =
𝑥1 − 𝑥2

𝜎
√︁

1
𝑛1

+ 1
𝑛2

(1.43)

If the variance is unknown, we apply the t-test and obtain the test statistic like this:

𝑡0 =
𝑥1 − 𝑥2

𝑠𝑝
√︁

1
𝑛1

+ 1
𝑛2

(1.44)

Here, 𝑠𝑝 is the square root of the pooled variance 𝑠2𝑝 that is computed this way:

𝑠2𝑝 =
(𝑛1 − 1)𝑠21 + (𝑛2 − 1)𝑠22

𝑛1 +𝑛2 − 2
(1.45)

where 𝑛1 + 𝑛2 − 2 represents the degrees of freedom from two samples [38]. We obtain
critical values and conclude about the null hypothesis as before.
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1.2.12 Comparing the means of more than two independent sam-
ples

Under the assumptions of the normal distribution, independence, and equal variances,
we can test the following hypothesis [38]:

𝐻0 : 𝜇1 = 𝜇2 = · · · = 𝜇𝑚 (1.46)
𝐻1 : the means are not all equal (1.47)

Here, 𝑚 is the index of the samples. Using the Analysis of Variance (ANOVA) test, we
obtain the following test statistic:

𝐹0 =
𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑒𝑟𝑟𝑜𝑟
(1.48)

where 𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 symbolizes independent samples, 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 is the mean square of
treatments, and 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 is the mean square of the error. Our critical value originates
from the F-distribution and looks like this:

𝐹𝛼,𝑚−1,𝑚(𝑛−1) (1.49)

If 𝐹0 > 𝐹𝛼,𝑚−1,𝑚(𝑛−1), we reject the null hypothesis. We will return to the topic of ANOVA
in Section 5.3.3.

1.2.13 Comparing the means of two dependent samples

When two samples are dependent, we conduct hypothesis testing using the paired t-
test. Our test statistic looks like this:

𝑡0 =
𝑑

𝑠𝑑/
√
𝑛

(1.50)

where 𝑑, the mean of the difference between two samples (each with size 𝑛), is given by:

𝑑 =
1
𝑛

𝑛∑︁
𝑗=1

𝑑𝑗 (1.51)

From Equation 1.50, 𝑠𝑑 is the standard deviation of the differences, which is obtained by
taking the square root of the variance 𝑠2𝑑 , given by:

𝑠2𝑑 =
1

𝑛− 1

𝑛∑︁
𝑗=1

(𝑑𝑗 − 𝑑)2 (1.52)

As before, the critical value is given by 𝑡𝛼/2,𝑛−1 in a two-sided test or 𝑡𝛼,𝑛−1 in a one-sided
test. In a two-sided test, we reject 𝐻0 when |𝑡0| > 𝑡𝛼/2,𝑛−1. In the one-sided test, we reject
𝐻0 when |𝑡0| > 𝑡𝛼,𝑛−1.
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1.2.14 Comparing the means of more than two dependent samples

Standard statistical software such as Minitab have options to compare the means of more
than two dependent samples, such as when one repeats measures on single or double
factors. See Minitab instructions in How-To 1.16 about how to analyze a design of a
single-factor with repeated measures.

How-To 1.14 (Z-test and t-test in Excel 2013)
You can run a t-test in Excel by using this function: =
𝑇 .𝑇 𝐸𝑆𝑇 (𝑠𝑎𝑚𝑝𝑙𝑒1, 𝑠𝑎𝑚𝑝𝑙𝑒2, 𝑡𝑎𝑖𝑙𝑠, 𝑡𝑦𝑝𝑒). In the tails option, you specify whether the
test is one or two-tailed. In the type option, you specify whether you are running a
paired t-test (1), a t-test with equal variances (2), or a t-test with unequal variances
(3). You can also run a t-test via the Data Analysis add-in. For that, open the
Data Analysis add-in, as shown in the snapshot portrayed in Figure 1.8 and select
the appropriate test (see the snapshot in Figure 1.9).

Figure 1.8: Excel 2013 Data Analysis add-in option

Figure 1.9: Z-test and t-test via Data Analysis add-in option in Excel 2013

If the Data Analysis add-in is not loaded, you can add it by clicking on File >Options
> Add-ins > Analysis ToolPak > Manage: Excel Add-in > Check the box of Analysis
ToolPak >OK.
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How-To 1.15 (Z-test and t-test in Minitab 18)
To conduct a Z-test or a t-test in Minitab 18, click on Stat>Basic Statistics and
select the appropriate test. See the snapshot portrayed in Figure 1.10.

Figure 1.10: Z-test and t-test options in Minitab 18

How-To 1.16 (Single-factor with repeated measures in Minitab 18)
To conduct an analysis of a single-factor design with repeated measures in Minitab
18, click on Stat > ANOVA > General Linear Model > Fit General Linear Model >
Select Factors > Select Responses > Click on Random/Nest >Factor Type >Ran-
dom >OK.

How-To 1.17 (Python 3.6)

Script 1.6: A script for running Z-test and t-test in Python 3.6

#import modules

from scipy import stats

from statsmodels.stats import weightstats

#https://www.statsmodels.org/stable/generated/statsmodels.stats.

weightstats.ztest.html

#https://www.statsmodels.org/stable/generated/statsmodels.stats.

weightstats.ttest_ind.html

#t-test returns (t-statistic, two-tailed p-value)

x1 = [...] #array of the first dataset

x2 = [...] #array of the second dataset



Chapter 1. Basics of quality improvement 35

equal_var = ...#True if equal variances, otherwise False

stats.ttest_ind(x1,x2, equal_var = equal_var)

#Z-test returns (Z-statistic, two-tailed p-value)

weightstats.ztest(x1, x2, alternative= ’two-sided’, usevar=’pooled’,

ddof=1.0)

1.2.15 Comparing variances of two independent samples

We hypothesize that two samples (sample 1 and sample 2), with variances 𝑠21 and 𝑠22,
were drawn from two independent populations with equal variances, 𝜎2

1 and 𝜎2
2 . We

create a hypothesis test to validate our conjecture as follows:

𝐻0 : 𝜎
2
1 = 𝜎2

2 (1.53)
𝐻1 : 𝜎

2
1 , 𝜎

2
2 (1.54)

Using F-distribution, we obtain the test statistic this way:

𝐹0 =
𝑠21
𝑠22

(1.55)

The lower critical value is given by 𝐹1−𝛼/2,𝑛1−1,𝑛2−1 whereas the upper critical value is
given by 𝐹𝛼/2,𝑛1−1,𝑛2−1. Here, 𝑛1 − 1 and 𝑛2 − 1 are degrees of freedom of sample 1 and
sample 2, respectively. If 𝐹0 > 𝐹𝛼/2,𝑛1−1,𝑛2−1 or 𝐹0 < 𝐹1−𝛼/2,𝑛1−1,𝑛2−1 we reject the null
hypothesis. To perform a one-sided test, we formulate 𝐻1 and 𝐹0 statistics this way:

𝐻1 : 𝜎
2
1 > 𝜎2

2 , 𝐹0 = 𝑠21/𝑠
2
2 (1.56)

𝐻1 : 𝜎
2
1 < 𝜎2

2 , 𝐹0 = 𝑠22/𝑠
2
1 (1.57)

For the case of 𝐻1 : 𝜎2
1 > 𝜎2

2 , we reject the null hypothesis when 𝐹0 > 𝐹𝛼,𝑛2−1,𝑛1−1. For
the case of 𝐻1 : 𝜎

2
1 < 𝜎2

2 , we reject the null hypothesis when 𝐹0 < 𝐹𝛼,𝑛1−1,𝑛2−1.

How-To 1.18 (F-test in Excel 2013)
To calculate the critical value of 𝐹𝛼, 𝑛1−1, 𝑛2−1 in Excel 2013, use this func-
tion = 𝐹.𝐼𝑁𝑉 .𝑅𝑇 (𝛼, 𝑛1 − 1, 𝑛2 − 1). You can estimate the p-value by =
𝐹.𝐷𝐼𝑆𝑇 .𝑅𝑇 (𝐹0, 𝑛1 − 1, 𝑛2 − 1). You can also conduct the F-test using the Data
Analysis add-in under the Data tab. Choose the option of F-test Two-Sample for
Variances.

How-To 1.19 (F-test in Minitab 18)
Click on Stat > Basic Statistics > 2 Variances. Review the snapshot in Figure 1.6.
Note that Minitab runs the test on equal standard deviations, but this will not alter
the conclusion about the null hypothesis.
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How-To 1.20 (Python 3.6)

Script 1.7: A script for running F-test in Python 3.6

#import f from scipy.stats

from scipy.stats import f

alpha = ...#given e.g, 0.05

var1 = ...#variance of first variable

var2 = ... #variance of second variable

df1 = ...#degrees of freedom first variable

df2 = ...#degrees of freedom second variable

F0 = var1 /var2 #F-statistic

pvalue = 1-f.cdf(F0, df1, df2) #if p-value < alpha, reject null

hypothesis

print (pvalue)

1.2.16 Correlation analysis

We conduct a correlation analysis to evaluate the relationship between two variables.
One way to conduct such analysis is via scatter plots to examine how variables vary
together visually. Another way is to apply using Pearson and Spearman correlation coef-
ficients. Another similar technique that we do not cover in this section is the Kendall rank
correlation coefficient [2].

Scatter diagrams

A scatter diagram is one of the major tools of statistical process control (SPC) that we
use in the Analyze phase of DMAIC to evaluate the correlation between two variables.
To create a scatter diagram, we start by organizing the data in the table format by storing
each variable in a separate column. Each row constitutes an ordered pair of observations.
To create a scatter plot, we simply graph a 2-dimensional chart of the variables in the
Cartesian coordinates system.

How-To 1.21 (Creating a scatter plot in Excel 2013)
To create a scatter diagram in Excel 2013, click on INSERT > Scatter Charts. See
the snapshot in Figure 1.11.
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Figure 1.11: Options for a scatter plot in Excel 2013

How-To 1.22 (Creating a scatter plot in Minitab 18)
To create a scatter diagram in Minitab 18, click on Graph >Scatterplot . See the
snapshot in Figure 1.12).

Figure 1.12: Options for a scatter plot in Minitab 18

Interpreting a scatter diagram

We characterize the relationship in a scatter plot as follows:

1. Positive correlation (or direct relationship) when two variables increase together.

2. Negative correlation (or inverse relationship) when one variable increases as the
other one decreases.

3. No correlation (or no relationship) when two variables do not vary together.

We can further differentiate the strength of the relationship by using terms such as
strong, moderate, or weak. For example, we can describe two variables as being
strongly and positively correlated. It is also common to fit a line on the scatter data to
evaluate the linearity or non-linearity of the relationship. Figure 1.13 portrays examples
of scatter plots. In Subfigure 1.13a, a strong positive and linear relationship exists be-
tween variables X and Y. This association implies that as X increases, Y tends to increase
too. In Subfigure 1.13b, we observe a strong negative and linear relationship between X
and Y, implying that as X increases, Y tends to decrease. In Subfigure 1.13c, no obvious
relationship is discernible, meaning that X and Y are likely independent variables. Sub-
figure 1.13a shows a non-linear relationship between X and Y, which, after fitting a line,
seems quadratic.

Remark: Scatter diagrams do not suggest that one variable causes another, rather imply that a
potential relationship exists. Other statistical tools, such as the design of experiments (DOE),
are best suited for entertaining the causality issue [44].
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Figure 1.13: Examples of scatter diagrams
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Pearson correlation coefficient

The Pearson correlation coefficient is a parametric technique that we use to quantify the
degree of the relationship between two continuous variables. We calculate this coeffi-
cient by taking the ratio between the corresponding covariance and standard deviations
statistics. To demonstrate, let’s assume that we have two samples 𝑋 and 𝑌 , each with
size 𝑛, and means of 𝑋 and 𝑌 , respectively. The covariance of 𝑋 and 𝑌 , 𝑐𝑜𝑣(𝑋,𝑌 ) is
given by:

𝑐𝑜𝑣(𝑋,𝑌 ) =
∑︀
(𝑋 −𝑋)(𝑌 −𝑌 )

𝑛− 1
(1.58)

where 𝑛−1 represents the degrees of freedom. We obtain the Pearson correlation coef-
ficient 𝜌(𝑋,𝑌 ), sometimes denoted as 𝑟, this way:

𝜌(𝑋,𝑌 ) ≡ 𝑟 =
𝑐𝑜𝑣(𝑋,𝑌 )

𝑠𝑋𝑠𝑌
(1.59)
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Here, 𝑠𝑋 is the standard deviation of variable 𝑋 and 𝑠𝑌 is the standard deviation of vari-
able 𝑌 . It follows that [39]:

−1 ≤ 𝑟 ≤ 1 (1.60)

The more 𝑟 is close to −1, the more 𝑋 and 𝑌 are negatively correlated. The more 𝑟 is
close to 1, the more 𝑋 and 𝑌 are positively correlated. When 𝑟 is around 0, the two
variables have little to no correlation.

Spearman coefficient

The Spearman correlation coefficient is a non-parametric technique that uses ranks in-
stead of the actual values of the variables under study. Given two variables 𝑋 and 𝑌 , we
replace a given value of 𝑥 in 𝑋 by its rank 𝑅(𝑥) and a given value of 𝑦 in 𝑌 by its rank
𝑅(𝑦). We denote the Spearman coefficient as 𝑟𝑆 and compute it this way:

𝑟𝑆 =
𝑐𝑜𝑣(𝑅(𝑋),𝑅(𝑌 ))

𝑠𝑅(𝑋)𝑠𝑅(𝑌 )
(1.61)

where −1 ≤ 𝑟𝑆 ≤ 1. In the simplified case of no ties in ranks, we compute 𝑟𝑆 as follows:

𝑟𝑆 = 1−
6
∑︀𝑛

𝑖=1𝑑
2
𝑖

𝑛(𝑛2 − 1)
(1.62)

where 𝑑𝑖 = 𝑅(𝑥𝑖) −𝑅(𝑦𝑖) [63]. We typically use the Spearman coefficient to assess the
degree of a monotonic relationship between two variables. Just like in Pearson’s case,
the more 𝑟𝑆 is close to −1, the more 𝑋 and 𝑌 are negatively correlated. The more 𝑟𝑆 is
close to 1, the more 𝑋 and 𝑌 are positively correlated. When 𝑟𝑆 is around 0, the two
variables are likely not to be correlated.

How-To 1.23 (Covariance and Correlation in Excel 2013) To calculate 𝑐𝑜𝑣(𝑋,𝑌 ) in
Excel, use this function = 𝐶𝑂𝑉𝐴𝑅𝐼𝐴𝑁𝐶𝐸.𝑆(𝑋,𝑌 ). To calculate 𝜌(𝑋,𝑌 ), use this
function = 𝐶𝑂𝑅𝑅𝐸𝐿(𝑋,𝑌 ).

How-To 1.24 (Covariance and Correlation in Minitab 18) In Minitab, you can cal-
culate the covariance and correlation between two variables by clicking on Stat >
Basic Statistics > chose Correlation... or Covariance... > select your data > OK.

How-To 1.25 (Python 3.6)

Script 1.8: A script for calculating the covariance and correlation in Python 3.6

#import numpy

import numpy as np

x1 = [...] # first variable

x2 = [...] # second variable
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# print the covariance

print(np.cov(x1, x2)[0][1])

# print the correlation of coefficient

print(np.corrcoef(x1, x2)[0][1])

1.2.17 Regression

We use regression techniques to create a mathematical model of the relationship be-
tween dependent and independent variables. Here, we only consider a linear regres-
sion model with one dependent variable.

One dependent variable and one independent variable

Let’s assume that we have two variables 𝑋 and 𝑌 , where 𝑌 is the dependent variable
and 𝑋 the independent variable. The corresponding linear regression model follows.

𝑌 = 𝛽0 + 𝛽1𝑋 + 𝜖 (1.63)

Both 𝛽0 and 𝛽1 are regression coefficients. The 𝜖 term denotes the regression error that
we refer to as residuals. We estimate 𝛽1 using 𝛽1, as follows:

𝛽1 = 𝑟
𝑠𝑌
𝑠𝑋
≡ 𝑐𝑜𝑣(𝑋,𝑌 )

𝑣𝑎𝑟(𝑋)
(1.64)

where 𝑣𝑎𝑟(𝑋) is the variance of 𝑋 and 𝑟 is the Pearson correlation coefficient between 𝑋
and 𝑌 . We calculate 𝛽0 to approximate 𝛽0 this way:

𝛽0 = 𝑌 − 𝛽1𝑋 (1.65)

where 𝑌 is the mean of 𝑌 and 𝑋 is the mean of 𝑋 [39]. We can predict the values of 𝑌
using 𝑌 , as follows:

𝑌 = 𝛽0 + 𝛽1𝑋 (1.66)

The coefficient 𝛽1 represents the expected change in 𝑌 per unit change in 𝑋. We can
think of 𝛽0 as the intercept of the line 𝑌 . We obtain the error term this way:

𝜖 = 𝑌 −𝑌 (1.67)

The sum of squares of the error 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 is given by 𝜖2 as follows:

𝜖2 = (𝑌 −𝑌 )2 (1.68)
≡ 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (1.69)

We assume 𝜖 to be a normally distributed random vector with mean zero and variance
𝜎2. The unbiased estimator of 𝜎2 is given by 𝜎2 and is calculated as follows:

𝜎2 =
𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑛− 𝑝

(1.70)

where 𝑛 − 𝑝 represents the degrees of freedom. Here, 𝑛 is the size of Y and 𝑝 is the
number of independent variables 𝑘 plus one for the intercept. That is, 𝑝 = 𝑘 +1 [44].
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One dependent variable and multiple independent variables

When we have more than one independent variable, say 𝑘, we create a multiple linear
regression model as follows:

𝑌 = 𝛽0 + 𝛽1𝑋1 + 𝛽2𝑋2 + · · ·+ 𝛽𝑘𝑋𝑘 + 𝜖 (1.71)

where 𝑋1, 𝑋2, . . . ,𝑋𝑘 are independent variables, 𝛽0, 𝛽1, . . . ,𝛽𝑘 are regression coefficients,
and 𝜖 is the error term. From the least-squares method, we obtain the 𝛽 coefficients as
follows:

𝛽 = (𝑋 ′𝑋)−1𝑋 ′𝑌 (1.72)

where ′ symbol indicates transpose. Here, 𝑋 is a matrix of size 𝑛×𝑝, 𝑌 is a vector of size
𝑛× 1, and 𝛽 is a vector of size 𝑝 × 1. Our 𝑌 model looks as follows:

𝑌 = 𝛽0 + 𝛽1𝑋1 + 𝛽2𝑋2 + · · ·+ 𝛽𝑘𝑋𝑘 (1.73)

The coefficient 𝛽𝑗 (for 𝑗 : 0,1, . . . , 𝑘) represents the expected change in 𝑌 per unit
change in 𝑋𝑗 while holding all other independent variables constant. If all inde-
pendent variables were zero, 𝑌 would equal 𝛽0. As before, 𝜖 = 𝑌 −𝑌 and 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 = 𝜖2

1.2.18 Goodness-of-fit

The techniques that we utilize to assess the goodness-of-fit of a linear regression model
are the coefficient of determination, residual plots, and hypothesis testing.

Coefficient of determination

We denote the coefficient of determination using 𝑅2 to represent the percent of the vari-
ation in 𝑌 that is explained by the variation in independent variables. We recall that:

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 = (𝑌 −𝑌 )2 (1.74)

Additionally, it follows that [38]:

𝑆𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑖𝑜𝑛 = (𝑌 −𝑌 )2 (1.75)

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = (𝑌 −𝑌 )2 (1.76)

We calculate 𝑅2 as follows:

𝑅2 =
𝑆𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑖𝑜𝑛
𝑆𝑆𝑡𝑜𝑡𝑎𝑙

≡ 1− 𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑆𝑆𝑡𝑜𝑡𝑎𝑙

(1.77)

where 0 ≤ 𝑅2 ≤ 1. The higher the value of 𝑅2, the better the goodness-of-fit of our model.

Remark: If we added more variables, necessary or unnecessary, to our regression model, 𝑆𝑆𝑒𝑟𝑟𝑜𝑟
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would decrease per Equation 1.70, which would in turn increase 𝑅2 per Equation 1.77. Accord-
ingly, we must be careful when interpreting 𝑅2. We recommend using 𝑅2

𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 , instead of 𝑅2, to

determine the goodness-of-fit of a regression model. We find 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 this way:

𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 = 1−

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 /(𝑛− 𝑝)
𝑆𝑆𝑡𝑜𝑡𝑎𝑙/(𝑛− 1)

(1.78)

where 𝑛− 1 is the degrees of freedom of 𝑌 and 𝑛− 𝑝 is the degrees of freedom of the residuals
[44].

Residual plots

Besides 𝑅2 and 𝑅2
𝑎𝑑𝑗𝑢𝑠𝑡𝑒𝑑 , we can also use residual plots to assess the goodness-of-fit

of our linear regression model. If a model is a good fit, we expect the residuals to be
normally distributed with mean zero and a constant variance. So, the normal plot of
the residuals should indicate that the points fall alongside the fitted line. Furthermore,
we expect to see random behavior around a horizontal line when we plot 𝜖 versus 𝑌 .
Any non-random behavior indicates poor fit, which suggests non-linear behaviors [39].
Statistical packages such as Minitab also include p-values to facilitate the interpretation
of the residual plots.

Hypothesis testing of regression models

In addition to the coefficient of determination and residual plots, we can also employ
hypothesis testing to assess the goodness-of-fit of our regression model. In this test, we
conjecture that the partial regression coefficients of the model are zero, as follows:

𝐻0 : 𝛽1 = 𝛽2 = · · · = 𝛽𝑘 = 0 (1.79)
𝐻1 : At least one 𝛽𝑗 , 0, for j:1,2,...,k (1.80)

Using the analysis of variance (ANOVA) technique, we obtain the test statistic as follows:

𝐹0 =
𝑀𝑆𝑟𝑒𝑔𝑟𝑒𝑠𝑠𝑖𝑜𝑛
𝑀𝑆𝑒𝑟𝑟𝑜𝑟

(1.81)

The critical value is given by:

𝐹𝛼, 𝑘, 𝑛−𝑘−1 (1.82)

where 𝛼 is the significance level, 𝑛 is the size of 𝑌 , and 𝑘 is the number of independent
variables. A good-fit model will have at least one non-zero coefficient. That is, the test
statistic will be greater than the critical value or the p-value less 𝛼. We could also test the
hypothesis that the coefficient 𝛽𝑗 (for 𝑗 : 1, . . . , 𝑘) is zero using the t-test, as follows [38]:

𝐻0 : 𝛽𝑗 = 0 (1.83)
𝐻1 : 𝛽𝑗 , 0 (1.84)
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We obtain the test statistic this way [38]:

𝑡 =
𝛽𝑗 − 0
𝑆𝛽𝑗

(1.85)

where the 𝑧𝑒𝑟𝑜 in the Equation 1.85 comes from the null hypothesis and 𝑆𝛽𝑖 is the stan-
dard error of the coefficient 𝛽𝑗 . The degrees of freedom for this test are given by 𝑛 − 𝑝,
where 𝑛 is the number of observations and 𝑝 = 𝑘 + 1, as before. We obtain the p-value
for this test, as illustrated in How-To 1.27.

How-To 1.26 (Linear Regression in Excel 2013)
Open the Data Analysis add-in > Regression > Input Y Range for dependent vari-
able > Input X Range for independent variables > Check Labels if you want to
include the column headings > Check the boxes of Residuals plots to check for the
model goodness-of-fit. See the snapshot in Figure 1.14.

Figure 1.14: Regression using the Data Analysis add-in, Excel 2013

How-To 1.27 (The p-value of the t-test in Excel 2013)
To obtain the p-value of the t-test in Excel 2013, use this equation: =
𝑇 .𝐷𝐼𝑆𝑇 .2𝑇 (𝐴𝐵𝑆(𝑡),𝑛− 𝑝)

How-To 1.28 (Linear Regression in Minitab 18)
Click on Stat > Regression > Regression > Fit Regression Model...On the screen
that pops up, input your Y data in the Responses and your X data in the Continuous
predictors > On the same screen, click on Graphs > Check the boxes for Normal
probability plot of residuals and Residuals versus fits >OK > OK. See the snapshot
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in Figure 1.15.

Figure 1.15: Options for fitting a regression model, Minitab 18

How-To 1.29 (Python 3.6)

Script 1.9: A script for linear regression in Python 3.6

# import modules

import statsmodels.api as sm

X = [[...],[...],..., [...]] # create a matrix of independent

variables

y = [...]# create an array of the dependent variable

X = sm.add_constant(X)# Add the intercept

model = sm.OLS(y, X).fit()# fit an ordinary regression model

model.summary()# The summary includes several goodness-of-fit

measures

1.3 Control charts

In this section, we introduce two major types of control charts, namely Shewhart and
time-weighted.

1.3.1 Shewhart control charts

The model

Walter A. Shewhart is credited for introducing the concept of control charts in the 1920s
while working at Bell Labs [44]. As summarized in Box 1.2, the Shewhart’s model of
a control chart has three main components: an upper control limit (𝑈𝐶𝐿), a centerline
(𝐶𝐿), and a lower control limit (𝐿𝐶𝐿).
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Box 1.2 Shewhart’s model of control charts

The construct of a Shewhart control chart is as follows:

𝑈𝐶𝐿 = 𝜇𝑤 +𝐿𝜎𝑤 (1.86)
𝐶𝐿 = 𝜇𝑤 (1.87)

𝐿𝐶𝐿 = 𝜇𝑤 −𝐿𝜎𝑤 (1.88)

where 𝑤 is the statistic of interest. Here, 𝜇𝑤 and 𝜎𝑤 symbolize the mean and
standard deviation of 𝑤, respectively. Letter 𝐿 denotes the distance measured in
standard deviation units from 𝐶𝐿 to 𝐿𝐶𝐿 or 𝑈𝐶𝐿 [44].

Control charts built following Box 1.2 are referred to as Shewhart control charts.

The types of Shewhart control charts

The two common categories of Shewhart’s control charts are variable and attribute. We
use variable charts when a process generates continuous independent data. Typical
variable charts include 𝐼𝑚𝑅, 𝑋𝑏𝑎𝑟𝑅, and 𝑋𝑏𝑎𝑟𝑆. We employ 𝐼𝑚𝑅 charts when the
sample size 𝑛 = 1. We apply 𝑋𝑏𝑎𝑟𝑅 charts when 1 < 𝑛 ≤ 10. When 𝑛 > 10, we use
𝑋𝑏𝑎𝑟𝑆 charts. The normal distribution is typically assumed in all variable charts. We
apply attribute charts when a process generates independent discrete data. Typical
attribute charts include 𝑝, 𝑛𝑝, 𝑐, 𝑢, 𝑔, and ℎ. The 𝑝 chart relates to the Bernoulli random
variable. The 𝑛𝑝 chart relates to the binomial random variable. The 𝑐 and 𝑢 assume the
Poisson random variable. The 𝑔 and ℎ charts presume the geometric random variable.

How do Shewhart control charts work?

An analogy that is often used to describe the mechanics of a Shewhart control chart
is that of hypothesis testing. For demonstration purposes, let’s consider the following
hypothesis of a normally distributed process:

𝐻0 : 𝜇 = 𝜇0 (1.89)
𝐻1 : 𝜇 , 𝜇0 (1.90)

Here, 𝜇 is the process mean and 𝜇0 is the hypothesized mean that we estimated from
the process samples. The standard deviation 𝜎 is given, otherwise, we are able to obtain
its unbiased estimator from the process samples. If 𝑥𝑖 is the mean of sample 𝑖 of this
process, the following test statistic 𝐿 applies to the hypothesis under consideration:

𝐿 =
𝑥𝑖 −𝜇0
𝜎/
√
𝑛

(1.91)
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where 𝑛 is the sample size. We obtain the confidence interval of the process mean 𝜇 in
terms of 𝑥𝑖 as follows:

𝜇0 −𝐿
𝜎
√
𝑛
≤ 𝑥𝑖 ≤ 𝜇0 +𝐿

𝜎
√
𝑛

(1.92)

We can think of the lower limit of the confidence interval in Equation 1.92 as 𝐿𝐶𝐿, the
upper limit as 𝑈𝐶𝐿, and 𝜇0 as 𝐶𝐿. If 𝑥𝑖 falls in this interval, then 𝑥𝑖 ≈ 𝜇0 and we conclude
that sample 𝑖 is in control. If 𝑥𝑖 , 𝜇0, 𝑥𝑖 will fall outside of the confidence interval, which
will lead us to reject 𝐻0. Accordingly, we will conclude that the process is out-of-control
or has special cause variation at that particular sample number. Failure to reject 𝐻0
at any sample number, is equivalent to saying that the process is in statistical control,
or simply that the process only exhibits common cause variation. By common cause
variation, we imply that the process behaves randomly within the control limits. If the
process does not behave randomly within the control limits, out-of-control behaviors are
likely due to the small shifts in the process. One way to detect such shifts is employing
specialized rubrics referred to as sensitizing rules, as exemplified in How-To 1.30. It is
important to emphasize that these rules are not universal. Another way to detect small
shifts in the process is by utilizing time-weighted control charts.

How-To 1.30 (Sensitizing rules in Minitab 18)
For each control chart, Minitab 18 displays applicable sensitizing rules. To access
these rules, click on Chart options > Tests. See Figure 1.16 for an example of
sensitizing rules of an 𝐼𝑚𝑅 control chart.
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Figure 1.16: Sensitizing rules of an 𝐼𝑚𝑅 control chart in Minitab 18

Example 1.1 (Special cause variation)
Figure 1.17 shows an example of a control chart with out-of-control behaviors since
at sample #5, a point fell outside of 𝐿𝐶𝐿.

Figure 1.17: A control chart with one type of special cause variation
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After applying the sensitizing rules, Figure 1.18 further indicates that this process
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has special cause variation at samples 35 and 36, given that 2 out of 3 consecutive
points are between the second and third standard deviation limits on the same side.

Figure 1.18: A control chart with two types of special cause variation
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1.3.2 Time-weighted control charts

Besides Shewhart control charts, other types of control charts have been suggested,
mainly time-weighted control charts. Time-weighted control charts involve the weighing
of samples over time. This structure allows for the incorporation of past information
into the current performance measure, which facilitates the detection of small shifts in
the process over time. Like Shewhart charts, time-weighted control charts also have
𝑈𝐶𝐿, 𝐶𝐿, and 𝐿𝐶𝐿, but the formulas are different. Still, the interpretation of out-of-
control behavior is comparable. That is, if a point falls outside of the control limits, special
cause variation has occurred. We typically do not apply sensitizing rules to time-weighted
controls. The three common types of time-weighted control charts that we consider in
this book are the Cumulative Sum (CUSUM), Exponentially Weighted Moving Average
(EWMA), and a regular Moving Average (MA).

1.3.3 Implementing control charts

Control charts are effective at improving quality if they are implemented correctly. For ex-
ample, before implementing control charts, we must decide on how big the sample sizes
must be and how frequently sampling should be done. Besides, we must understand how
to choose distance 𝐿 and know how to detect out-of-control behaviors.

Sampling

Adequate sample sizes and the frequency of sampling are required for a successful
application of control charts. In general, we need at least 25 samples to construct a
control chart. The larger the sample sizes, the easier it is to detect small shifts in the
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process. If obtaining large samples is not feasible, we try to take small samples but dot
it more frequently. In this effort, we must ensure rational subgroups to maximize the
between sample differences while minimizing the within-sample differences. Doing so
will promote the independence of the samples, an assumption that we often make when
creating Shewhart control charts. An appropriate partition of the time-ordered samples
is critical in minimizing the dependence of the subgroups [44]. In general, sampling
only from units produced since the last subgroup, or from units produced under similar
conditions, will help ensure rational subgroups [44].

Choosing 𝐿

As indicated earlier, letter 𝐿 in a Shewhart control chart denotes the distance, in standard
deviation units, from the centerline to the control limit. It is customary to choose 𝐿 = 3,
but depending on the application, this setting may be different. For example, in the type
of control charts known as risk-adjusted, the limits are typically set to 𝐿 < 3 [65]. Why
should we care about where we set the control limits? We should care because different
settings of 𝐿 may lead to different conclusions about the following hypothesis:

𝐻0 : process in control (1.93)
𝐻1 : process not in control (1.94)

As it can be observed in the confidence interval in Equation 1.92, if 𝐿 is too big, meaning
too far from 𝐶𝐿, 𝑥𝑖 is more likely to fall within limits. This outcome increases the probability
𝛽 for Type II error, meaning that we are likely to fail to reject 𝐻0 when it is false. In
contrast, if 𝐿 is too small, 𝑥𝑖 is more likely to fall outside of the limits, which increases the
probability 𝛼 of Type I error where we reject 𝐻0 when it is true. We can think of type I
error as a false alarm in a stable process [44, 65]. Both type I and II errors affect how we
measure the performance of control charts. For example, using the probability of type I
error 𝛼, we can construct the control chart performance measure referred to as average
run length (ARL), as follows:

𝐴𝑅𝐿𝛼 =
1
𝛼

(1.95)

The 𝐴𝑅𝐿𝛼 measure also known as in-control ARL or 𝐴𝑅𝐿0, allows us to determine the
expected number of samples until a false alarm occurs in a stable process. In a normally
distributed process with 𝐿 = 3, the probability of a point falling either outside of 𝐿𝐶𝐿 or
𝑈𝐶𝐿 is given by 1−0.9973 = 0.0027. This implies that 𝐴𝑅𝐿𝛼 = 1/0.0027 ≈ 370. Hence,
we can expect a false alarm at every 370𝑡ℎ sample, if the process has not shifted. If the
process mean has shifted, we gauge the process performance using the 𝐴𝑅𝐿𝛽 measure
that we obtain like this:

𝐴𝑅𝐿𝛽 =
1

1− 𝛽
(1.96)

As previously noted, 𝛽 is the probability of type II error and 1 − 𝛽 is the power test that
expresses the probability of correctly rejecting 𝐻0. The 𝐴𝑅𝐿𝛽 measure in Equation 1.96
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is also referred to as out-of-control ARL or 𝐴𝑅𝐿1. This statistic expresses the expected
number of samples to detect a mean shift of 𝑘𝜎 in the process. In practice, we want to
be able to detect a shift in the process as soon as it happens. We can accomplish this by
increasing the sample size 𝑛 since that decreases 𝛽 [44].

Phases of control charts

There are two major phases of control chart application: phase I and phase II. In phase
I, our main goal is to stabilize the process using Shewhart control charts. We accomplish
this goal by detecting and removing large shifts, or sustained shifts, out of the process.
In general, phase I coincides with the Improve period of DMAIC when we attempt to
remove all assignable causes and modify control charts repetitively until the process is
stable. Every time we remove an assignable cause, variability decreases and the process
improves. In phase II, the process is stable. Hence, we are not likely to detect large
shifts. The interest now is to detect and remove small shifts. For that, time-weighted
control charts are recommended [44]. As we have discussed earlier, one could still apply
Shewhart control charts with sensitizing rules to detect small shifts, but this is likely to
complicate performance measures such as 𝐴𝑅𝐿. Besides, it is much easier to interpret
time-weighted charts over sensitizing rules since we only pay attention to points that fall
outside of the limits. In typical quality improvement projects, phase II coincides with the
Control period of DMAIC. Figure 1.19 displays a basic decision tree of control charts by
the phase of implementation.

Figure 1.19: A basic decision tree of control charts by the phase of implementation
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Adjusting control charts

When applying control charts, we often have to make adjustments to alleviate mislead-
ing results. For example, we often assume independent samples when creating control
charts, but this is not always true. When the process data are autocorrelated, we need
to make adjustments to remove autocorrelation. One of the techniques to do this is fitting
a time series model to sample data and then generate residuals that can be monitored
using traditional charts. Another adjustment that we make when sample data are de-
pendent concerns processes with correlated variables. In such instances, we have to
monitor the variables jointly, instead of individually, which requires the creation of the
type of control charts referred to as multivariate.

Additional adjustments to traditional control charts include the weighing of defects
and risk factors. Indeed, if we are monitoring a unit with several defects that occur in-
dependently and these defects don’t have the same importance, it may be convenient
to create one control chart of the weighted defects instead of control charts of individual
defects. In general, do to this, we need to have some demerit system that may vary by
the process. Regarding risk, this is a phenomenon that occurs more often in health care
than in the manufacturing sector. It’s been observed that patient risk-factors tend to affect
the outcomes of care [65]. So, if one is monitoring the quality of care, it is essential to
account for this risk to obtain more accurate quality measures of the process [65].

1.3.4 How to improve a process using control charts?

A process with out-of-control behaviors is unstable. To stabilize the process, we must
attempt to assign a reason to the special cause and try to rectify it. When the cause is
assignable and rectifiable, we remove the out-of-control sample from the process and
recalculate the centerline and control limits. By removing assignable causes, variabil-
ity decreases, which in turn improves the process [44]. A process with no special
cause variation needs no improvement. But, one could still decide to reduce common
cause variation, which amounts to creating a new process [44].

Remark: Control charts only tell us about the samples that are out-of-control but say nothing
about the actual reasons for out-of-control behaviors. Assigning causes and fixing particular
sources of the special cause variation requires good knowledge of the process and a well-tuned
understanding of how to apply various quality improvement tools such as Lean and designed
experiments.

How-To 1.31 (Omitting samples in Minitab 18)
To remove an assignable cause, click on Chart Options tab of a control chart >
Estimate > Enter the sample number(s) to be omitted. See the snapshot in Figure
1.20.



52 1.3. Control charts

Figure 1.20: Omitting samples with assignable causes in Minitab 18

Note: After omitting a sample number, Minitab 18 calculates a new centerline and
also adjusts control limits, but, depending on setting in Minitab, the omitted sample
may still be visible on the chart.

Example 1.2 (Assignable special cause variation)
A medical coding manager at Metropolis Hospital monitors the daily processing time
of inpatient records. The control chart indicates that the sample from last Monday
was out-of-control. After brainstorming with coders and the IT staff, the manager
realized that the reason for out-of-control behaviors was encoder updates that over-
wrote some coding data on that day. Since the manager knows the reason for the
out-of-control behaviors (that is, the manager assigned the cause), the sample from
last Monday will be omitted, and the centerline and control limits recalculated. By
removing the out-of-control sample, variability will decrease in the process control
chart.

Example 1.3 (Common cause variation)
The office manager at Metropolis Radiology Center uses control charts to monitor
the average coding time for outpatient records. No special variation causes have
been noticed, but still, the manager would like to reduce common cause variation
by creating a new process based on computer-assisted coding (CAC) technology.
The manager believes that the new process will minimize variability by improving
the consistency of coding. The manager will need new control charts to monitor the
new process.

1.3.5 An out-of-control action plan (OCAP)

During the Control period of DMAIC, we implement phase II of the control chart appli-
cation to monitor small shifts in the process. During this period, we also create an out-
of-control plan, so the owner of the process knows what to do when new out-of-control
behaviors are detected. We typically organize an OCAP document as a flow chart with
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two primary components: checkpoints, which are decision nodes for detecting special
cause variation, and terminators, which are plausible corrective actions [44]. We illus-
trate with a generic example in Figure 1.21.

Figure 1.21: A generic OCAP document about a particular Computerized provider order
entry ()CPOE) process
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1.4 Check Your Understanding

1. What happens to quality when variation increases?

2. The term subgroup has the same meaning as

(a) sample

(b) number

(c) population

(d) variance

3. The manager of Metropolis Clinic has received several patient complaints about
excessive waiting times. To investigate the matter, the manager performed a ret-
rospective audit of 5 random visits each day for 25 days. From this scenario, the
sample size is:

(a) 1

(b) 5

(c) 12

(d) 60

4. Which of the following is an example of a statistic measure of a process:

(a) a sample mean

(b) a sample size

(c) a sample number

(d) a random sample

5. In ——— sampling, each item in the process has an equal chance of being se-
lected:

(a) random

(b) systematic

(c) stratified

(d) cluster

6. We use this formula 1
𝑛−1

∑︀𝑛
𝑖=1(𝑥𝑖 − 𝑥)2 to calculate the sample:

(a) mean

(b) variance

(c) standard deviation

(d) median
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7. Your population has a mean 𝜇 = 50 and 𝜎 = 10. If you took a sample of size 7 and
observed a mean of 55, what is your sampling error?

(a) 5

(b) 7

(c) 10

(d) 40

8. Your population has a mean 𝜇 = 50 and 𝜎 = 10. If you took a sample of size 7 and
observed a mean of 55, what is your standard error?

(a) 3.8

(b) 7.0

(c) 11.9

(d) 17.6

9. The ratio between the two sample variances is likely to follow which distribution?

(a) normal distribution

(b) t-distribution

(c) F-distribution

(d) Chi-square distribution

10. When sampling your process, you should seek to —— within subgroup differences

(a) maximize

(b) minimize

11. Which of the following sample statistic is a biased estimator of the related popula-
tion parameter?

(a) Mean

(b) Median

(c) Variance

(d) Standard deviation

12. Which of the following distribution has the mean and variance parameters that are
equal?

(a) Geometric

(b) Poisson

(c) Normal

(d) Bernoulli
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13. Which statistic do you need to create a confidence interval for your population
mean?

(a) Standard error

(b) Sampling error

(c) Regression error

(d) Statistic error

14. A false alarm in the process is equivalent to a:

(a) type I error.

(b) type II error.

15. When comparing the means in paired observations, we typically apply which sta-
tistical test?

(a) t-test

(b) Z-test

(c) F-test

(d) Chi-square-test

16. Our null hypothesis says that 𝐻0 : 𝜎
2
1 = 𝜎2

2 . What statistic test are we likely to run?

(a) F-test

(b) t-Test

(c) Z-test

(d) M-test

17. When performing an ANOVA test, as the degrees of freedom in the error decrease,
we are likely to conclude that:

(a) There is no difference in the population means

(b) There is a difference in the population means

18. Why are we likely to assume normal distribution during quality improvement projects?

19. What graphical technique can we use to verify the normality assumption?

20. Why do we have to adjust the coefficient of determination?

21. Given 𝛼 = 0.05, and 𝑛 = 10, what is the t-statistic for constructing a confidence
interval?

22. Given individual observations, which one of the following control charts are we likely
to use to monitor variability?
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(a) 𝑀𝑅

(b) 𝑅

(c) 𝑆

(d) 𝑆2

23. If we want to monitor the average coding time per record, what type of control charts
are we likely to use?

(a) Variable control charts

(b) Attribute control charts

24. From the operating curves, we observe that as the sample size increases

(a) 𝛼 decreases.

(b) 𝛽 decreases.

(c) 𝛼 increases.

(d) 𝛽 increases.

25. Removing ——– results in the creation of a new process.

(a) special cause variation from an existing process

(b) common cause variation from an existing process

26. When there are at least eight consecutive points on the same side of the centerline
of a control chart, we likely have ——

(a) a shift in the process.

(b) zig-zag behaviors in the process.

(c) trend behaviors in the process.

(d) oscillation behaviors in the process.

27. 𝐴𝑅𝐿𝛼 in a stable and normally distributed process with L = 2 is about:

(a) 3

(b) 10

(c) 20

(d) 370

28. The 𝑔 chart is related to which random variable?

(a) Geometric

(b) Poisson

(c) Binomial
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(d) Normal

29. How are we likely to monitor a process with variable data when the sample size is
𝑛 = 20?

(a) Using 𝐼𝑚𝑅 charts

(b) Using 𝑋𝑏𝑎𝑟𝑅 charts

(c) Using 𝑋𝑏𝑎𝑟𝑆 charts

(d) Using 𝑝 and 𝑛𝑝 charts

30. The 𝑋𝑏𝑎𝑟 chart is related to which random variable?

(a) Geometric

(b) Poisson

(c) Binomial

(d) Normal

31. 𝐻0 : a process in control
𝐻1 : a process not in control
You noticed that a point fell outside of the control limits and concluded that the
special cause variation existed. Your conclusion was equivalent to:

(a) rejecting the null hypothesis.

(b) failing to reject the null hypothesis.

32. Sensitizing rules are mainly applied to detect ——

(a) large shifts in the process.

(b) small shifts in the process.

33. The individual credited with introducing control charts is —–

(a) Deming.

(b) Juran.

(c) Ishikawa.

(d) Shewhart.

34. 𝐴𝑅𝐿𝛽 is also referred to as ——

(a) in-control 𝐴𝑅𝐿.

(b) out-of-control 𝐴𝑅𝐿.

35. How can you state the null hypothesis about the coefficients of a multiple regression
model?
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36. Given one dependent variable Y and one independent variable X, how would you
obtain the intercept of the corresponding linear regression model?

37. Given the residual plot from a regression model, how would you determine the
goodness-of-fit?

38. Consider the following multiple linear regression model 𝑌 = 𝛽0+𝛽1𝑋1+𝛽2𝑋2+ · · ·+
𝛽𝑘𝑋𝑘 + 𝜖. How can you interpret 𝛽2 concerning 𝑌 ?

39. You have created a regression model from your sample data. How can you use
the total sum of squares and the error sum of squares to obtain the coefficient of
determination?

40. From fitting a multiple regression model in Excel, with 20 observations, you ob-
tained the results in the following table:

Coefficients Standard Error t Stat

Intercept 89.75368 7.970321 11.26099
X1 1.7707 0.318356 5.562016
X2 1.669831 0.556528 3.000446

(a) Write down the regression equation for this case

(b) What can you conclude about the significance of the coefficient of your re-
gression model? Justify your answer using p-values



CHAPTER 2

Shewhart Control Charts

In this chapter, we widen our discussion of Shewhart control charts. We
focus on variable and attribute charts. We demonstrate how to create
and implement these charts using Excel, Python, and Minitab software.
We include several examples as well as a necessary review of statistical
concepts that concern particular control charts under discussion.

Key concepts and tools: Control charts; Variable charts; Attribute charts; Out-of-
control behaviors; Assignable causes; Stabilize the process;

Major objectives
After studying this chapter, you will be able to:

1. Define key concepts of Shewhart control charts

2. Distinguish different types of Shewhart control charts

3. Explain the statistical formulation of Shewhart control charts

4. Recognize out-of-control behaviors in Shewhart control charts

5. Use Shewhart control charts to improve a process

6. Develop an implementation strategy of Shewhart control charts

7. Survey data transformation techniques when monitoring rare events

8. Create variable control charts using Excel, Python, and Minitab

9. Create attribute control charts using Excel, Python, and Minitab

10. Justify the role of Shewhart control charts in improving quality in health care

60
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2.1 Introduction

In this chapter, we expand on the discussion of Shewhart control charts that we intro-
duced in Chapter 1. We recall that we implement these charts during phase I of chart
application to detect and remove large or sustained shifts out of the process. When a
process generates continuous independent data, we apply variable control charts. Ex-
amples of continuous data in health care include measurements of waiting time, patient’s
height and weight, infusion rate, service charges, and case mix index. The types of vari-
able charts that we consider here include 𝐼𝑚𝑅, 𝑋𝑏𝑎𝑟𝑅, and 𝑋𝑏𝑎𝑟𝑆. We employ 𝐼𝑚𝑅
charts when the sample size 𝑛 = 1. We apply 𝑋𝑏𝑎𝑟𝑅 charts when 1 < 𝑛 ≤ 10. When
𝑛 > 10, we use 𝑋𝑏𝑎𝑟𝑆 charts. The normal distribution is typically assumed in all variable
charts.

Besides variable charts, we also consider attribute charts that we apply when a pro-
cess generates independent discrete data of defects. The types of attribute charts that
we discuss include 𝑝, 𝑛𝑝, 𝑐, 𝑢, 𝑔, and ℎ. When a sample unit has one or more defects,
we can classify it as being either defective or non-defective. The 𝑝 chart, which relates
to the Bernoulli random variable, can be used to monitor the fraction of defective units.
The 𝑛𝑝 chart is derived from the binomial random variable and is applied to monitor the
expected number of defective units. The 𝑐 and 𝑢 charts relate to the Poisson random
variable, and we can employ them to monitor the rate of defects. The 𝑔 and ℎ charts
presume the geometric random variable and are applicable for monitoring rare events.
To monitor the time between rare events, we apply traditional variable charts.

Throughout this chapter, we include several How-To clauses to demonstrate how to
implement Shewhart control charts using Excel, Python, and Minitab software. We also
include a basic review of the statistical concepts behind each chart we that discuss.

2.2 Variable control charts

Figure 2.1 maps the types of variable control charts that we discuss in this chapter,
namely 𝐼𝑚𝑅, 𝑋𝑏𝑎𝑟𝑅, and 𝑋𝑏𝑎𝑟𝑆 charts. The following scenarios exemplify health care
processes that can be monitored using variable charts.

Scenario 1: When patients visit the emergency department (ED), they are assigned an
emergency severity index (ESI), and the most seriously ill patients (ESI-level 1) are
prioritized. The ED manager would like to use variable control charts to monitor the
time it takes for ESI-level 1 patients to be seen by the physician. Currently, there
are no electronic means of capturing this amount of time. As a result, the manager
has decided to randomly sample 5 ESI-level 1 patients and monitor their waiting
time using 𝐼𝑚𝑅 charts. For more discussion about using variable control charts to
monitor ED waiting times, see Ross (2013) [53].
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Figure 2.1: A basic map of variable control charts

Control Chart Application

Shewhart Time-weighted

ImR XbarR XbarS

Phase I Phase II

AttributeVariable

1 < n <= 10 n > 10n = 1

Scenario 2: The CIO1 of Metropolis Hospital has received several complaints about de-
lays in the queries for diagnostic images from the PACS2 system. The CIO un-
derstands that the efficiency of the retrieval of patient information is critical for the
timeliness of medical care delivery. Depending on the type of information, several
databases may have to be queried, and data may have to be synthesized and dis-
played in a tailored format for the user [57]. The CIO has put together a team of
experts to help improve the PACS query process. To start, the team has collected
25 samples of size 𝑛 = 15 and established preliminary 𝑋𝑏𝑎𝑟𝑆 control charts.

Scenario 3: The director of Health Informatics at Metropolis Hospital manages an in-
volved department that encompasses health information management, data ana-
lytics, and quality reporting. To keep track of the department’s expenditures, the
director has decided to use variable control charts to monitor biweekly expenses.
The budget target set by the finance department will be used to set up an appro-
priate variable control chart. See Carey and Lloyd (1995)[10] to read more about
a case study that discusses the use of variable control charts to monitor financial
metrics.

Scenario 4: You are the manager of the revenue cycle at your hospital, and your CFO3

has asked you to help decrease the average collection period (ACP)4. You under-
stand that some of the processes related to ACP are outside of your direct control,

1CIO: Chief Information Officer
2PACS: Picture Archiving and Communication System
3CFO: Chief Financial Officer
4ACP: In healthcare finance, ACP is also known as days-in-patient account receivable [28]
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but you do have a contribution to make such as reducing the number of days to
mail patient co-payment invoices. To monitor your process, you have decided to
use 𝑋𝑏𝑎𝑟𝑅 control charts. A case study discussing the use of variable control
charts to monitor days to mail patient invoices can be found in Carey and Lloyd
(1995)[10].

2.2.1 Statistics for variable charts

To construct variable charts, we must know or be able to estimate the process mean and
standard deviation. Unless standard values are provided, we always estimate prelim-
inary variable control charts using at least 25 samples. We assume that our samples
are independent and identically distributed following the normal random variable. We
calculate the mean 𝑥𝑖 of sample 𝑖 as follows:

𝑥𝑖 =
1
𝑛

𝑛∑︁
𝑗=1

𝑥𝑖𝑗 (2.1)

for 𝑖 : 1, . . . ,𝑚, where 𝑚 is the total number of samples. We obtain the overall mean ¯̄𝑥 this
way:

¯̄𝑥 =
1
𝑚

𝑚∑︁
𝑖=1

𝑥𝑖 (2.2)

When the sample size is variable, we obtain ¯̄𝑥 like this:

¯̄𝑥 =
∑︀𝑚

𝑖=1𝑛𝑖𝑥𝑖∑︀𝑚
𝑖=1𝑛𝑖

(2.3)

We recall from Chapter 1 that the sample mean ¯̄𝑥 is the unbiased estimator of the process
mean 𝜇. We calculate the standard deviation of sample 𝑖 as follows:

𝑠𝑖 =

√︃∑︀𝑛
𝑗=1(𝑥𝑗 − 𝑥𝑖)2

𝑛− 1
(2.4)

where 𝑛−1 signifies the degrees of freedom. Given 𝑚 number of samples, we obtain the
average of standard deviations 𝑠 this way:

𝑠 =
1
𝑚

𝑚∑︁
𝑖=1

𝑠𝑖 (2.5)

When the sample size is variable, we obtain 𝑠 as follows [44]:

𝑠 =

√︃∑︀𝑚
𝑖=1(𝑛𝑖 − 1)𝑠

2
𝑖∑︀𝑚

𝑖=1(𝑛𝑖 −𝑚)
(2.6)
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where 𝑠2𝑖 is the variance of sample 𝑖 [44]. As indicated in Chapter 1, when the sample
size 𝑛 > 10, we use 𝑠 to derive the unbiased estimator of the process standard deviation
𝜎 , as follows:

𝜎 ≈ 𝜎 =
𝑠
𝑐4

(2.7)

Parameter 𝑐4 depends on the sample size 𝑛 in Appendix Table 12. When the sample size
1 ≤ 𝑛 ≤ 10, we use the range method to estimate variability. We obtain the range 𝑅𝑖 of
sample 𝑥𝑖 , for 𝑖 : 1, . . . ,𝑚, where 𝑚 is the sample number, as follows:

𝑅𝑖 =max(𝑥𝑖𝑗)−min(𝑥𝑖𝑗) (2.8)

for 𝑗 : 1, . . . ,𝑛. We use the min() function to find the minimum value, and max() function
to find the maximum value. Given 𝑚 number of samples, we derive 𝑅, the average of the
ranges, this way:

𝑅 =
1
𝑚

𝑚∑︁
𝑖=1

𝑅𝑖 (2.9)

We use the 𝑅 statistic to estimate the process standard deviation as follows:

𝜎 ≈ 𝜎 =
𝑅̄
𝑑2

(2.10)

where the parameter 𝑑2 is obtained from Appendix Table 12 by the constant sample size
𝑛. In the special case of individual observations, we calculate the moving range (MR)
over the span of two observations this way:

𝑀𝑅𝑖 = |𝑥𝑖 − 𝑥𝑖−1| (2.11)

for 𝑖 : 2, . . . ,𝑚. Here, the |.| symbol signifies the absolute value, 𝑥𝑖 is the current obser-
vation, and 𝑥𝑖−1 is the previous observation. The average of moving ranges, 𝑀𝑅, in 𝑚
samples is obtained as follows:

𝑀𝑅 =
1

𝑚− 1

𝑚∑︁
𝑖=2

𝑀𝑅𝑖 (2.12)

We approximate 𝜎 like this:

𝜎 ≈ 𝜎 =
𝑀𝑅
𝑑2

(2.13)

From Appendix Table 12, when 𝑛 = 2, 𝑑2 = 1.128.



Chapter 2. Shewhart Control Charts 65

2.2.2 ImR control charts

We use 𝐼𝑚𝑅 control charts, also denoted as 𝐼-𝑀𝑅, to monitor a process when the sam-
ple size 𝑛 = 1. The part of 𝐼 monitors individual observations, whereas the part of 𝑀𝑅
monitors variability using moving ranges.

Formulation

Box 2.1 summarizes the formulas for 𝐼𝑚𝑅 control charts.

Box 2.1 Formulas for 𝐼𝑚𝑅 control charts when 𝐿 = 3

The formulas for 𝐼𝑚𝑅 charts are as follows:

𝐼 chart 𝑀𝑅 chart

𝑈𝐶𝐿 𝑥+3
𝑀𝑅
𝑑2

𝐷4𝑀𝑅

𝐶𝐿 𝑥 𝑀𝑅

𝐿𝐶𝐿 𝑥 − 3𝑀𝑅
𝑑2

𝐷3𝑀𝑅

Here, 𝑥 is the overall mean of observations. We obtain parameters 𝑑2, 𝐷3, and
𝐷4 in Appendix Table 12 when 𝑛 = 2. Since we can’t have negative observations,
when 𝐿𝐶𝐿 < 0, we set 𝐿𝐶𝐿 = 0.

How-To 2.1 (𝐼-𝑀𝑅 charts in Minitab 18)
To construct 𝐼𝑚𝑅 charts in Minitab 18, click on Stat > Control Charts > Variable
Control Charts for Individuals > I-MR > Select your data > OK. See the snapshot in
Figure 2.2.

Figure 2.2: Options for 𝐼-𝑀𝑅 control charts in Minitab 18
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How-To 2.2 (Python 3.6)

Script 2.1: A script for creating 𝐼-𝑀𝑅 charts in Python 3.6

#VARIABLE CHARTS- IMR charts

#import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

data = read_excel(’your directory’)

xr = data.xt

xbar = mean(xr)

d2 = 1.128

D3 = 0.

D4 = 3.267

mr = [abs(xr[i]-xr[i-1]) for i in range(1, len(xr))]

mrbar = mean(mr)

UCLa = [xbar + 3.*(mrbar/d2)]*len(xr)

LCLa = [ max(0,xbar - 3.*(mrbar/d2))]*len(xr)

CLa = [xbar]*len(xr)

markers = []

colors = []

for i in range (len(data)):

x1 = data.ix[i][’xt’]

if x1 > UCLa[0]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#Plotting

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCLa, ’k-’, alpha = 0.5)

ax1.plot(LCLa, ’k-’,alpha = 0.5)

ax1.plot(CLa, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1, alpha = 1.)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

xlim(xmin = -0.3)

xlim(-0.3, t[-1]+1)

sns.color_palette("Blues")

sns.despine(offset=10, top = True, trim=True)

sns.axes_style({’xtick.right’: False})

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Individual Observations’)

ax1.yaxis.set_ticks_position(’left’) #remove yticks from right up

ax1.xaxis.set_ticks_position(’bottom’) #remove yticks from right up
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#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCLa[0],2)), xy = (xlim()[1], list(

UCLa)[-1]), xytext = (xlim()[1],list(UCLa)[-1]),fontsize = 11)

ax1.annotate (’$\overline{X}=$’+str(round(CLa[0],2)), xy = (xlim()

[1], list(CLa)[-1]), xytext = (xlim()[1],list(CLa)[-1]),fontsize

= 11)

ax1.annotate (’$LCL=$’+str(round(LCLa[0],2)), xy = (xlim()[1], list(

LCLa)[-1]), xytext = (xlim()[1],list(LCLa)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

#plot MR chart

UCLa = [mrbar*D4]*len(mr)

LCLa = [max(0,mrbar*D3)]*len(mr)

CLa = [mrbar ]*len(mr)

markers = []

colors = []

for i in range (len(mr)):

x1 = mr[i]

x2 = UCLa[i]

x3 = LCLa[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#Plotting Xbar

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCLa, ’k-’, alpha = 0.5)

ax1.plot(LCLa, ’k-’,alpha = 0.5)

ax1.plot(CLa, ’k-’,alpha = 0.5)

ax1.plot(mr,’b-’,zorder=1)

for x,y,c,m in zip(t, mr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

ylim(-0.5, 40)

xlim(-0.3, t[-1])

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Moving Range’)

ax1.yaxis.set_ticks_position(’left’) #remove yticks from right up

ax1.xaxis.set_ticks_position(’bottom’) #remove yticks from right up

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCLa[-1],2)), xy = (xlim()[1], list(

UCLa)[-1]), xytext = (xlim()[1],list(UCLa)[-1]),fontsize = 11)

ax1.annotate (r’$\overline{MR}=$’+str(round(CLa[0],2)), xy = (xlim()
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[1], list(CLa)[-1]), xytext = (xlim()[1],list(CLa)[-1]),fontsize

= 11)

ax1.annotate (’$LCL=$’+str(round(LCLa[-1],2)), xy = (xlim()[1], list(

LCLa)[-1]), xytext = (xlim()[1],list(LCLa)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(2, len(data)+2, step = 2))

show()

How-To 2.3 (𝐼-𝑀𝑅 charts in Excel 2013)
Excel does not have a built-in option to create I-MR charts, but we can manually
program the formulas from Box 2.1 as we demonstrate in Example 2.1.

Example 2.1 (𝐼-𝑀𝑅 charts)
The lab manager at Metropolis Hospital is interested in monitoring the turn around
time (TAT) of “stat” potassium orders for each patient. A shorter TAT is preferred
since potassium levels are required before patients could be taken off the heart/lung
bypass machine in the cardiac unit [49]. To set up preliminary 𝐼𝑚𝑅 control charts,
the manager collected 30 random samples, as portrayed in Table 2.1.

Table 2.1: TAT, in minutes (X), of “stat” potassium orders at Metropolis Hospital

Sample# 𝑋 Sample# 𝑋

1 27 16 29
2 32 17 31
3 54 18 47
4 27 19 40
5 31 20 31
6 40 21 37
7 45 22 27
8 20 23 26
9 33 24 40

10 41 25 33
11 30 26 70
12 44 27 45
13 24 28 29
14 22 29 44
15 33 30 43

To help the manager construct the appropriate control chart, we start by consulting
Appendix Table 12 when 𝑛 = 2 and obtain 𝑑2 = 1.128, 𝐷3 = 0, and 𝐷4 = 3.267.
Next, we set up our spreadsheet as portrayed in Figure 2.3. To create the 𝐼-𝑀𝑅
charts, we follow these steps:

Step 1: From the setup in Figure 2.3, we have column B containing individual ob-
servations that we monitor in the 𝐼 chart. We also use this column to deter-
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mine the moving ranges (𝑀𝑅).

Step 2: We obtain the 𝑀𝑅 values per Equations 2.11 and 2.12. For example, we
calculated the 𝑀𝑅 value in cell C4 using = 𝐴𝐵𝑆(𝐵3−𝐵4). We dragged down
this formula to populate the rest of the values. Furthermore, we obtained 𝑀𝑅
value in cell M7 using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐶4 : 𝐶32).

Figure 2.3: A setup of 𝐼-𝑀𝑅 control charts in Excel based on the data in Table 2.1

Step 3: In this step, we calculate the 𝑋 value. We obtained the value in cell M6
using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵3 : 𝐵32).

Step 4: To construct the control limits, we apply the formulas in Box 2.1. For ex-
ample, we obtained the 𝑈𝐶𝐿 value in cell 𝐷3 by = 𝑅𝑂𝑈𝑁𝐷($𝑀$6 + 3 *
($𝑀$7/$𝑀$3),2) and obtained the 𝐿𝐶𝐿 value in cell 𝐽3 by = $𝑀$4 * $𝑀$7.
The 𝐶𝐿 value in cell E3 follows from = 𝑅𝑂𝑈𝑁𝐷($𝑀$6,2). We use the
𝑅𝑂𝑈𝑁𝐷(𝑥,2) function to round 𝑥 to two decimal places. The $ sign in Excel
formulas allows us to drag down the formula and easily populate the rest of
the values while keeping cells with the $ sign constant.

Step 5: In this final step, we insert line charts of columns D-F to create the 𝐼 chart
and line charts of columns H-J to create the 𝑀𝑅 chart.
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Figure 2.4 portrays 𝐼-𝑀𝑅 charts that we created by following the instructions in
How-To 2.1. In Figure 2.5, we show similar charts that we reproduced in Python
3.6 using the script in How-To 2.2. From any of these sets of 𝐼-𝑀𝑅 charts, we
appreciate that the 𝐼 chart exhibits out-of-control behavior at sample 26. The 𝑀𝑅
chart does not show any special cause variation, but it is also clear that sample 26
is too close to 𝑈𝐶𝐿. To improve this process, the manager needs to investigate
sample 26 and remove any sources of variability. Let’s assume that the manager
was able to assign the reason for the out-of-control behaviors at sample 26. Then,
the manager can omit that sample and recalculate the centerline and control limits,
as portrayed in Figure 2.5. To omit a sample number using Minitab 18, review the
instructions in How-To 1.31.

Figure 2.4: 𝐼-𝑀𝑅 control charts created in Minitab using the data in Table 2.1
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Figure 2.5: 𝐼-𝑀𝑅 control charts produced in Python using the data in Table 2.1

(a) 𝐼-𝐶ℎ𝑎𝑟𝑡
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Figure 2.5: Revised 𝐼-𝑀𝑅 control charts after omitting sample 26 of the data in
Table 2.1

(a) 𝐼-𝐶ℎ𝑎𝑟𝑡 𝑟𝑒𝑣𝑖𝑠𝑒𝑑
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(b) 𝑀𝑅-𝐶ℎ𝑎𝑟𝑡 𝑟𝑒𝑣𝑖𝑠𝑒𝑑

By examining the revised control charts in Figure 2.5, we notice that variability in the
process has decreased, given that the control limits moved closer to the centerline.
For example, in the 𝐼-𝑐ℎ𝑎𝑟𝑡, 𝑈𝐶𝐿 decreased from 67.56 to 62.77 and 𝐿𝐶𝐿 moved
up from 4.1 to 6.54. In the 𝑀𝑅-𝑐ℎ𝑎𝑟𝑡, 𝑈𝐶𝐿 decreased from 38.98 to 34.54, and
𝐿𝐶𝐿 remained at zero. In both cases, the mean behaviors also decreased. Since
the new control charts are stable, the manager can use them to monitor the future
process.

2.2.3 XbarR control charts

The 𝑋𝑏𝑎𝑟𝑅 charts, also noted as 𝑋𝑏𝑎𝑟-𝑅 or 𝑋𝑚𝑅, help us monitor the process mean
behaviors using the 𝑋𝑏𝑎𝑟 chart and the variability using the 𝑅 chart. We typically employ
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𝑋𝑏𝑎𝑟-𝑅 charts when the sample size 1 < 𝑛 ≤ 10.

Formulation

Box 2.2 summarizes the formulas for these charts.

Box 2.2 The formulas for 𝑋𝑏𝑎𝑟𝑅 control charts when 𝐿 = 3

When 𝜇 and 𝜎 standards are given, we apply these formulas:

𝑋𝑏𝑎𝑟 chart 𝑅 chart

UCL 𝜇+𝐴𝜎 𝐷2𝜎

CL 𝜇 𝑑2𝜎

LCL 𝜇−𝐴𝜎 𝐷1𝜎

When 𝜇 and 𝜎 standards are not given, we apply the following formulas:

𝑋𝑏𝑎𝑟 chart 𝑅 chart

UCL ¯̄𝑥+𝐴2𝑅 𝐷4𝑅

CL ¯̄𝑥 𝑅

LCL ¯̄𝑥 −𝐴2𝑅 𝐷3𝑅

In the 𝑋𝑏𝑎𝑟 chart, we monitor 𝑥𝑖 , the average mean in each sample 𝑖, for
𝑖 : 1, . . . ,𝑚, where 𝑚 is the total number of samples. In the 𝑅 chart, we monitor
𝑅𝑖 , the range in each sample 𝑖. We obtain the values of 𝐴, 𝐴2, 𝐷1, 𝑑2, 𝐷3, and 𝐷4
from Appendix Table 12 by the sample size 𝑛.

How-To 2.4 (Python 3.6)

Script 2.2: A script for creating 𝑋𝑏𝑎𝑟-𝑅 charts in Python 3.6

#VARIABLE CHARTS- XbarR charts

#Import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an excel spreadsheet

data = read_excel(’your directory’)

#if column names in Excel, select the column of interest (e.g., data

= data[’column name’]

xr = [mean(data.loc[i]) for i in range(len(data))]

t = arange(len(data))

rr = [max(data.loc[i])-min(data.loc[i])*1. for i in range(len(data))

]
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xbar = mean(xr)

rbar = mean(rr)

#Xbar chart

#parameters from Appendix Table 1. Below is an example of values when

n = 5

A2 = 0.577

D3 = 0.

D4 = 2.114

#control limits

UCL = [xbar + A2*rbar]*len(xr)

LCL = [max(0,xbar - A2*rbar)]*len(xr)

CL = [xbar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue.

markers = []

colors = []

for i in range (len(xr)):

x1 = xr[i]

x2 = UCL[i]

x3 = LCL[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting Xbar

fig=figure()

ax1 = fig.add_subplot(111)

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(r’$\overline{X}$’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCLa)[-1]),fontsize = 11)

ax1.annotate (r’$\overline{\overline{X}}=$’+str(round(CL[0],2)), xy =

(xlim()[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),

fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCLa)[-1]), xytext = (xlim()[1],list(LCLa)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

#########################

#R chart
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#control limits

UCL = [rbar*D4]*len(xr)

LCL = [max(0,rbar*D3)]*len(xr)

CL = [rbar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(xr)):

x1 = rr[i]

x2 = UCL[i]

x3 = LCL[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting R-chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(rr,’b-’,zorder=1)

for x,y,c,m in zip(t, rr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’R’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (r’$\overline{R}=$’+str(round(CL[0],2)), xy = (xlim()

[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize =

11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

How-To 2.5 (𝑋𝑏𝑎𝑟-𝑅 charts in Minitab 18) To construct 𝑋𝑏𝑎𝑟-𝑅 charts in Minitab 18,
click on Stat > Control Charts > Variable Control Charts for Subgroups > Xbar-R >
In the drop-down menu, select Observations for a subgroup are in one row of
columns >Select your data > OK. See the snapshot in Figure 2.5.
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Figure 2.5: Options for 𝑋𝑏𝑎𝑟-𝑅 control charts in Minitab 18

How-To 2.6 (𝑋𝑏𝑎𝑟-𝑅 charts in Excel 2013)
Excel does not have a built-in option to create 𝑋𝑏𝑎𝑟-𝑅 charts, but we can manually
program the formulas in Box 2.2 as we demonstrate in Example 2.2.

Example 2.2 (XbarR charts)
The coding manager at Metropolis Hospital is interested in setting up control charts
to monitor the processing time of inpatient records. The manager defined process-
ing time as the total time it takes, in minutes, to code and abstract a record. To
get started, the manager looked up the standards about the mean and standard
deviation of inpatient processing times but found none. Subsequently, the manager
decided to estimate the process parameters using sample data. Table 2.2 shows
the data that the manager sampled from 30 random days in 2018. On each day,
the manager sampled 5 records.

Table 2.2: Samples of processing times of inpatient records at Metropolis Hospital

Sample # 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5 Sample # 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5

1 28 32 34 32 33 16 27 26 27 25 35
2 31 27 31 28 30 17 29 33 32 30 35
3 15 31 20 34 15 18 29 27 29 25 34
4 33 32 31 31 30 19 33 27 32 33 44
5 26 27 34 29 34 20 32 27 28 29 28
6 34 27 32 30 31 21 35 32 34 32 27
7 25 34 33 33 25 22 28 33 28 40 30
8 32 32 35 26 32 23 34 32 32 30 32
9 28 33 35 29 30 24 35 25 25 28 34
10 25 32 29 28 50 25 28 25 26 31 27
11 33 32 30 35 35 26 27 33 33 34 34
12 34 29 21 32 26 27 33 31 29 27 10
13 27 30 31 31 35 28 32 31 35 31 29
14 27 28 28 34 34 29 30 27 35 33 28
15 29 33 33 25 32 30 32 25 33 25 29
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Next, the manager looked up the values of parameters 𝐴2, 𝐷3, and 𝐷4 in Appendix
Table 12, when 𝑛 = 5, and obtained 0.577, 0, 2.114, respectively. We help the
manager create 𝑋𝑏𝑎𝑟-𝑅 charts in Excel by following these steps:

Step 1: First, we set up our spreadsheet as shown in Figure 2.6, and calculate the
mean statistics per Equations 2.1 and 2.2. For example, the 𝑋𝑏𝑎𝑟 value in
cell G3 was calculated using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵3 : 𝐹3). This formula can be
dragged down to populate the rest of the values. The value of 𝑋𝑏𝑎𝑟𝑏𝑎𝑟 ( ¯̄𝑥) in
cell R5 was calculated using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐺3 : 𝐺32).

Step 2: We obtain the range per Equations 2.8 and 2.9. For example, the 𝑅 value
in cell H3 was obtained by 𝑀𝐴𝑋(𝐵3 : 𝐹3)−𝑀𝐼𝑁 (𝐵3 : 𝐹3). We dragged down
this formula to populate the rest of the values. The 𝑅𝑏𝑎𝑟 value in cell R6 was
obtained using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐻3 :𝐻32).

Step 3: To construct the control limits, we applied the formulas from Box 2.2, when
no standards were given. For example, we obtained the 𝑈𝐶𝐿 value in cell
I3 using = 𝑅𝑂𝑈𝑁𝐷($𝑅$5 + $𝑅$2 * $𝑅$6,2), and obtained the 𝐿𝐶𝐿 value in
cell K3 using = 𝑅𝑂𝑈𝑁𝐷($𝑅$5−$𝑅$2*$𝑅$6,2). The center limits are based
on the values of 𝑋𝑏𝑎𝑟𝑏𝑎𝑟 and 𝑅𝑏𝑎𝑟. We dragged down these formulas to
populate the rest of the values.

Step 4: In this final step, we insert the line charts of columns 𝐼 −𝐾 to construct the
𝑋𝑏𝑎𝑟 chart, and columns 𝑀 −𝑂 to construct the 𝑅 chart.
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Figure 2.6: A setup of 𝑋𝑏𝑎𝑟-𝑅 control charts in Excel based on the data in Table
2.2

We reproduced the same charts in Python by running the script in How-To 2.4. The
resulting charts are displayed in Figure 2.7.

Figure 2.7: 𝑋𝑏𝑎𝑟-𝑅 control charts produced in Python using the data in Table 2.2
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(b) 𝑅 chart

We also recreated similar charts in Minitab by following the instructions in How-To
2.5. The charts that we obtained are illustrated in Figure 2.7.

Figure 2.7: 𝑋𝑏𝑎𝑟-𝑅 control charts in Minitab 18 from the data in Table 2.2

By examining any of these sets of 𝑋𝑏𝑎𝑟-𝑅 control charts, we conclude that the pro-
cess is unstable in both the 𝑋𝑏𝑎𝑟 and 𝑅 charts. The manager needs to investigate
samples 3, 10, and 27 and remove any sources of variations. Once the manager
has found and fixed all issues, these samples should be omitted and control charts
revised. If new out-of-control behaviors arise, the manager should repeat the same
process until the process is stable. For demonstration purposes, we used Minitab
to omit samples 3, 10, and 27, as shown in Figure 2.8.
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Figure 2.8: Omitting out-of-control samples from the 𝑋𝑏𝑎𝑟-𝑅 chart in Figure 2.7

The revised charts are portrayed in Figure 2.9. The default settings in Minitab
preserve the omitted points on the charts, but the centerline and control limits are
adjusted.

Figure 2.9: Revised 𝑋𝑏𝑎𝑟-𝑅 control charts in Minitab 18, after omitting samples 3,
10, and 27

2.2.4 XbarS control charts

We use 𝑋𝑏𝑎𝑟𝑆 charts, also noted as 𝑋𝑏𝑎𝑟-𝑆, to monitor the mean behavior using the
𝑋𝑏𝑎𝑟 chart and the variability using the 𝑆 chart. We typically utilize these charts when
the sample size 𝑛 > 10.
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Formulation

Box 2.3 summarizes the formulas for 𝑋𝑏𝑎𝑟-𝑆 charts.

Box 2.3 The formulas for 𝑋𝑏𝑎𝑟𝑆 control charts when 𝐿 = 3

When 𝜇 and 𝜎 standards are given, we apply these formulas:

𝑋𝑏𝑎𝑟 chart 𝑆 chart

UCL 𝜇+𝐴𝜎 𝐵6𝜎

CL 𝜇 𝑐4𝜎

LCL 𝜇−𝐴𝜎 𝐵5𝜎

When 𝜇 and 𝜎 standards are not given, we implement the following formulas:

𝑋𝑏𝑎𝑟 chart 𝑆 chart

UCL ¯̄𝑥+𝐴3𝑠 𝐵4𝑠

CL ¯̄𝑥 𝑠

LCL ¯̄𝑥 −𝐴3𝑠 𝐵3𝑠

In the 𝑋𝑏𝑎𝑟 chart, we monitor 𝑥𝑖 , the average mean in each sample 𝑖, for
𝑖 : 1, . . . ,𝑚, where 𝑚 is the total number of samples. In the 𝑆 chart, we monitor
𝑠𝑖 , the standard deviation in each sample 𝑖. We obtain the values of 𝐴, 𝐴3, 𝐵3, 𝐵4,
𝐵5, 𝐵6, and 𝑐4 from Appendix Table 12 by the constant sample size 𝑛.

How-To 2.7 (XbarS charts in Minitab 18) To construct 𝑋𝑏𝑎𝑟𝑆 charts in Minitab 18,
click on Stat > Control Charts > Variable Control Charts for Subgroups > Xbar-S >
In the drop-down menu, select Observations for a subgroup are in one row of
columns >Select your data >. See the snapshot in Figure 2.10.

Figure 2.10: Options for 𝑋𝑏𝑎𝑟-𝑆 control charts in Minitab 18
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How-To 2.8 (Python 3.6)

Script 2.3: A script for creating 𝑋𝑏𝑎𝑟-𝑆 charts in Python 3.6

#VARIABLE CHARTS- XbarS charts

#Import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an excel spreadsheet

data = read_excel(’your directory’)

#if column names in Excel, select the column of interest (e.g., data

= data[’column name’]

xr = [mean(data.loc[i]) for i in range(len(data))]

sd = [std(data.loc[i], ddof = 1)*1. for i in range(len(data))]

xbar = mean(xr)

sdbar = mean(sd)

t = arange(len(data))

#parameters fro Appendix Table 1. Next is an example of values when n

= 13

A3 = 0.850

B3 = 0.382

B4 = 1.618

#Xbar chart

#control limits

UCL = [xbar + A3*sdbar]*len(xr)

LCL = [max(0,xbar - A3*sdbar)]*len(xr)

CL = [xbar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue.

markers = []

colors = []

for i in range (len(xr)):

x1 = xr[i]

x2 = UCL[i]

x3 = LCL[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting Xbar

fig=figure()

ax1 = fig.add_subplot(111)

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")
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sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(r’$\overline{X}$’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (r’$\overline{\overline{X}}=$’+str(round(CL[0],2)), xy =

(xlim()[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),

fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

#########################

#S chart

#control limits

UCL = [sdbar*B4]*len(xr)

LCL = [max(0,sdbar*B3)]*len(xr)

CL = [sdbar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(xr)):

x1 = sd[i]

x2 = UCL[i]

x3 = LCL[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting S chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(sd,’b-’,zorder=1)

for x,y,c,m in zip(t, sd, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#pabel y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(r’$\overline{S}$’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)
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ax1.annotate (r’$\overline{S}=$’+str(round(CL[0],2)), xy = (xlim()

[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize =

11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

How-To 2.9 (𝑋𝑏𝑎𝑟-𝑆 charts in Excel 2013)
Excel does not have a built-in option to create 𝑋𝑏𝑎𝑟-𝑆 charts, but we can manually
program the formulas in Box 2.3 as we demonstrate in Example 2.3.

Example 2.3 (XbarS charts)
You are an intern at Metropolis Hospital, and you are working on a project to sta-
bilize the process of complete blood count (CBC) orders in the ED. The goal is
to reduce turn-around-time (TAT). Since the process on the weekends tends to be
different than the process on the weekdays, you have decided to start with orders
placed on the weekdays. Table 2.3 shows the random samples that you have col-
lected so far. Given that the sample size 𝑛 > 10, you have decided to use the
𝑋𝑏𝑎𝑟-𝑆 control charts to monitor the process. To get started, you looked up param-
eters 𝐴3, 𝐵3, and 𝐵4 in Appendix Table 12 when 𝑛 = 13 and obtained 0.850, 0.382,
1.618, respectively.
To create 𝑋𝑏𝑎𝑟-𝑆 control charts from this dataset, first set up your spreadsheet in
Excel, as shown in Figure 2.11, then proceed with these steps:

Step 1: Calculate the mean in each sample per Equation 2.1. For example, calcu-
late the 𝑋𝑏𝑎𝑟 in cell O3 using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵3 : 𝑁3). You can drag down
this formula to produce the rest of the 𝑋𝑏𝑎𝑟 values. Additionally, calculate the
𝑋𝑏𝑎𝑟𝑏𝑎𝑟 in cell Z5, per Equation 2.2, using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝑂3 :𝑂32).

Step 2: Next, calculate the sample standard deviation per Equation 2.4. For ex-
ample, the 𝑆 value in cell P3 was obtained using = 𝑆𝑇𝐷𝐸𝑉 .𝑆(𝐵3 :𝑁3). You
can drag down this formula to populate the rest of the 𝑆 values. To obtain the
𝑆𝑏𝑎𝑟, in cell R6, use = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝑃 3 : 𝑃 32).

Step 3: To construct control limits, apply the formulas in Box 2.3 when no stan-
dards are given. For example, the 𝑈𝐶𝐿 value in cell U3 was obtained using
= 𝑅𝑂𝑈𝑁𝐷($𝑍$4 * $𝑍$6,2), and the 𝐿𝐶𝐿 value in cell W3 was obtained by
= 𝑅𝑂𝑈𝑁𝐷($𝑍$3 * $𝑍$6,2). The 𝐶𝐿 value in cell V3 was determined as
= $𝑍$6.

Step 4: In this final step, insert the line charts of columns O and Q-S to create the
𝑋𝑏𝑎𝑟 chart. Also, insert lines charts of columns P and U-W to create the 𝑆
chart.
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Table 2.3: TAT of CBC orders in the ED, weekdays, Metropolis Hospital, 2018

Sample# 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5 𝑥6 𝑥7 𝑥8 𝑥9 𝑥10 𝑥11 𝑥12 𝑥13

1 40 45 39 30 36 38 43 46 39 39 33 34 23
2 47 40 27 56 30 53 48 34 36 36 36 41 54
3 38 31 33 44 46 27 28 37 35 41 39 53 39
4 42 25 30 26 30 49 37 34 32 57 34 39 34
5 31 37 43 40 46 43 47 32 26 36 53 30 52
6 39 47 45 46 32 43 36 52 29 34 38 42 45
7 30 35 44 42 56 27 38 41 36 44 38 24 30
8 27 34 29 46 39 38 35 45 43 47 35 53 32
9 40 47 59 45 40 38 37 33 35 25 49 49 39

10 49 46 33 28 34 41 29 41 44 47 37 37 31
11 24 43 42 41 38 50 39 60 58 48 80 44 45
12 31 33 48 37 42 28 41 42 45 26 30 26 46
13 34 41 24 42 41 50 39 36 57 26 54 46 39
14 27 44 51 35 41 58 35 33 32 39 40 41 43
15 32 26 55 48 42 38 45 43 55 29 29 27 35
16 39 36 50 46 43 39 34 54 42 42 38 46 33
17 31 33 57 25 28 27 25 49 45 33 39 44 51
18 33 41 34 41 49 40 37 43 40 37 31 42 39
19 46 40 45 33 29 36 41 58 37 29 35 39 37
20 38 52 44 51 42 33 29 34 39 32 32 35 36
21 30 23 48 59 37 41 52 38 34 34 39 39 33
22 29 26 27 54 47 29 39 39 21 36 42 56 48
23 34 30 55 40 36 40 47 30 23 26 29 27 57
24 56 31 45 30 45 44 41 27 45 55 35 43 45
25 47 39 50 39 30 33 35 37 59 35 42 50 40
26 31 50 31 52 42 49 35 29 26 49 33 33 33
27 44 57 38 46 27 36 33 28 32 34 28 38 30
28 28 31 44 44 25 32 36 36 40 40 20 34 43
29 45 36 29 42 47 34 34 40 42 51 22 30 36
30 40 31 29 41 40 31 38 37 30 41 33 42 49

Figure 2.11: An Excel setup for 𝑋𝑏𝑎𝑟-𝑆 control charts using the data in Table 2.2
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To create the same charts in Python, run the script in How-To 2.8. Your charts may
look as illustrated in Figure 2.12.

Figure 2.12: 𝑋𝑏𝑎𝑟𝑆 control charts produced in Python using the data in Table 2.3

(a) 𝑋𝑏𝑎𝑟 chart

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29
Sample number

30

32

34

36

38

40

42

44

46

48

X

UCL=46.05

X=38.88

LCL=31.72

(b) 𝑆 chart

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29
Sample number

2

4

6

8

10

12

14

S

UCL=13.64

S=8.43

LCL=3.22

From these charts, we appreciate that sample 11 is out-of-control in the 𝑋𝑏𝑎𝑟 chart.
The 𝑆 chart shows no points outside of the limits, but some unusual alternating
behaviors are noticeable. After applying sensitizing rules in Minitab 18, it becomes
apparent that the 𝑆 chart fails test 4 at points 19, 20, 21 (see Figure 2.13). Test 4
in Minitab 18 indicates that 14 points in a row are alternating up and down. To
run sensitizing rules for this case, click on Chart Options > Tests and select all the
sensitizing rules of interest (Review the instructions in How-To 1.30).
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Figure 2.13: 𝑋𝑏𝑎𝑟-𝑆 control charts produced in Minitab 18 using the data in Table
2.2

Remark (𝑠2 control chart): Besides the unbiased estimation methods of the standard deviation,
we can also monitor the process variability using the variance. To accomplish that, we use the 𝜒2

distribution and set up control limits as follows:

𝑈𝐶𝐿 =
𝑠2

𝑛− 1
𝜒2
𝛼/2,𝑛−1 (2.14)

𝐶𝐿 = 𝑠2 (2.15)

𝑈𝐶𝐿 =
𝑠2

𝑛− 1
𝜒2
1−(𝛼/2),𝑛−1 (2.16)

where 𝑠2 is the mean of all sample variances and 𝜒2 has the degree of freedom of 𝑛 − 1 at the
significance level 𝛼. If the standard deviation is given, we replace 𝑠2 with 𝜎2. This type of control
chart is known as 𝑠2 control chart [44].

2.3 Attribute control charts

We recall that we employ attribute charts to monitor processes that generate independent
discrete data. The attribute charts that we consider here are 𝑝, 𝑛𝑝, 𝑐, 𝑢, 𝑔, and ℎ.
If the interest is to monitor the fraction of defective units, we apply the 𝑝 chart. If
the interest is to monitor the number of defective units, we use the 𝑛𝑝 charts. The
𝑝 and 𝑛𝑝 charts portray the same information, but some users tend to prefer the 𝑛𝑝
charts since they portray whole units instead of fractions. If the interest is to monitor
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the number of defects per sample, we use 𝑐 charts. We apply 𝑢 charts to monitor the
average number of defects per unit. Additionally, 𝑢 charts allow us to monitor weighted
defects using a demerit system. For processes with rare defects, we use 𝑔 charts
to monitor the number of events between successive defects. The ℎ charts permit
us to monitor the average number of events between successive defects. Instead of
monitoring rare events, we could instead monitor the time between defects. To do that, we
may have to transform the data into normal distribution using methods such as Nelson’s
transformation. Then, we can apply traditional variable charts to monitor the process. A
map summarizing attribute charts is illustrated in Figure 2.14.

Figure 2.14: A basic map of attribute charts

Control Chart Application

Shewhart
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Variable

Time-weighted 

As compared to variable charts, attribute charts tend to be more prevalent in health
care given that most of the data generated there are discrete [44]. The following sce-
narios describe possible health care processes that could be monitored using attribute
charts.

Scenario 1: The manager of Labor and Delivery at Metropolis Hospital is interested in
using 𝑝 and 𝑛𝑝 charts to monitor the rate of cesarean-section (c-section) at the
hospital. Each month, a retrospective review will be conducted, and the rate of
c-section will be determined by dividing the total number of c-section by the total
number of deliveries. A detailed scenario discussing the application of 𝑝 charts to
monitor the rate of primary c-section is presented in Carey and Lloyd (1995) [10].

Scenario 2: The manager of a local surgery center will use 𝑝 charts to monitor the ad-
verse outcomes of thyroid surgery. More specifically, the manager will track the
fraction of thyroid surgical patients who experience a recurrence of either laryngeal
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nerve palsy or hypocalcemia. Each month the manager will perform an audit to
determine the rate of interest. Additionally, the manager will adjust for patient risk
factors and create a separate risk-adjusted 𝑝 chart. See Ross (2013) [53] for more
discussion about the use of 𝑝 charts to monitor the outcomes of thyroid surgery.

Scenario 3: The use of restraints and seclusions on patients is a practice that is dis-
couraged due to the potential of psychological and physical traumas [27, 55]. The
chairperson of the quality assurance committee of the psychiatric unit at Metropolis
Hospital would like to use 𝑐 charts to monitor the daily use rate of restraints and
seclusions. The chairperson will also use 𝑢 charts to monitor the use rate per pa-
tient. A case study discussing the application of control charts to monitor restraints
in psychiatric units is presented in Carey and Lloyd (1995) [10].

Scenario 4: On rare occasions, the use of information technology (IT) in clinical settings
has led to serious patient harm. Some of the incidents that have been reported in-
clude patient harm from wrong medications owing to the computerized provider
order entry (CPOE) system that failed to display alerts about drug interactions
[15, 35]. In one serious incident, a hospital’s picture archiving and communication
system (PACS) showed a wrong x-ray image, which resulted in patient death [35].
The CIO of Metropolis Hospital is working with the Chief Medical Officer (CMO) to
establish a system for tracking IT technical issues that result in severe patient harm
or near misses. Given the rarity of these events, 𝑔 and ℎ charts will be used for
monitoring the process.

Scenario 5: Document Imaging Technology allows for patient paper records to be scanned
and converted into digital images. The typical process of scanning patient records
includes the steps of removing staples, repairing torn papers, and the verification
of barcodes on each page to ensure the correct indexing of documents into the
patient’s electronic health record (EHR) [25, 48]. While errors due to barcoding
technology are infrequent (about 3 transactions in a million [48]), they do occasion-
ally occur nonetheless, and one could potentially end up with a patient record with
information from another patient. The manager of health informatics at Metropolis
Hospital would like to use Nelson’s transformation and 𝐼𝑚𝑅 charts to monitor the
number of days between barcode errors.

2.3.1 𝑝 and 𝑛𝑝 charts

The statistics for a 𝑝 chart

A 𝑝 chart is based on the Bernoulli random variable given by:

𝑝(𝑥) =

⎧⎪⎪⎨⎪⎪⎩𝑝 𝑥 = 1
1− 𝑝 𝑥 = 0

(2.17)

where 𝑝 is the probability of an event under study such as that of a unit being defective.
If a randomly selected unit is defective, 𝑥 = 1, otherwise 𝑥 = 0. The mean 𝜇 and the
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standard deviation 𝜎 of the Bernoulli random variable are given by:

𝜇 = 𝑝 (2.18)

𝜎 =
√︀
𝑝(1− 𝑝) (2.19)

Since we generally don’t know 𝑝, we estimate it from the process samples via the method
of the maximum likelihood estimator(MLE). Let’s suppose that we took 𝑚 number of sam-
ples. Each sample 𝑖 has a constant size 𝑛 and 𝐷𝑖 is the number of defective units in this
sample. The MLE estimator of 𝑝 is given by 𝑝̄ that we calculate as follows:

𝑝̄ =
∑︀𝑚

𝑖=1𝐷𝑖

𝑚𝑛
(2.20)

When the sample size is variable, we obtain 𝑝̄ like this:

𝑝̄ =
∑︀𝑚

𝑖=1𝐷𝑖∑︀𝑚
𝑖=1𝑛𝑖

(2.21)

The standard deviation of the 𝑝̄ statistic follows from the central limit theorem and is given
by:

𝜎𝑝̄ =

√︂
𝑝̄(1− 𝑝̄)

𝑛
(2.22)

The statistics for an 𝑛𝑝 chart

An 𝑛𝑝 chart is based on the binomial random variable given by:

𝑃 {𝐷 = 𝑥} =
(︃
𝑛
𝑥

)︃
𝑝𝑥(1− 𝑝)𝑛−𝑥 𝑥 = 0,1,2, . . . ,𝑛 (2.23)

where 𝐷 symbolizes the number of defective units. Here, 𝑃 (𝐷 = 𝑥) characterizes the
probability of observing 𝑥 number of defective units in a sample of size 𝑛. The mean and
standard deviation of the binomial random variable are given by:

𝜇 = 𝑛𝑝 (2.24)

𝜎 =
√︀
𝑛𝑝(1− 𝑝) (2.25)

where 𝑝, if not given, is estimated by 𝑝̄ per Equation 2.20 or 2.21.

Formulation

Box 2.4 summarizes the formulas for creating 𝑝 and 𝑛𝑝 charts.
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Box 2.4 The formulas for 𝑝 and 𝑛𝑝 control charts when 𝐿 = 3

When the standard of 𝑝 is given, we apply these formulas:

𝑝 chart 𝑛𝑝 chart

UCL 𝑝+3

√︂
𝑝(1− 𝑝)

𝑛
𝑛𝑝+3

√︀
𝑛𝑝(1− 𝑝)

CL 𝑝 𝑛𝑝

LCL 𝑝 − 3
√︂

𝑝(1− 𝑝)
𝑛

𝑛𝑝 − 3
√︀
𝑛𝑝(1− 𝑝)

When no standard of 𝑝 is given, we apply the following formulas:

𝑝 chart 𝑛𝑝 chart

UCL 𝑝̄+3

√︂
𝑝̄(1− 𝑝̄)

𝑛
𝑛𝑝̄+3

√︀
𝑛𝑝̄(1− 𝑝̄)

CL 𝑝̄ 𝑛𝑝̄

LCL 𝑝̄ − 3
√︂

𝑝̄(1− 𝑝̄)
𝑛

𝑛𝑝̄ − 3
√︀
𝑛𝑝̄(1− 𝑝̄)

In the 𝑛𝑝 chart we monitor the number of defective units 𝐷𝑖 , for 𝑖 : 1, . . . ,𝑚, where 𝑚
is the total number of samples. In the 𝑝 chart, we monitor the fraction of defective
units 𝑝̂𝑖 = 𝐷𝑖/𝑛 when 𝑛 is constant. When 𝑛 is variable, we replace 𝑛 by 𝑛𝑖 , which
creates variable control limits. Alternatively, we could monitor the process using
the standardized values given by:

𝑍𝑖 =
𝑝̂𝑖 − 𝑝√︁
𝑝(1−𝑝)

𝑛𝑖

𝑖 = 1,2, . . . ,𝑚 (2.26)

with 𝑈𝐶𝐿 = 3, 𝐶𝐿 = 0, and 𝐿𝐶𝐿 = −3. If not given, 𝑝 is estimated with 𝑝̄ [44].

Remark (LCL > 0): It is common practice to set the LCL value 𝑥 to max(0,𝑥) since negative
defective units don’t make sense. This approach generally works well, but it does not allow for the
capture information about when the process is doing well (e.g., small numbers of defective units)
since all we will observe is LCL = 0. To remedy this problem, we choose the sample size 𝑛 so that
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LCL is always positive. To do that, we proceed as follows:

𝑝̄ −𝐿
√︂

𝑝̄(1− 𝑝̄)
𝑛

= 0 (2.27)

−𝐿
√︂

𝑝̄(1− 𝑝̄)
𝑛

= −𝑝̄ (2.28)⎛⎜⎜⎜⎜⎜⎝−𝐿
√︂

𝑝̄(1− 𝑝̄)
𝑛

⎞⎟⎟⎟⎟⎟⎠
2

= (−𝑝̄)2 (2.29)

𝐿2𝑝̄(1− 𝑝̄)
𝑛

= 𝑝̄2 (2.30)

𝐿2𝑝̄(1− 𝑝̄)
𝑝̄2

= 𝑛 (2.31)

𝐿2(1− 𝑝̄)
𝑝̄

= 𝑛 (2.32)

So, to ensure that 𝐿𝐶𝐿 > 0, we must choose 𝑛 such that:

𝑛 ≥
⌈︃
𝐿2(1− 𝑝̄)

𝑝̄

⌉︃
(2.33)

where ⌈.⌉ is a ceiling function. In this book, the default value of 𝐿 is 3.

How-To 2.10 (𝑝 and 𝑛𝑝 charts in Minitab 18)
To construct 𝑝 and 𝑛𝑝 charts in Minitab 18, click on Stat > Control Charts > Attribute
Charts > select the appropriate chart > Select your data > Input the sample size or
the column of sample sizes>OK. See the snapshot in Figure 2.15.

Figure 2.15: Options for p and np control charts in Minitab 18

How-To 2.11 (Python 3.6)

Script 2.4: A script for creating 𝑝 and 𝑍 charts in Python 3.6



Chapter 2. Shewhart Control Charts 93

#ATTRIBUTE CHARTS- P and Z charts

#Import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an excel spreadsheet

#Di is the column of defects and Ni is the column of sample sizes

data = read_excel(’your directory’)

xr = [data.Di[i]*1./data.Ni[i] for i in xrange(len(data))]#phat

t = arange(len(xr))

pbar = 1.*data.Di.sum()/ data.Ni.sum()

#P chart

#control limits

UCL = [pbar + 3.*sqrt(pbar*(1.-pbar)/data.Ni[i]) for i in xrange(len

(xr))]

LCL = [max(0.,pbar - 3.*sqrt(pbar*(1.-pbar)/data.Ni[i])) for i in

xrange(len(xr))]

CL = [pbar]*(len(xr))

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in xrange (len(xr)):

x1 = xr[i]

if x1 > UCL[i]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting the P chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.step(t,UCL, ’k-’, alpha = 0.5, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

ylim(ymin = -0.01)

xlim(-0.5, t[-1]+1)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Fraction nonconforming’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[0],3)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$\overline{P}=$’+str(round(CL[0],3)), xy = (xlim()[1],

list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[0],3)), xy = (xlim()[1], list(
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LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

#####################################

#Z chart

data[’xt’] = data.Di/data.Ni

pbar = 1.*data.Di.sum()/ data.Ni.sum()

xr = [(data.xt[i] - pbar)/sqrt(pbar*(1.-pbar)/data.Ni[i]) for i in

xrange(len(data))]

t = arange(len(xr))

#control limits

UCL = [3. for i in xrange(len(xr))]

LCL = [-3 for i in xrange(len(xr))]

CL = [0]*(len(xr))

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in xrange (len(xr)):

x1 = xr[i]

if x1 > UCL[i]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting Z chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.step(t,UCL, ’k-’, alpha = 0.5, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

ylim(-3.5, 3.5)

xlim(-0.5, t[-1]+1)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’$Z_i$’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[0],3)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’’+str(round(CL[0],1)), xy = (xlim()[1], list(CL)[-1]),

xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[0],3)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()
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How-To 2.12 (𝑝 and 𝑛𝑝 charts in Excel 2013)
Excel does not have a built-in option to create 𝑝 and 𝑛𝑝 charts, but we can manually
program the formulas in Box 2.4 as we demonstrate in Example 2.4.

Example 2.4 (𝑝 and 𝑛𝑝 charts)
The HIMa manager at Metropolis Hospital sits on the revenue cycle steering com-
mittee. At the last week’s meeting, it was decided to start monitoring billing denials
by the department. The HIM manager was charged with monitoring denials due to
medical coding errors. Table 2.4 presents monthly denials for the last 30 months.
The column of 𝐷𝑒𝑛𝑖𝑎𝑙𝑠 represents the variable sample size of all denials, and the
𝐶𝑜𝑑𝑖𝑛𝑔 column contains the number of denials due to medical coding errors.

Table 2.4: Denials related to medical coding errors at Metropolis Hospital

Sample# Denials Coding Sample# Denials Coding

1 36 4 16 38 5
2 39 2 17 20 5
3 22 7 18 49 4
4 44 5 19 39 6
5 22 5 20 46 6
6 45 2 21 45 5
7 33 6 22 37 5
8 21 6 23 42 2
9 37 7 24 45 7
10 40 3 25 30 4
11 41 2 26 38 2
12 27 7 27 24 9
13 34 8 28 27 3
14 23 4 29 32 2
15 27 7 30 48 6

The manager has decided to apply the 𝑝 and 𝑛𝑝 charts to monitor the process.
Using Python, the manager programmed the formulas in Box 2.4, when 𝑝 is not
given, and produced the charts in Figures 2.16 - 2.18.
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Figure 2.16: A 𝑝 chart based on the data in Table 2.4
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Figure 2.17: An 𝑛𝑝 chart based on the data in Table 2.4
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Figure 2.18: A 𝑍 chart based on the data in Table 2.4
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All charts indicate out-of-control behaviors in sample 27. To improve the process,
the manager needs to find and fix all the causes of special variation in this sample.
Subsequently, sample 27 can be omitted, and a new control chart created to
continue to monitor the process. This procedure should be iterated until no more
out-of-control behaviors exist in the process.

Next, we demonstrate how you can reproduce the 𝑝 and 𝑍 charts in Excel.
The replication of the 𝑛𝑝 chart is left for an exercise.

1. First set up your spreadsheet, as illustrated in Figure 2.19.

Figure 2.19: A setup of Excel to create the 𝑝 and 𝑍 charts based on the data in
Table 2.4

A B C D E F G H I J

1 Denials Coding phat Zi LCL CL UCL Parameters

2 36 4 0.11 -0.52 0 0.14 0.31 pbar 0.14

3 39 2 0.05 -1.62 0 0.14 0.31

4 22 7 0.32 2.43 0 0.14 0.36

5 44 5 0.11 -0.57 0 0.14 0.3

6 22 5 0.23 1.22 0 0.14 0.36

7 45 2 0.04 -1.93 0 0.14 0.3

8 33 6 0.18 0.66 0 0.14 0.32

9 21 6 0.29 1.98 0 0.14 0.37

10 37 7 0.19 0.88 0 0.14 0.31

11 40 3 0.08 -1.09 0 0.14 0.3

12 41 2 0.05 -1.66 0 0.14 0.3

13 27 7 0.26 1.8 0 0.14 0.34

14 34 8 0.24 1.68 0 0.14 0.32

15 23 4 0.17 0.41 0 0.14 0.36

16 27 7 0.26 1.8 0 0.14 0.34

17 38 5 0.13 -0.18 0 0.14 0.31

18 20 5 0.25 1.42 0 0.14 0.37

19 49 4 0.08 -1.21 0 0.14 0.29

20 39 6 0.15 0.18 0 0.14 0.31

21 46 6 0.13 -0.2 0 0.14 0.29

22 45 5 0.11 -0.58 0 0.14 0.3

23 37 5 0.14 0 0 0.14 0.31

24 42 2 0.05 -1.68 0 0.14 0.3

25 45 7 0.16 0.39 0 0.14 0.3

26 30 4 0.13 -0.16 0 0.14 0.33

27 38 2 0.05 -1.6 0 0.14 0.31

28 24 9 0.38 3.39 0 0.14 0.35

29 27 3 0.11 -0.45 0 0.14 0.34

30 32 2 0.06 -1.3 0 0.14 0.32

31 48 6 0.13 -0.2 0 0.14 0.29
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2. Determine the 𝑝̄ value in cell 𝐽2 as indicated in Equation 2.21. Proceed this
way: = 𝑅𝑂𝑈𝑁𝐷(𝑆𝑈𝑀(𝐵2 : 𝐵31)/𝑆𝑈𝑀(𝐴2 : 𝐴31),2).

3. Calculate the 𝑝̂𝑖 statistic for each month 𝑖 using this ratio: 𝐶𝑜𝑑𝑖𝑛𝑔/𝐷𝑒𝑛𝑖𝑎𝑙𝑠.
For example, the value in cell 𝐶2 was obtained by = 𝑅𝑂𝑈𝑁𝐷(𝐵2/𝐴2,2). You
can drag down this formula to populate the rest of the values.

4. Create control limits when no standards are given, as indicated in Box 2.4. For
example, the value of LCL in cell 𝐸2 was calculated using = 𝑀𝐴𝑋(0,$𝐽$2−
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3 * 𝑆𝑄𝑅𝑇 ($𝐽$2 * (1− $𝐽$2)/𝐴2)). The value of CL in cell 𝐹2 was obtained by
= $𝐽$2. The value of UCL in cell 𝐺2 was determined using = 𝑅𝑂𝑈𝑁𝐷($𝐽$2+
3 * 𝑆𝑄𝑅𝑇 ($𝐽$2 * (1− $𝐽$2)/𝐴2),2).

5. To create the p chart, insert line charts for columns C, E, F, and G.

6. To determine the 𝑍𝑖 statistic for each month 𝑖, encode Equation 2.26. For
example, the value of 𝑍𝑖 in cell 𝐷2 was obtained by = 𝑅𝑂𝑈𝑁𝐷((𝐶2 −
$𝐽$2)/𝑆𝑄𝑅𝑇 ($𝐽$2 * (1 − $𝐽$2)/𝐴2),2). Drag down this formula to populate
the rest of the values.

To reproduce the same charts in Minitab, follow the instructions in How-To 2.10.

aHIM: Health Information Management

2.3.2 𝑐 and 𝑢 charts

The statistics for a 𝑐 chart

We use a 𝑐 chart to monitor the variable count of defects 𝐶 in the process. The probability
of observing 𝐶 = 𝑥 count of defects obeys the Poisson random variable and is expressed
like this:

𝑝(𝐶 = 𝑥) =
𝑒−𝑐𝑐𝑥

𝑥!
𝑥 = 0,1,2, . . . (2.34)

where 𝑐, the rate of defects, if not given, can be approximated using the MLE method as
follows:

𝑐 ≈ 𝑐 =
∑︀𝑚

𝑖=1𝐶𝑖

𝑚
(2.35)

where 𝑚 is the total number of samples. We recall that the mean and variance of a
Poisson random variable are equal, meaning that, for our process, we have:

𝜇 = 𝑐 (2.36)
𝜎 =

√
𝑐 (2.37)

The statistics for a 𝑢 chart

We use a 𝑢 chart to monitor the average count of defects per unit. A 𝑢 chart also obeys
the Poisson random variable with a rate 𝑢̄ that we estimate this way:

𝑢̄ =
𝑐
𝑛

(2.38)

where 𝑐 is obtained per Equation 2.35 and 𝑛 is the sample size. From the central limit
theorem, we approximate the standard deviation of our process this way:

𝜎𝑢̄ =

√︂
𝑢̄
𝑛
≡ 1
𝑛

√
𝑐 (2.39)
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Formulation with unweighted defects

Box 2.5 presents the formulas to construct the 𝑐 and 𝑢 charts when defects are not
weighted. In other words, we assume that defects as have equal severity.

Box 2.5 The formulas for the 𝑐 and 𝑢 control charts when 𝐿 = 3 and
defects are unweighted

When the standard rate c is given, we apply the formulas below:

𝑐 chart 𝑢 chart

UCL 𝑐+3
√
𝑐 𝑢 +3

√︂
𝑢
𝑛

CL 𝑐 𝑐

LCL 𝑐 − 3
√
𝑐 𝑢 − 3

√︂
𝑢
𝑛

where 𝑢 = 𝑐/𝑛. When the standard rate c is not given, we employ the following
formulas:

𝑐 chart 𝑢 chart

UCL 𝑐+3
√
𝑐 𝑢̄ +3

√︂
𝑢̄
𝑛

CL 𝑐 𝑢̄

LCL 𝑐 − 3
√
𝑐 𝑢̄ − 3

√︂
𝑢̄
𝑛

In the 𝑐 chart, we monitor the count of defects 𝐶𝑖 , for 𝑖 : 1, . . . ,𝑚, where 𝑚 is the
total number of samples. In the 𝑢 chart, we monitor the average count of defects
given by 𝑢𝑖 = 𝐶𝑖/𝑛. When the sample size is variable, we replace 𝑛 by 𝑛𝑖 , which
creates variable control limits. Alternatively, we can monitor the process using
standardized values given by:

𝑍𝑖 =
𝑢𝑖 − 𝑢̄√︁

𝑢̄
𝑛𝑖

(2.40)

We set 𝑈𝐶𝐿 = 3, 𝐶𝐿 = 0, and 𝐿𝐶𝐿 = −3 [44].

Remark (LCL>0): Like in the 𝑝 and 𝑛𝑝 charts, it is common practice to set the LCL value 𝑥 to
max(0,𝑥) since negative defects can’t occur. To be able to capture all instances of low defects in
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the process, we choose 𝑛 so 𝐿𝐶𝐿 > 0 as follows:

𝑢̄ −𝐿
√︂

𝑢̄
𝑛

= 0 (2.41)

−𝐿
√︂

𝑢̄
𝑛

= −𝑢̄ (2.42)⎛⎜⎜⎜⎜⎝−𝐿√︂ 𝑢̄
𝑛

⎞⎟⎟⎟⎟⎠2 = (−𝑢̄)2 (2.43)

𝐿2𝑢̄
𝑛

= 𝑢̄2 (2.44)

𝐿2

𝑢̄
= 𝑛 (2.45)

So, to assure 𝐿𝐶𝐿 > 0, we must choose 𝑛 that satisfies this inequality:

𝑛 ≥
⌈︃
𝐿2

𝑢̄

⌉︃
(2.46)

where ⌈.⌉, as before, is the ceiling function for rounding up.

Formulation with weighted defects

When defects differ in severity, we group them into classes and assign each class a
weight according to some demerit system. Box 2.6 presents a demerit system of defects
commonly used in the manufacturing sector [44]. This weighing system can also be
adopted for typical health care processes.

Box 2.6 A demerit system of defects

Each independent defect is assigned to one of the following classes [44]:

Class A: a very serious defect with a weight of 100

Class B: a serious defect with a weight of 50

Class C: a moderately serious defect with a weight of 10

Class D: a minor defect with a weight of 1

To monitor a process with weighted defects, we use 𝑢 charts. The corresponding
formulas are summarized in Box 2.6.
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Box 2.7 A demerit-based 𝑢 chart when 𝐿 = 3

We construct a demerit-based 𝑢 chart as follows [44]:

𝑈𝐶𝐿 = 𝑢̄ +3𝜎𝑢 (2.47)
𝐶𝐿 = 𝑢̄ (2.48)

𝐿𝐶𝐿 = 𝑢̄ − 3𝜎𝑢 (2.49)

where

𝑢̄ = 100𝑢̄𝐴 +50𝑢̄𝐵 +10𝑢̄𝐶 +1𝑢̄𝐷 (2.50)

and

𝜎𝑢 =

√︂
1002𝑢̄𝐴 +502𝑢̄𝐵 +102𝑢̄𝐶 +1𝑢̄𝐷

𝑛
(2.51)

Here, 𝑢̄𝐴, 𝑢̄𝐵, 𝑢̄𝐶 , and 𝑢̄𝐷 are the averages of defects in classes A, B, C, and D,
respectively. The weighted statistic to be monitored 𝑢𝐷𝑖 , for each sample 𝑖, is
given by:

𝑢𝐷𝑖 = 100𝑢𝑖𝐴 +50𝑢𝑖𝐵 +10𝑢𝑖𝐶 +1𝑢𝑖𝐷 𝑖 = 1,2, . . . ,𝑚 (2.52)

How-To 2.13 (𝑐 and 𝑢 charts in Minitab 18)
To create the 𝑐 and 𝑢 charts in Minitab, Click on Stat > Control Charts > Attribute
Charts > Select the appropriate chart. Note: there is no option for creating a
demerit-based u chart. We will show how to construct this chart using Excel.

Figure 2.20: Options for creating c and u control charts in Minitab 18
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How-To 2.14 (Python 3.6)

Script 2.5: A script for creating 𝑐 and 𝑢 charts in Python 3.6

#ATTRIBUTE CHARTS C and U

#import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#Import data from an excel spreadsheet

#Ci is the column of defects and Ni is the column of sample sizes

data = read_excel(’your directory’)

#C-CHART

xr = data.Ci

cbar = mean(data.Ci)

t = arange(len(xr))

#control limits

UCL = [cbar + 3.*sqrt(cbar)]*len(xr)

LCL = [cbar - 3.*sqrt(cbar)]*len(xr)

CL = [cbar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(xr)):

x1 = xr[i]

if (x1 > UCL[i] or x1<LCL[i]):

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#Plotting

fig=figure()

ax1 = fig.add_subplot(111)

ax1.step(t,UCL, ’k-’, alpha = 0.5, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.step(t,CL, ’k-’,alpha = 1, where = ’mid’)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Number of nonconformities’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$CL=$’+str(round(CL[-1],2)), xy = (xlim()[1], list(CL)

[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(
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LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

##############################

#U-CHART

xr = data.Ci/data.Ni

t = arange(len(xr))

n = mean(data.Ni)

ubar = cbar/n

#control limits

UCL = [ubar + 3.*sqrt(ubar/n)]*len(xr)

LCL = [ubar - 3.*sqrt(ubar/n)]*len(xr)

CL = [ubar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(xr)):

x1 = xr[i]

if (x1 > UCL[i] or x1<LCL[i]):

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting U chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.step(t,UCL, ’k-’, alpha = 1, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 1, where = ’mid’)

ax1.step(t,UCL, ’k-’, alpha = 0.5, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.step(t,CL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’u’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$\overline{C}=$’+str(round(CL[-1],2)), xy = (xlim()

[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize =

11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()
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How-To 2.15 (𝑐 and 𝑢 charts in Excel 2013)
Excel does not have a built-in option to create 𝑐 and 𝑢 charts, but we can manually
program the formulas in Box 2.5 as we demonstrate in Example 2.5.

Table 2.5: Weekly samples and the changes made to the codes of the CAC system by
the class

Week n A B C D Week n A B C D

1 25 14 4 3 29 21 25 6 3 7 28
2 25 5 4 19 12 22 25 11 1 4 15
3 25 10 1 8 13 23 25 5 2 16 20
4 25 14 4 10 30 24 25 8 0 9 16
5 25 1 0 1 15 25 25 10 4 9 10
6 25 4 2 2 21 26 25 15 4 8 10
7 25 9 1 10 14 27 25 14 3 2 28
8 25 2 2 16 29 28 25 6 3 6 13
9 25 8 3 14 13 29 25 4 1 16 28
10 25 11 1 10 25 30 25 4 5 1 15
11 25 12 3 12 26 31 25 6 1 5 22
12 25 10 5 2 12 32 25 8 3 11 19
13 25 1 4 1 24 33 25 13 2 11 16
14 25 14 0 17 11 34 25 8 4 17 14
15 25 8 1 16 25 35 25 4 3 9 18
16 25 8 5 12 13 36 25 2 1 11 11
17 25 9 5 3 20 37 25 1 1 16 16
18 25 14 5 13 19 38 25 14 2 8 23
19 25 6 1 9 28 39 25 15 2 3 26
20 25 2 5 5 26 40 25 2 0 7 29

Example 2.5 (𝑐 and 𝑢 charts)
Metropolis Hospital has just implemented an EHR system, which came with a mod-
ule on computer-assisted coding (CAC). Like many CAC technologies on the mar-
ket, the one soon to be used at Metropolis Hospital also employs the elements of
convolution networks and natural language processing (NLP) to translate electronic
clinical notes into medical classification and terminology codes such as SNOMED-
CTa, ICD-10-CM/PCSb, and CPTc. These codes can then be used for many pur-
poses, including health information exchange (HIE), reimbursement, quality re-
porting, and operational management. The hospital’s CEO is excited about the
prospects of this new technology to reduce coding costs and boost productivity.
But, the HIM manager has cautioned that all existing CAC systems still require
trained medical coders to audit the codes [24]. Accordingly, the manager has de-
cided to track the performance of the CAC system by taking 25 random samples
each week and recording the changes that coders make, including adding, remov-
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ing, or modifying codes. Furthermore, the manager created a demerit system to
weigh the significance of the changes. Table 2.5 presents random samples that the
manager has collected. The demerit system utilized has four classes (A, B, C, and
D) as described next:

Class A: The change of the principal diagnosis or principal procedure code (weight
of 100)

Class B: The change of a secondary diagnosis or a secondary procedure code
(weight of 50)

Class C: The change of a code classified as a factor influencing health status and
contact with health services (weight of 10)

Class D: The change of an external cause code (weight of 1)

Using the data in Table 2.5, the manager used Python to program the 𝑐 chart,
unweighted 𝑢 chart, and weighted 𝑢 chart as portrayed in Figures 2.21 - 2.23,
respectively.

Figure 2.21: A 𝑐 chart created using Python based on the data in Table 2.5
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Figure 2.22: An unweighted 𝑢 chart created using Python based on the data in
Table 2.5
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Figure 2.23: A weighted 𝑢 chart created using Python based on the data in Table
2.5
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Both the 𝑐 and unweighted 𝑢 charts indicate that samples 4 and 5 are out-of-
control. After weighing the defects with the given demerit-system, the 𝑢 chart
shows that only sample 5 falls outside of the control limits. Also, samples 36 and
37 violated a sensitizing rule that forbids two out of three consecutive points from
falling between the second and third limits on the same side. To improve the
process, the manager will have to find and remove all assignable causes from the
process.

To reproduce the same charts in Excel, set up your spreadsheet, as illustrated in
Figure 2.24.
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Figure 2.24: A setup of Excel to create the 𝑐 and 𝑢 control charts based on the
data in Table 2.5

A B C D E F G H I J K L M N O P Q R S T

1

2 A B C D ui Ci uDi uDisqr LCL CL UCL LCL CL UCL LCL CL UCL Parameters

3 0.56 0.16 0.12 1.16 2 50 66.36 6013.16 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 ubar 1.56

4 0.2 0.16 0.76 0.48 1.6 40 36.08 2476.48 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 cbar 39

5 0.4 0.04 0.32 0.52 1.3 32 45.72 4132.52 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 uDbar 41.2

6 0.56 0.16 0.4 1.2 2.3 58 69.2 6041.2 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 uDstd 11.8

7 0.04 0 0.04 0.6 0.7 17 5 404.6 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 n 25

8 0.16 0.08 0.08 0.84 1.2 29 21.64 1808.84 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

9 0.36 0.04 0.4 0.56 1.4 34 42.56 3740.56 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 A 100

10 0.08 0.08 0.64 1.16 2 49 19.56 1065.16 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 B 50

11 0.32 0.12 0.56 0.52 1.5 38 44.12 3556.52 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 C 10

12 0.44 0.04 0.4 1 1.9 47 51 4541 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7 D 1

13 0.48 0.12 0.48 1.04 2.1 53 59.84 5149.04 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

14 0.4 0.2 0.08 0.48 1.2 29 51.28 4508.48 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

15 0.04 0.16 0.04 0.96 1.2 30 13.36 804.96 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

16 0.56 0 0.68 0.44 1.7 42 63.24 5668.44 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

17 0.32 0.04 0.64 1 2 50 41.4 3365 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

18 0.32 0.2 0.48 0.52 1.5 38 47.32 3748.52 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

19 0.36 0.2 0.12 0.8 1.5 37 48 4112.8 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

20 0.56 0.2 0.52 0.76 2 51 71.96 6152.76 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

21 0.24 0.04 0.36 1.12 1.8 44 30.72 2537.12 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

22 0.08 0.2 0.2 1.04 1.5 38 21.04 1321.04 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

23 0.24 0.12 0.28 1.12 1.8 44 33.92 2729.12 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

24 0.44 0.04 0.16 0.6 1.2 31 48.2 4516.6 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

25 0.2 0.08 0.64 0.8 1.7 43 31.2 2264.8 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

26 0.32 0 0.36 0.64 1.3 33 36.24 3236.64 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

27 0.4 0.16 0.36 0.4 1.3 33 52 4436.4 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

28 0.6 0.16 0.32 0.4 1.5 37 71.6 6432.4 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

29 0.56 0.12 0.08 1.12 1.9 47 63.92 5909.12 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

30 0.24 0.12 0.24 0.52 1.1 28 32.92 2724.52 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

31 0.16 0.04 0.64 1.12 2 49 25.52 1765.12 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

32 0.16 0.2 0.04 0.6 1 25 27 2104.6 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

33 0.24 0.04 0.2 0.88 1.4 34 28.88 2520.88 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

34 0.32 0.12 0.44 0.76 1.6 41 43.16 3544.76 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

35 0.52 0.08 0.44 0.64 1.7 42 61.04 5444.64 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

36 0.32 0.16 0.68 0.56 1.7 43 47.36 3668.56 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

37 0.16 0.12 0.36 0.72 1.4 34 26.32 1936.72 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

38 0.08 0.04 0.44 0.44 1 25 14.84 944.44 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

39 0.04 0.04 0.64 0.64 1.4 34 13.04 564.64 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

40 0.56 0.08 0.32 0.92 1.9 47 64.12 5832.92 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

41 0.6 0.08 0.12 1.04 1.8 46 66.24 6213.04 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7

42 0.08 0 0.28 1.16 1.5 38 11.96 829.16 0.81 1.56 2.3 5.9 41.2 76.6 20.3 39 57.7
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The explanation of how we set up the spreadsheet in Figure 2.24 follows.

1. Columns A through D in Figure 2.24 reflect the data from Table 2.5 after
dividing each row by 25. For example, the values of row 3, columns A-D,
were obtained as: 14/25 = 0.56, 4/25 = 0.16, 3/25 = 0.12, and 29/25 = 1.16,
respectively.

2. Column E contains the 𝑢𝑖 statistic to be monitored in an unweighted 𝑢 chart.
For example, the value in cell 𝐸3 was obtained by = 𝑆𝑈𝑀(𝐴3 :𝐷3). You can
drag down this formula to populate the rest of the values.

3. Column F contains the 𝐶𝑖 statistic to be monitored in a 𝑐 chart. For example,
the value in cell 𝐹3 was obtained by = 𝐸3 * $𝑇 $7, which is equivalent to
summing all values of the first row in Table 2.5 (14 + 4 + 3+ 29 = 50). You can
drag down the formula in F3 to populate the rest of the 𝐶𝑖 values.

4. Column 𝐺 contains the 𝑢𝐷𝑖 statistic to be monitored in a demerit-based 𝑢
chart. Equation 2.52 is used to calculate each value. For example, the value
in cell 𝐺3 was obtained using = 𝐴3 * $𝑇 $9+𝐵3 * $𝑇 $10+𝐶3 * $𝑇 $11+𝐷3 *
$𝑇 $12.

5. Column H contains values that will be used to determine the standard devia-
tion to create the control limits for the demerit-based 𝑢 chart. Each value was
obtained using the radicand in Equation 2.51. For example, the value in cell
𝐻3 was obtained like this: = 𝐴3*$𝑇 $9∧2+𝐵3*$𝑇 $10∧2+𝐶3*$𝑇 $11∧2+𝐷3*
$𝑇 $12∧2. You can drag down this formula to populate the rest of the values.
To include an exponent in Excel, use the caret sign ∧.
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6. The details for calculating the parameters for creating the control limits follow.

(a) The 𝑢̄ value in cell 𝑇 3 was obtained this way: = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐸3 : 𝐸42).

(b) The 𝑐 value in cell 𝑇 4 was calculated this way: = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐹3 : 𝐹42).

(c) The 𝑢̄𝐷 value in cell 𝑇 5 was obtained this way: = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐺3 :
𝐺42).

(d) The 𝜎𝑢 value in cell 𝑇 6 was determined by = 𝑆𝑄𝑅𝑇 (𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐻3 :
𝐻42)/𝑇 7).

(e) The sample size 𝑛 in cell 𝑇 7 comes from column n in Table 2.5.

(f) The demerit weights in cells 𝑇 9 - 𝑇 12 come from Box 2.6.

7. To determine the control limits, per formulas in Boxes 2.5 and 2.7, the first
row was computed as follows:

(a) The value of LCL in cell 𝐼3 was obtained as follows: = $𝑇 $3 − 3 *
𝑆𝑄𝑅𝑇 ($𝑇 $3/$𝑇 $7).

(b) The value of CL in cell 𝐽3 was calculated like this: = $𝑇 $3.

(c) The value of UCL in cell 𝐾3 was given by: = $𝑇 $3 + 3 *
𝑆𝑄𝑅𝑇 ($𝑇 $3/$𝑇 $7).

(d) The value of LCL in cell 𝐿3 was computed this way: = $𝑇 $5− 3 * $𝑇 $6.

(e) The value of CL in cell 𝑀3 was obtained like this: = $𝑇 $5.

(f) The value of UCL in cell 𝑁3 was obtained this way: = $𝑇 $5+3 * $𝑇 $6.

(g) The value of LCL in cell 𝑂3 was calculated this way: = $𝑇 $4 − 3 *
𝑆𝑄𝑅𝑇 ($𝑇 $4).

(h) The value of CL in cell 𝑃 3 was obtained this way: = $𝑇 $4.

(i) The value of UCL in cell 𝑄3 was calculated this way: = $𝑇 $4 + 3 *
𝑆𝑄𝑅𝑇 ($𝑇 $4).

8. To create the control charts of interest proceed by:

(a) Inserting line charts of columns E and I-K to create an unweighted 𝑢
chart.

(b) Inserting line charts of columns F and O-Q to create a 𝑐 chart.

(c) Inserting line charts of columns G and L-N to create a demerit-based 𝑢
chart.

You can recreate the 𝑐 and unweighted 𝑢 charts in Minitab by following the instruc-
tions in How-To 2.13.

aSNOMED-CT: Systematized Nomenclature of Medicine – Clinical Terms
bICD-10-CM/PCS: The International Classification of Diseases, Tenth Revision, Clinical Modifi-

cation/Procedure Coding System
cCPT: Current Procedural Terminology
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2.3.3 𝑔 and ℎ charts

The statistics for a 𝑔 chart

We use 𝑔 charts to model the total number of events between rare incidents. It is
assumed that these events are independent and identically distributed according to the
geometric distribution modeled as follows [34]:

𝑝(𝑥) = 𝑝(1− 𝑝)𝑥−𝑎 𝑥 = 𝑎,𝑎+1, 𝑎+2, . . . (2.53)

where 𝑎 is the minimum number of events, and 𝑝 is the probability of an event. Unless 𝑝
is given, we can estimate it using 𝑝̄ like this [44]:

𝑝̄ =
1

𝑥 − 𝑎+1
(2.54)

Here, 𝑥 is the average number of events. The mean 𝜇𝑇 and standard deviation 𝜎𝑇 for the
process of the total number of events are given by [44]:

𝜇𝑇 = 𝑛

(︃
1− 𝑝
𝑝

+ 𝑎

)︃
(2.55)

𝜎𝑇 =
𝑛(1− 𝑝)

𝑝2
(2.56)

where 𝑛 is the sample size.

The statistics for a ℎ chart

We use ℎ charts to model the average number of events between rare incidents. The
occurrence of these events is also assumed to follow the geometric distribution shown
Equation 2.53. The mean 𝜇𝑥 and standard deviation 𝜎𝑥 in this case, are given by:

𝜇𝑥 =
1− 𝑝
𝑝

+ 𝑎 (2.57)

𝜎𝑥 =
(1− 𝑝)
𝑛𝑝2

(2.58)

If not given, we estimate 𝑝 as indicated in Equation 2.54.

Formulation

Box 2.8 summarizes the formulas for the 𝑔 and ℎ charts.

The time between rare events

Instead of monitoring the number of events between successive rare incidents, we could
instead try to monitor the time between them. If defects occur according to a Poisson
distribution, the time between events can be modeled using an exponential distribution.
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Box 2.8 The formulas for the 𝑔 and ℎ control charts when 𝐿 = 3

When the standard 𝑝 is given, we construct the 𝑔 and ℎ charts as follows:

𝑔 chart ℎ chart

UCL 𝑛

(︃
1− 𝑝
𝑝

+ 𝑎

)︃
+3

√︃
𝑛(1− 𝑝)

𝑝2
1− 𝑝
𝑝

+ 𝑎+3

√︂
1− 𝑝
𝑛𝑝2

CL 𝑛

(︃
1− 𝑝
𝑝

+ 𝑎

)︃
1− 𝑝
𝑝

+ 𝑎

LCL 𝑛

(︃
1− 𝑝
𝑝

+ 𝑎

)︃
− 3

√︃
𝑛(1− 𝑝)

𝑝2
1− 𝑝
𝑝

+ 𝑎− 3
√︂

1− 𝑝
𝑛𝑝2

When the standard 𝑝 is not given, we construct the 𝑔 and ℎ charts this way:

𝑔 chart ℎ chart

UCL 𝑛

(︃
1− 𝑝̄
𝑝̄

+ 𝑎

)︃
+3

√︃
𝑛(1− 𝑝̄)

𝑝̄2
1− 𝑝̄
𝑝̄

+ 𝑎+3

√︂
1− 𝑝̄
𝑛𝑝̄2

CL 𝑛

(︃
1− 𝑝̄
𝑝̄

+ 𝑎

)︃
1− 𝑝̄
𝑝̄

+ 𝑎

LCL 𝑛

(︃
1− 𝑝̄
𝑝̄

+ 𝑎

)︃
− 3

√︃
𝑛(1− 𝑝̄)

𝑝̄2
1− 𝑝̄
𝑝̄

+ 𝑎− 3
√︂

1− 𝑝̄
𝑛𝑝̄2

In the 𝑔 chart, we monitor the total number of events between successive rare
incidents. In the ℎ chart, we monitor the corresponding average number of events.

But, the exponential distribution is not typically used to construct control charts due to the
skewness of this distribution [44]. To get around this issue, we transform the exponential
data into a Weibull distribution to allow for the approximation of the normal distribution.
The following Nelson’s transformation is usually used for this purpose [44, 65].

𝑥 = 𝑥0.2777 (2.59)

Here, 𝑥 is the original data, and 𝑥 is the transformed data. Subsequently, we can apply
traditional variable control charts using the transformed data [65]. We should note that,
besides Nelson’s method in Equation 2.59, other data transformation techniques exist,
such as the approach used to create 𝑇 charts in Minitab 18 [66].
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How-To 2.16 (Python 3.6)

Script 2.6: A script for creating a 𝑔 chart in Python 3.6

#ATTRIBUTE CHARTS G chart

#import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#Import data from an excel spreadsheet

#Bi is the column for the number of events between successive rare

events

data = read_excel(’your directory’)

#G chart

xr = data.Bi

t = arange(len(xr))

n = 1.

a = 1.

xbarbar = xr.mean() - a +1.

p = 1./xbarbar

L = 3.

std = sqrt(n*(1.-p)/(p**2))

#control limits

CL = [n*(((1.-p)/p)+a)]*len(xr)

UCL = [CL[0] + L*std ]*len(xr)

LCL = [max(0,CL[0] - L*std)]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in xrange (len(xr)):

x1 = xr[i]

if (x1 > UCL[i] or x1<LCL[i]):

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting the G chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.step(t,CL, ’k-’,alpha = 1, where = ’mid’)

ax1.step(t,UCL, ’k-’, alpha = 1, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 1, where = ’mid’)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Number of events’)
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#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$CL=$’+str(round(CL[-1],2)), xy = (xlim()[1], list(CL)

[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 2), arange(1, len(data)+1, step = 2))

show()

How-To 2.17 (Python 3.6)

Script 2.7: A script for Nelson’s transformation in Python 3.6

#ATTRIBUTE CHARTS to VARIABLE CHARTS via Nelson’s transformation

#Import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an excel spreadsheet. Days is the column with time

data

data = read_excel(’your directory’)

#Nelson’s transformation

data[’xt’] = data[’Days’].apply(lambda x: x**0.2777)

#initialize parameters for IMR charts

xr = data.xt

xbar = mean(xr)

d2 = 1.128

D3 = 0.

D4 = 3.267

mr = [abs(xr[i]-xr[i-1]) for i in range(1, len(xr))]

mrbar = mean(mr)

t = arange(len(data))

#I chart

#control limits

UCL = [xbar + 3.*(mrbar/d2)]*len(xr)

LCL = [ max(0,xbar - 3.*(mrbar/d2))]*len(xr)

CL = [xbar]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(data)):

x1 = data.ix[i][’xt’]

if x1 > UCL[0]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)
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#plotting I chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Individual value’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[0],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$\overline{X}=$’+str(round(CL[0],2)), xy = (xlim()[1],

list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[0],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 3), arange(1, len(data)+1, step = 3))

show()

####################

#MR chart

#control limits

UCL = [mrbar*D4]*len(mr)

LCL = [max(0,mrbar*D3)]*len(mr)

CL = [mrbar ]*len(mr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(mr)):

x1 = mr[i]

x2 = UCL[i]

x3 = LCL[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plotting MR chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(mr,’b-’,zorder=1)

for x,y,c,m in zip(t, mr, colors, markers):
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ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

ylim(ymin = -0.1)

xlim(-0.3, t[-1]+1)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Moving Range’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (r’$\overline{MR}=$’+str(round(CL[0],2)), xy = (xlim()

[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize =

11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(data), step = 3), arange(1, len(data)+1, step = 3))

show()

How-To 2.18 (Rare events in Minitab 18)
To construct rare events charts in Minitab 18, click on Stat > Control Charts > Rare
Event Charts > select the appropriate chart. Minitab 18 only has the choices for the
G and T charts. See the snapshot in Figure 2.25.

Figure 2.25: Options for the 𝐺 and 𝑇 charts in Minitab 18

How-To 2.19 (𝑔 and ℎ charts in Excel 2013)
Excel does not have a built-in option to create 𝑔 and ℎ charts, but we can manually
program the formulas in Box 2.8 as we demonstrate in Example 2.6.



Chapter 2. Shewhart Control Charts 115

Example 2.6 (𝑔 chart)
During a regular meeting of the patient safety committee at Metropolis Hospital, a
discussion came up about how to track and monitor hospital-acquired conditions
(HACs). The HIM manager who sits on this committee suggested that in addition to
the data from the incident reporting system, ICD-10-CM/PCSa and POAb indicators
could also be used to track HACs. The committee approved this suggestion and
recommended that ICD-10-CM/PCS codes and POA indicators be used to track
the following HACs events as defined by CMS [26]:

1. Foreign objects retained after surgery

2. Air embolism

3. Stage III and IV pressure ulcers

4. Falls and trauma

5. Manifestations of glycemic control

6. Catheter-associated urinary tract infection

7. Vascular catheter-associated infection

8. Post-surgical wound infection

9. Deep vein thrombosis

10. Iatrogenic pneumothorax with venous catheterization.

Given the rarity of these HACs at Metropolis Hospital, the committee decided to ap-
ply the 𝑔 chart to monitor the number of discharges between successive incidents.
The historical data collected so far is shown in Table 2.6.

Table 2.6: The number of discharges between HACs

HAC#
Discharges

HAC#
Discharges

Between Between

1 20 14 210
2 16 15 81
3 120 16 15
4 41 17 45
5 380 18 17
6 66 19 174
7 21 20 29
8 249 21 312
9 34 22 66
10 24 23 24
11 100 24 35
12 50 25 142
13 31 26 27
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Python was applied to create the 𝑔 chart per Box 2.8 using 𝑎 = 1 and 𝑛 = 1. The
resulting chart is portrayed in Figure 2.26.

Figure 2.26: A 𝑔 chart created using Python based on the data in Table 2.6
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Figure 2.26 shows that sample 5 is out-of-control. Unless this was a reporting
error, this represents a process that was doing well since there was an unusually
high number of discharges between HAC#4 and HAC#6. The manager should
investigate this point and learn about what happened during that period and then
recalculate the control charts. To reproduce the same chart in Excel, first set up
your spreadsheet, as shown in Figure 2.27 and then follow subsequent instructions.

Figure 2.27: A setup of a 𝑔 control chart in Excel based on the data in Table 2.6

A B C D E F G H

1 Failure# Discharges LCL CL UCL Parameters

2 1 20 0 89.58 356.8035 phat 0.011164

3 2 16 0 89.58 356.8035 mean 89.57692

4 3 120 0 89.58 356.8035 std 89.07552

5 4 41 0 89.58 356.8035

6 5 380 0 89.58 356.8035

7 6 66 0 89.58 356.8035

8 7 21 0 89.58 356.8035

9 8 249 0 89.58 356.8035

10 9 34 0 89.58 356.8035

11 10 24 0 89.58 356.8035

12 11 100 0 89.58 356.8035

13 12 50 0 89.58 356.8035

14 13 31 0 89.58 356.8035

15 14 210 0 89.58 356.8035

16 15 81 0 89.58 356.8035

17 16 15 0 89.58 356.8035

18 17 45 0 89.58 356.8035

19 18 17 0 89.58 356.8035

20 19 174 0 89.58 356.8035

21 20 29 0 89.58 356.8035

22 21 312 0 89.58 356.8035

23 22 66 0 89.58 356.8035

24 23 24 0 89.58 356.8035

25 24 35 0 89.58 356.8035

26 25 142 0 89.58 356.8035

27 26 27 0 89.58 356.8035
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1. First, determine the parameters of your 𝑔 chart:

(a) The phat (𝑝̂) in cell 𝐻2 follows from Equation 2.54 when 𝑎 = 1. This
quantity was obtained using = 1/𝐻3.

(b) The mean value in cell 𝐻3 was calculated as = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵2 : 𝐵27).

(c) Per Box 2.8, the value of the standard deviation in cell 𝐻4 was obtained
this way = 𝑆𝑄𝑅𝑇 ((1−𝐻2)/𝐻2∧2.

2. Next, create the control limits. For example,

(a) The 𝐿𝐶𝐿 value in cell 𝐶2 was obtained this way: = 𝑀𝐴𝑋(0,1/$𝐻$2 −
3 *$𝐻$4). This formula can be dragged down to populate the rest of the
values.

(b) The 𝐶𝐿 value in cell 𝐷2 was obtained like this: = $𝐻$3. This formula
can also be dragged down to populate the rest of the values.

(c) The 𝑈𝐶𝐿 value in cell 𝐸2 was obtained this way: = 𝑀𝐴𝑋(0,1/$𝐻$2 +
3 *$𝐻$4). Again, this formula can be dragged down to populate the rest
of the values.

3. Finally, create the 𝑔 chart by inserting line charts of columns B-E.

aICD-10-CM/PCS: International Classification of Diseases-10-Clinical Modification/Procedure
Coding System

bPOA: Present on Admission



118 2.3. Attribute control charts

Table 2.7: Number of days until the next HAC event

HAC#
Days Days

HAC #
Days Days

between transformed Between Transformed

1 56 3.058242 31 33 2.640531
2 21 2.329058 32 43 2.841935
3 19 2.265217 33 78 3.353009
4 48 2.930088 34 8 1.781509
5 8 1.781509 35 15 2.121292
6 117 3.752625 36 4 1.469576
7 4 1.469576 37 17 2.19632
8 15 2.121292 38 80 3.376666
9 140 3.944389 39 5 1.563522
10 1 1.000000 40 146 3.990624
11 11 1.946233 41 3 1.35674
12 99 3.582514 42 31 2.595082
13 112 3.707386 43 34 2.662513
14 8 1.781509 44 60 3.117401
15 16 2.159654 45 15 2.121292
16 22 2.359341 46 3 1.35674
17 45 2.878042 47 15 2.121292
18 112 3.707386 48 108 3.670133
19 24 2.417045 49 41 2.804594
20 23 2.388646 50 80 3.376666
21 13 2.038647 51 25 2.444601
22 89 3.478128 52 103 3.622137
23 19 2.265217 53 39 2.765914
24 96 3.552031 54 77 3.341015
25 14 2.081037 55 6 1.644722
26 18 2.23146 56 44 2.860137
27 35 2.684032 57 135 3.904754
28 22 2.359341 58 2 1.212261
29 38 2.746034 59 94 3.531324
30 30 2.571559 60 9 1.840743

Example 2.7 (Data transformation)
Following from Example 2.6, the safety committee also decided to monitor the num-
ber of days between successive HACs. Table 2.6 shows the transformed number
of days to be monitored using 𝐼-𝑀𝑅 charts. Before applying these charts, the com-
mittee wanted to make sure that the normality assumption, which is required for
variable charts, was satisfied. Accordingly, probability plots were created in Minitab,
as illustrated in Figure 2.28.
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Figure 2.28: Probability plots of days based on the data in Table 2.7

(a) Days before transformation

(b) Days after transformation

The plot in Subfigure 2.28b indicates that the transformed days are about normally
distributed since 𝑝-𝑣𝑎𝑙𝑢𝑒 > 0.05. This result suggests the failure to reject the hy-
pothesis that the transformed days are normally distributed. Subsequently, the
committee created 𝐼-𝑀𝑅 charts per Box 2.1. The resulting charts are portrayed
in Figure 2.29.
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Figure 2.29: 𝐼-𝑀𝑅 control charts based on the transformed number of days in
Table 2.7

(a) 𝐼 𝑐ℎ𝑎𝑟𝑡
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(b) 𝑀𝑅 𝑐ℎ𝑎𝑟𝑡
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Subfigure 2.29a indicates a stable process, but Subfigure 2.29b shows out-of-
control behaviors in the moving ranges at sample number 9. The committee in-
vestigated this sample and assigned it to a data entry error. As a result, sample
9 was omitted from the process, and control charts were recreated to monitor the
future process. The new charts are presented in Figure 2.30.
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Figure 2.30: 𝐼-𝑀𝑅 control charts, based on the transformed number of days in
Table 2.7, after removing sample 9
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(b) 𝑀𝑅 𝑐ℎ𝑎𝑟𝑡
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2.4 EXERCISES

1. Using Excel, reproduce the 𝑋𝑏𝑎𝑟𝑆 chart in Example 2.3.

2. The chief financial officer at Metropolis Hospital would like to start monitoring the
costs for total hip replacements. Table 2.8 presents samples of 40 individual pa-
tients who recently had hips replaced at this facility. Using Excel, create appropriate
control charts, and stabilize the process. What can you conclude? Hint: to stabilize
the process, if any point falls outside of the control limits, remove it and create new
control charts. Repeat this procedure until the process is stable.

Table 2.8: Costs X in thousand, for total hip replacements at Metropolis Hospital, 2018

Patient# X Patient# X

1 34 21 33
2 41 22 35
3 40 23 28
4 36 24 39
5 37 25 37
6 35 26 36
7 42 27 36
8 37 28 48
9 31 29 39
10 42 30 33
11 44 31 27
12 35 32 28
13 37 33 25
14 26 34 34
15 27 35 42
16 49 36 31
17 29 37 47
18 30 38 29
19 40 39 38
20 39 40 37

3. At Metropolis Hospital, the CIO keeps track of the queue time of IT tickets. Table
2.9 portrays the samples that the manager has collected. Use this data to create
appropriate control charts and then stabilize the process. What can you conclude?
If the goal is to have an average queue time of 70 minutes, how is the IT department
doing on this goal?
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Table 2.9: Queue time in minutes, clinical IT tickets at Metropolis Hospital, 2018

Sample# x1 x2 x3 x4 x5 x6 x7

1 110 45 84 86 58 75 38
2 80 70 110 148 32 84 42
3 22 111 37 100 109 62 63
4 82 67 55 30 129 63 57
5 74 40 82 59 82 43 84
6 38 40 139 100 59 44 85
7 80 123 52 80 48 45 96
8 76 97 54 64 65 75 110
9 64 47 66 135 65 79 91
10 80 35 47 59 50 119 44
11 65 76 118 64 38 49 66
12 60 67 41 86 73 128 88
13 105 49 87 68 105 63 42
14 104 138 50 67 102 54 122
15 51 54 58 81 79 143 61
16 47 60 90 61 66 58 145
17 61 94 104 60 83 50 96
18 32 79 79 99 61 70 84
19 32 101 111 85 48 103 40
20 55 23 97 123 58 47 54
21 46 32 47 55 88 103 80
22 52 130 63 32 50 141 105
23 108 66 104 101 103 100 95
24 90 38 64 64 107 44 84
25 102 48 51 93 55 53 58
26 33 64 57 110 41 114 67
27 37 81 84 90 69 113 52
28 99 96 80 112 84 131 32
29 94 89 114 80 41 96 83
30 78 44 118 58 75 107 63
31 74 123 61 95 109 68 114
32 102 45 63 49 127 78 70
33 79 130 122 51 32 61 62
34 102 31 68 97 68 109 99
35 122 62 56 87 38 70 77
36 81 104 85 52 57 40 28
37 79 43 86 72 57 110 50
38 49 95 71 132 90 112 82
39 200 46 99 150 90 103 80
40 83 72 46 80 44 87 36
41 123 44 108 73 56 51 86
42 96 114 106 33 56 90 101
43 37 53 44 46 50 70 82
44 71 82 112 85 102 43 119
45 126 37 40 31 47 100 120
46 104 87 113 79 59 79 59
47 89 95 54 64 61 102 66
48 61 44 50 59 33 63 73
49 43 53 66 94 95 82 80
50 45 65 56 84 62 24 107
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4. The Chief Medical Officer (CMO) at Metropolis Hospital keeps track of the time to
extubation of ICU patients. Table 2.10 presents monthly sample statistics of this
time. The sample size is 𝑛 = 13, 𝜇 = 6, 𝜎 = 3. Create appropriate control charts,
with and without these standards.

(a) What can you conclude about the stability of the process?

(b) Any ideas about how to improve the stability of the process?

Table 2.10: Monthly sample statistics of time to extubation, Metropolis Hospital, 2015-
2018

Week # 𝑥 𝑠 Week # 𝑥 𝑠

1 5.2 2.4 16 6.3 3.8
2 6.3 4.5 17 6.9 3.4
3 6.5 3.9 18 7.2 5.8
4 7.5 2.9 19 6.5 2.4
5 6.9 3.1 20 6.1 3.1
6 5.7 3.3 21 5.6 2.7
7 7.3 2.1 22 5.3 2.7
8 6.8 3.9 23 7.9 7.9
9 5 2.3 24 5.8 3.6

10 6.8 2.5 25 3.4 2
11 5.9 3.7 26 6.7 4.6
12 8.3 3.5 27 7.5 2.7
13 5.1 4.2 28 6.2 2.3
14 5.5 3.7 29 5 3.4
15 5.6 3.2 30 6.1 1.9

5. The manager of the emergency department (ED) at Metropolis Hospital would like
to monitor and control the number of patients leaving without being seen (LWBS).
Table 2.11 presents samples collected on weekdays. Implement appropriate con-
trol charts for the rate and the number of LWBS. If any point falls outside of the
limits, remove it, and recreate the charts. Repeat this procedure until the process
is stable.

(a) What can you conclude?

(b) How would this process perform against the LWBS target of 2.5%?
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Table 2.11: Weekday samples of LWBS in the ED at Metropolis Hospital, 2018

Sample# Visits LWBS Sample# Visits LWBS

1 221 7 31 182 5
2 217 10 32 245 3
3 201 9 33 197 8
4 200 6 34 239 7
5 247 4 35 204 6
6 231 7 36 213 4
7 243 5 37 180 5
8 240 7 38 208 11
9 246 7 39 231 7

10 225 4 40 195 6
11 247 9 41 201 7
12 202 4 42 230 4
13 233 7 43 203 7
14 216 8 44 236 8
15 215 5 45 191 6
16 224 4 46 230 9
17 220 6 47 234 8
18 201 4 48 229 3
19 198 8 49 231 9
20 225 8 50 224 3
21 250 7 51 226 4
22 245 9 52 201 3
23 225 9 53 249 7
24 225 8 54 225 8
25 209 7 55 181 8
26 237 8 56 216 7
27 181 7 57 220 6
28 196 6 58 249 16
29 183 6 59 216 4
30 233 9 60 184 6

6. The CMO at Metropolis Hospital wants to monitor postoperative sternal wound in-
fections for patients who had open-heart surgeries. Given the rarity of such events,
the manager will not monitor the number of infections, but rather the number of
surgeries between successive infections. Sample data are presented in Table 2.12.
Create an appropriate control chart for this process. What can you conclude?
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Table 2.12: Number of surgeries between post-operative sternal wound infections at
Metropolis Hospital, 2018

Infection# #s of surgeries Infection# #s of surgeries

1 27 17 45
2 38 18 7
3 7 19 8
4 9 20 6
5 9 21 5
6 13 22 12
7 7 23 6
8 14 24 26
9 72 25 4
10 4 26 61
11 7 27 14
12 4 28 6
13 3 29 13
14 30 30 19
15 7 31 51
16 35 32 5

Table 2.13: Weekly samples of billing errors at Metropolis Hospital, 2018

Week n A B C D Week n A B C D

1 33 12 5 10 16 21 33 10 1 18 13
2 33 10 3 16 11 22 33 14 2 2 12
3 33 14 4 10 28 23 33 3 3 4 17
4 33 7 5 9 14 24 33 10 3 4 22
5 33 5 3 10 11 25 33 6 2 8 27
6 33 11 2 15 11 26 33 15 0 0 15
7 33 4 0 1 10 27 33 5 5 1 21
8 33 7 0 19 19 28 33 14 2 10 29
9 33 1 4 9 10 29 33 8 3 9 23
10 33 9 5 4 23 30 33 15 1 19 18
11 33 10 2 11 28 31 33 14 2 18 27
12 33 14 4 7 11 32 33 10 0 4 23
13 33 13 0 14 16 33 33 2 4 3 10
14 33 12 3 0 10 34 33 9 3 6 22
15 33 12 3 12 22 35 33 12 5 11 30
16 33 13 3 20 30 36 33 12 3 15 21
17 33 15 0 13 26 37 33 11 0 9 13
18 33 14 4 3 30 38 33 12 1 14 12
19 33 11 1 15 14 39 33 4 5 5 11
20 33 5 1 17 16 40 33 13 5 17 16

7. Consider the data in Table 2.13 showing medical billing errors by the demerit class
defined and weighted per Box 2.6.
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(a) Create a 𝑐 chart for this process

(b) Create a 𝑍 chart for this process

(c) Create a demerit-based 𝑢 chart for this process.

(d) Compare and contrast the results from your charts. What can you conclude?

8. The Chief Nursing Officer (CNO) at Metropolis Hospital has just asked you to help
create an appropriate control chart for monitoring urinary tract infection (UTI) at the
hospital. The CNO has indicated that the numbers of UTIs are few and far between.
Accordingly, you suggested monitoring the number of days between UTIs instead
of tracking the count of UTIs. The CNO handed you the data presented in Table
2.14.

(a) Create two applicable control charts and choose the best chart.

(b) Create probability plots to support the choice of your control chart.

(c) What can you conclude?

Table 2.14: Days between UTIs at Metropolis Hospital, 2014 - 2018

UTI#
Days

UTI#
Days

Between Between

1 61 17 25
2 46 18 17
3 46 19 15
4 102 20 35
5 38 21 14
6 11 22 20
7 22 23 24
8 91 24 62
9 18 25 31
10 31 26 60
11 77 27 18
12 17 28 43
13 94 29 30
14 2 30 16
15 31 31 43
16 66 32 29

9. Table 2.15 presents frequencies of monthly overrides of critical alerts in the CPOE
system at Metropolis Hospital. Use this data to create an appropriate control chart.

(a) Using probability plots, justify the choice of the control chart that you applied.

(b) What can you conclude about the stability fo this process?
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Table 2.15: Critical alert overrides in the CPOE system at Metropolis Hospital, 2014-
2018

Month #Overrides Month #Overrides

1 42 21 40
2 46 22 47
3 17 23 47
4 25 24 9
5 41 25 44
6 38 26 24
7 23 27 8
8 55 28 23
9 28 29 36

10 12 30 55
11 14 31 63
12 26 32 60
13 28 33 53
14 32 34 26
15 11 35 26
16 53 36 13
17 20 37 11
18 5 38 8
19 8 39 29
20 15 40 75

10. Recreate the 𝑛𝑝 chart in Example 2.4. What should the sample size be to ensure
that 𝐿𝐶𝐿 > 0?



CHAPTER 3

Time-Weighted Control Charts

Summary

In this chapter, we review how to apply time-weighted control charts to
detect small shifts in the process. Here, we only consider cumulative sum
(CUSUM), exponentially weighted moving average (EWMA), and moving
average (MA) charts. We provide statistical formulas of these charts and
demonstrate how to implement them using Excel, Minitab, and Python
software.

Key concepts and tools

Time-weighted charts; CUSUM; EWMA; MA; Out-of-control behaviors;
Assignable causes; Special cause variation; Common cause variation;
Phase II; Proportional–integral–derivative (PID); Process regulation

Major objectives

After studying this chapter, you will be able to:

1. Define key concepts and tools of time-weighted control charts
2. Recognize the need for time-weighted charts
3. Reiterate different phases of chart application
4. Compare and contrast Shewhart and time-weighted control charts
5. Design and apply CUSUM control charts
6. Design and apply EWMA control charts
7. Design and apply MA control charts
8. Evaluate the stability of a process using time-weighted control charts
9. Implement time-weighted control charts using Excel, Python, and

Minitab
10. Regulate a process using an EWMA model

129
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3.1 Introduction

In this chapter, we discuss the time-weighted control charts. We typically implement
these charts during phase II of the control chart application to detect small shifts in the
process. We recall that we apply Shewhart charts in phase I to detect big shifts and
stabilize the process.

As the name implies, time-weighted charts involve weighing data over time. In this
case, we weigh each sample given the time when that sample was collected. This pro-
cedure permits us to incorporate past information into the current process performance
measure, which facilitates the detection of small shifts in the process over time. Here, we
only consider the three most common types of time-weighted charts, namely CUSUM,
EWMA, and MA. These charts are applicable to both variable and attribute processes
when samples are independent. When samples are dependent, we can, for instance, ap-
ply EWMA techniques for autocorrelated data [44]. Besides, we can also employ EWMA
concepts to regulate a process, as we demonstrate later.

Figure 3.1 depicts a basic decision tree for selecting time-weighted charts by the
phase of control chart application.

Figure 3.1: Selecting a time-weighted chart by the phase of control chart application

Control Chart Application

Shewhart

Phase I Phase II

Time-weighted 

CUSUM EWMA MA

Like in Shewhart charts, we detect out-of-control behaviors in time-weighted charts
by finding points that fall outside of the control limits. But, unlike in traditional Shewhart
charts, special cause variation in a time-weighted chart is not confined to the sample that
falls outside of the limits since this event is due to the cumulative effect of multiple sam-
ples. So, when investigating the source of special cause variation, we have to begin from
the sample when the process first started to drift away from the target. After remov-
ing all assignable causes, we reset the control charts to initial conditions and resume
monitoring the process. We typically do not apply sensitizing rules with time-weighted
charts, but we could still look for obvious abnormalities, such as points that hover too
close to the control limits. In How-To 3.1, we present general instructions for accessing
time-weighted charts options in Minitab 18. When discussing each chart, we will present
specific instructions as well as a Python script to create the chart of interest. We will also
show how to set up time-weighted charts using Microsoft Excel.
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How-To 3.1 (Time-weighted charts in Minitab 18)
Click on Stat > Control Charts > Time-Weighted Charts > Select the chart of inter-
est. See the snapshot in Figure 3.2.

Figure 3.2: A menu of time-weighted charts in Minitab 18

Before diving into specifics of time-weighted charts, we first present possible scenar-
ios where these charts may be applicable in health care processes.

Scenario 1: Last year, General Hospital implemented a CPOE1 system. Over the past
few months, the CIO of this hospital has worked hard to stabilize the order entry
process using 𝑝-charts. The CPOE system is now compliant with the Centers for
Medicare and Medicaid Services (CMS) stage 3 meaningful use, given that more
than 60% of orders for medication, laboratory, and diagnostic imaging are entered
by licensed professionals using this system [16]. The CIO’s next plan is to apply
CUSUM charts to attempt to detect small shifts in the new process.

Scenario 2: CMS mandates the reporting of several quality measures, including the time
to administer antibiotics to pneumonia patients and the time to give aspirin to heart
attack patients [12]. The quality manager at Metropolis Hospital, who is in charge
of data reporting, used 𝐼𝑚𝑅 charts to stabilize the process of the timely reporting
of all required quality measures. Next, the manager will implement CUSUM charts
to monitor small shifts in the new process.

Scenario 3: The manager of Metropolis Medical Practice monitors the productivity of
physicians. One measure of productivity that the manager uses is the relative value
unit (RVU). Given that the process has been stable for the past several months,
the manager has decided to apply MA charts to monitor small shifts in the future

1CPOE: computerized provider order entry
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process. For further discussion about the use of RVUs to monitor productivity in
medical practices, see Stewart (2002) [60] and Thor et al. (2007) [61].

Scenario 4: Metropolis Hospital has recently implemented an EHR system with a medium
for documenting clinical problem lists using SNOMED-CT2. Currently, the hospital
is using this option to record the emergency department (ED) chief complaints. But,
providers still have an option to use free-text. The goal of the hospital is to minimize
the utilization of free-text to promote data integrity and consistency. Accordingly, the
ED manager has proposed using c-charts to monitor the daily number of times the
free-text alert is overwritten. After stabilizing the process, the manager intends to
implement EWMA charts for phase II of the control chart application. To read more
about the use of control charts to monitor the documentation of chief complaints in
the ED, see Aronsky et al. (2001) [4].

3.2 CUSUM charts

We apply CUSUM charts to monitor cumulative deviations 𝐶𝑖 from the target 𝜇0. We
determine 𝐶𝑖 this way:

𝐶𝑖 =
𝑖∑︁

𝑗=1

(𝑥𝑗 −𝜇0) (3.1)

≡ 𝑥𝑖 −𝜇0 +𝐶𝑖−1 (3.2)

where 𝑥𝑖 is the statistic of interest in sample 𝑖, for 𝑖 : 1, . . . ,𝑚, and 𝑚 is the number of
samples. It is common practice to apply CUSUM charts to monitor individual observations
when the sample size 𝑛 = 1. When 𝑛 > 1, we monitor 𝑥𝑖 , the mean of sample 𝑖. We
assume that all samples are independent. If the process is in control, 𝐶𝑖 will fluctuate
around zero. If 𝐶𝑖 continuously drifts away from the target until it exceeds the limits, the
special cause variation likely has occurred.

Formulation

Box 3.1 summarizes the formulas for a type of CUSUM charts known as Tabular or
Algorithmic. V-mask is another common type of CUSUM charts, but we do not consider
it here [44].

2SNOMED-CT: Systematized Nomenclature of Medicine -Clinical Terms
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Box 3.1 Tabular CUSUM charts for mean behaviors

We set the control limits of a tabular CUSUM chart to ±𝐻 , where 𝐻 = ℎ𝜎 and ℎ is
a constant set between 4 and 5 to ensure good in-control 𝐴𝑅𝐿 performance. As
before, 𝜎 denotes the process standard deviation, and we can estimate it from the
process samples. When ℎ = 4.77, 𝐴𝑅𝐿 ≈ 370, which corresponds to the perfor-
mance of an in-control 3𝜎 Shewhart control chart. In CUSUM charts, we monitor
two statistics given by 𝐶+

𝑖 and 𝐶−𝑖 . The formulas of these quantities are as follows:

𝐶+
𝑖 = max

[︁
0,𝑥𝑖 −𝜇0 − 𝑘 +𝐶+

𝑖−1
]︁

(3.3)

𝐶−𝑖 = min
[︁
0,𝑥𝑖 −𝜇0 + 𝑘 +𝐶−𝑖−1

]︁
(3.4)

where 𝐶+
0 = 𝐶−0 = 0 and 𝑘 is the slack value generally set to half the shift that

we want to detect. So, if we wanted to detect a shift of one standard deviation,
we would set 𝑘 = 1/2. In practice, it is common to standardize CUSUM charts by
replacing 𝑥𝑖 −𝜇0 in Equations 3.3 and 3.4 with 𝑦𝑖 given by [44]:

𝑦𝑖 =
𝑥𝑖 −𝜇0

𝜎
(3.5)

To monitor variability, we utilize a scale CUSUM chart formulated in Box 3.2.

Box 3.2 A scale CUSUM chart for variability

To monitor variability using CUSUM charts, we track the statistics of 𝑆+
𝑖 and 𝑆−𝑖

given by:

𝑆+
𝑖 = max

[︁
0,𝑣𝑖 − 𝑘 +𝐶+

𝑖−1
]︁

(3.6)

𝑆−𝑖 = min
[︁
0,𝑣𝑖 + 𝑘 +𝐶−𝑖−1

]︁
(3.7)

Here, 𝑆+
0 = 𝑆−0 = 0 and

𝑣𝑖 =

√︀
|𝑦𝑖 | − 0.822
0.349

(3.8)

where 𝑦𝑖 is as defined in Equation 3.5 [32]. We set the control limits and the slack
value 𝑘 as previously described in Box 3.1 [44].

How-To 3.2 (Tabular CUSUM options in Minitab 18)

1. Click on CUSUM as portrayed in How-To 3.1

2. Input the subgroup size > input the target > click on CUSUM Options as
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shown in Figure 3.3.

Figure 3.3: CUSUM chart options in Minitab 18, the main screen

3. Click on tab Plan/Type > change the ℎ and 𝑘 values as necessary. Make sure
the Tabular type is selected. See the snapshot in Figure 3.4.

Figure 3.4: CUSUM chart options in Minitab 18, Plan/Type tab

4. Click 𝑂𝐾 > 𝑂𝐾 to create your chart.
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How-To 3.3 (Python 3.6)

Script 3.1: A script for creating a tabular CUSUM chart using Python 3.6

#TIME WEIGHTED CHARTS CUSUM

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

data = read_excel(’your directory’)

#parameters

L = 3.

lmda = 0.2

h= 5.

d2 = 1.128

xr = data.xt

mrbar = mean([abs(data.xt[i] -data.xt[i-1]) for i in range(1,len(data

.xt))])

sigma = mrbar/d2

K = sigma*0.5

target = 10.# for python2

xbar = target #mean(xr)

#set up control limits

c1 =[0.]

c2 = [0.]

for i in range(len(xr)):

c1i = max(0, xr[i] - (xbar + K) + c1[i])

c2i = min(0, xr[i]-xbar + K +c2[i])

c1.append(c1i)

c2.append(c2i)

UCL = [h*sigma]*len(xr)

LCL = [-h*sigma]*len(xr)

CL = [0]*len(xr)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

markers1 = []

colors1 = []

for i in range (len(data)):

x1 = c1[i+1]

if x1 > UCL[i]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

for i in range (len(data)):

x2 = c2[i+1]

if x2 <LCL[i]:

markers1.append(’D’)

colors1.append(’r’)

else:
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markers1.append(’D’)

colors1.append(’g’)

#Plotting CUSUM chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(c1[1:],’b-’,zorder=1)

ax1.plot(c2[1:],’g-’,zorder=1)

for x,y,c,m in zip(t, c1[1:], colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

for x,y,c,m in zip(t, c2[1:], colors1, markers1):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’CUSUM’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[0],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’’+str(round(abs(CL[0]),2)), xy = (xlim()[1], list(CL)

[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[0],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(xr), step = 2), arange(1, len(xr)+1, step = 2))

show()

How-To 3.4 (A tabular CUSUM chart in Excel 2013)
Excel does not have a built-in option for creating a tabular CUSUM chart, but we
can manually program the formulas in Box 3.1 as we demonstrate in Example 3.1.

Example 3.1 (A CUSUM chart for the process in scenario 1)
Let us reconsider scenario 1 about General Hospital and a CPOE process. The
CIO has transitioned to phase II, and Table 3.1 presents data for the most recent
entry times for radiology orders.
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Table 3.1: Entry times in minutes (𝑥𝑡) for radiology orders at General Hospital

𝑆𝑎𝑚𝑝𝑙𝑒# 𝑥𝑡 𝑆𝑎𝑚𝑝𝑙𝑒# 𝑥𝑡

1 9.63 26 9.29
2 5.03 27 7.58
3 14.16 28 8.52
4 15.74 29 10
5 11.27 30 5.75
6 13.05 31 9.05
7 15.55 32 6.17
8 8.65 33 10.97
9 11.78 34 14.6
10 14.91 35 14.35
11 11.42 36 6.82
12 13.01 37 8.77
13 20.63 38 14.03
14 5.52 39 12.7
15 5.02 40 9.38
16 6.61 41 12.59
17 15.23 42 15.15
18 12.96 43 14.44
19 10.24 44 11.56
20 9.33 45 7.76
21 6.13 46 5.73
22 9.5 47 9.8
23 7.3 48 15.88
24 2.1 49 8.24
25 1.83 50 6.84

To help the CIO create a CUSUM chart for phase II, we applied the Python script in
How-To 3.3 and generated the chart portrayed in Figure 3.5.

Figure 3.5: A CUSUM chart created using Python 3.6 based on the data in Table
3.1
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The CUSUM chart in Figure 3.5 indicates that samples 13 and 32 fall outside of
the control limits. To investigate the causes of these behaviors, the CIO needs
to begin from the sample where the cumulative sum started to drift away from 0.
For the case of sample 13, the CIO should start an investigation from sample 3.
For the case of sample 32, the manager should go back to sample 22 to find the
reason for out-of-control behaviors. After removing all assignable causes, the CIO
should reset the chart to zero and resume monitoring the process. In practice,
out-of-control behaviors should be investigated as soon as they occur, and the
charts reset thereafter.

To reproduce the CUSUM chart in Figure 3.5 using Excel, we first set up our
spreadsheet, as shown in Figure 3.6. In our setup, we left row 2 blank, except for
cells G2 and H2, to initialize 𝐶+

0 = 𝐶−0 = 0 per Box 3.1.

Figure 3.6: A setup of Excel to create a CUSUM chart based on the data in Table
3.1

The explanation of our spreadsheet setup follows.

1. The target value in this case is 𝜇0 = 10, as indicated in cell 𝐽7.

2. To estimate the standard deviation 𝜎 , we used the 𝑅̄/𝑑2 technique, where
𝑅̄ is the average of moving ranges and 𝑑2 = 1.128 per Appendix Table 12
when 𝑛 = 2. For example, we obtained the moving range value in cell 𝐶3
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by: = 𝐴𝐵𝑆(𝐵3 − 𝐵4), where 𝐴𝐵𝑆() is the absolute value function in Excel.
Subsequently, we dragged down the formula in 𝐶3 until cell 𝐶51 to populate
the rest of the values. After that, we obtained 𝑅𝑏𝑎𝑟, shown in cell 𝐽4, by:
= 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐶3 : 𝐶51). Our estimate of 𝜎 is indicated in cell 𝐽5 and was
obtained by = 𝐽4/𝐽3.

3. We calculated the 𝐶+
𝑖 and 𝐶−𝑖 statistics per Box 3.1. For example, we obtained

the value in cell 𝐺3 by =𝑀𝐴𝑋(0, (𝐵3−$𝐽$7−$𝐽$6+𝐺2)) and the value in cell
𝐻3 by =𝑀𝐼𝑁 (0,𝐵3− $𝐽$7 + $𝐽$6 +𝐻2). We dragged down these formulas
until row 52 to populate the rest of the values.

4. For control limits, we set 𝐶𝐿 to 0 and obtained the values of 𝑈𝐶𝐿 and 𝐿𝐶𝐿 in
cells 𝐷3 and 𝐹3 by = $𝐽$8*$𝐽$5 and = $𝐽$8*$𝐽$5, respectively. We dragged
down these formulas until row 52.

5. Finally, we created the CUSUM chart of interest by inserting the line charts of
columns 𝐷,𝐸,𝐹,𝐺, and 𝐻 .

To reproduce the CUSUM chart in Minitab 18, we set the subgroup size to 1, the
target to 10, ℎ to 5, and 𝑘 to 0.5. The resulting CUSUM chart is portrayed in Figure
3.7. The CUSUM statistics and interpretation are as before.

Figure 3.7: A CUSUM chart created using Minitab 18 based on the data in Table
3.1
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3.3 EWMA charts

We create EWMA charts by weighting all process observations or sample statistics of
interest. The weights we apply decrease geometrically, thus making the most recent
observations weigh more than the earlier ones. Like in CUSUM charts, we typically use
EWMA charts to monitor individual observations when the sample size 𝑛 = 1. When
𝑛 > 1, we monitor 𝑥𝑖 , the mean of sample 𝑖, for 𝑖 : 1, . . . ,𝑚, where 𝑚 is the total number
of samples.

Formulation

We summarize the formulas of EWMA charts in Box 3.3.

Box 3.3 EWMA charts

In EWMA charts, we monitor the statistic 𝑧𝑖 , given by:

𝑧𝑖 = 𝜆𝑥𝑖 + (1−𝜆)𝑧𝑖−1 (3.9)

where 𝑧0 = 𝜇0 and 𝑥𝑖 is the observation from sample 𝑖. Here, 𝜆 is the discount
factor commonly set between 0.2 and 0.4. The smaller 𝜆, the more sensitivity to
small shifts in the process. When 𝜆 = 1, the resulting EWMA chart is equivalent
to its Shewhart counterpart (e.g., 𝐼𝑚𝑅 chart). Given sample 𝑖, we determine the
centerline and limits as follows:

𝑈𝐶𝐿𝑖 = 𝜇0 +𝐿𝜎

√︂
𝜆

2−𝜆
[1− (1−𝜆)2𝑖] (3.10)

𝐶𝐿𝑖 = 𝜇0 (3.11)

𝐿𝐶𝐿𝑖 = 𝜇0 −𝐿𝜎
√︂

𝜆
2−𝜆

[1− (1−𝜆)2𝑖] (3.12)

where 𝜇0 is a constant target. We typically set 𝐿 = 3 and estimate 𝜎 using 𝑀𝑅/𝑑2
for individual observations [45].

How-To 3.5 (EWMA in Minitab 18)

1. Click on EWMA as pictured in How-To 3.1

2. Input your data > select the subgroup size > click on EWMA options. Change
the default value of 𝜆 (Weight of EWMA) as necessary. See the snapshot in
Figure 3.8.
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Figure 3.8: EWMA chart options in Minitab 18, the main screen

3. Click on the Parameters tab> input your mean target, as shown in Figure 3.9

Figure 3.9: EWMA chart in Minitab 18, the Parameters tab

How-To 3.6 (Python 3.6)

Script 3.2: A script for creating an EWMA chart using Python 3.6
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##TIME WEIGHTED CHARTS EWMA chart

#Import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an excel spreadsheet

data = read_excel(’your directory’)

#parameters

L = 3.

lmda = 0.2

d2 = 1.128

mrbar = mean([abs(data.xt[i] -data.xt[i-1]) for i in range(1,len(data

.xt))])

target = 10.

xbar = target

sigma = mrbar/d2

term1 = lmda/(2.-lmda)

term2 = (1.-lmda)

xr = []

xr0 = data.xt

#set up control charts

UCL = [xbar + L*sigma*sqrt(term1*(1. - term2**(2*i))) for i in range

(1, len(xr0)+1)]

LCL = [xbar - L*sigma*sqrt(term1*(1. - term2**(2*i))) for i in range

(1, len(xr0)+1)]

CL = [xbar]*len(xr0)

zv = [xbar]

for i in range(len(xr0)):

z = lmda*xr0[i] + (1.-lmda)*(zv[i])

zv.append(z)

xr.append(z)

#mark red a point that falls outside of the control limits. Otherwise

, mark the point blue

markers = []

colors = []

for i in range (len(xr0)):

x1 = xr[i]

x2 = UCL[i]

x3 = LCL[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#Plotting EWMA chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)
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ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’EWMA’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$CL=$’+str(round(CL[0],2)), xy = (xlim()[1], list(CL)

[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(xr), step = 2), arange(1, len(xr)+1, step = 2))

show()

Example 3.2 (An EWMA chart for the process in scenario 1)
In this example, we once again revisit scenario 1 about General Hospital and the
CPOE process. We use the data in Table 3.1 and apply the Python script in How-To
3.6 to generate the EWMA chart portrayed in Figure 3.10.

Figure 3.10: An EWMA chart created in Python 3.6 based on the data in Table 3.1
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To this EWMA chart in Excel, we begin by setting up our spreadsheet, as illustrated
in Figure 3.11.
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Figure 3.11: A setup of Excel to create an EWMA chart based on the data in Table
3.1

In our Excel setup, we left the second row blank to initialize 𝑧0 = 𝜇0. We imple-
mented the following steps to recreate the EWMA chart of interest.

1. We set the 𝜆 parameter in cell 𝐼5 to 0.2, the target parameter in cell 𝐼6 to 10,
and the 𝐿 parameter in cell 𝐼7 to 3.

2. We estimated 𝜎 as in Example 3.1.

3. We set up 𝑡𝑒𝑟𝑚1 in cell 𝐼8 as = 𝐼5/(2− 𝐼5). This term is equivalent to
(︁

𝜆
2−𝜆

)︁
.

4. We set up 𝑡𝑒𝑟𝑚2 in cell 𝐼9 as = 1− 𝐼5. This term is equivalent to (1−𝜆).

5. We computed the 𝑧𝑖 statistic per Box 3.3. For example, we determined the 𝑧𝑖
value in 𝐺3 by = $𝐼$5 *𝐵3 + (1− $𝐼$5) *𝐺2. We dragged down this formula
to populate the rest of the values.

6. By this step, we can set up the control limits. For example, we obtained the
values of 𝑈𝐶𝐿 and 𝐿𝐶𝐿 in cells 𝐷3 and 𝐹3 using = $𝐼$6 + $𝐼$7 * $𝐼$4 *
𝑆𝑄𝑅𝑇 ($𝐼$8 * (1−$𝐼$9(2 *𝐴3))) and = $𝐼$6−$𝐼$7 *$𝐼$4 *𝑆𝑄𝑅𝑇 ($𝐼$8 * (1−
$𝐼$9(2*𝐴3))), respectively. We dragged down these formulas to populate the
rest of the values. The 𝐶𝐿 value is set to the target of 10.
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7. We plotted the EWMA control chart by inserting the line charts of columns 𝐷
through 𝐺.

To reproduce the same chart in Minitab, we set the subgroup size of 1 and the mean
parameter of 10. The resulting chart is portrayed in Figure 3.12.

Figure 3.12: An EWMA chart produced in Minitab based on the data in Table 3.1

Like in the CUSUM chart, the EWMA chart shows two areas of out-of-control be-
haviors. But, unlike in the CUSUM chart, the EWMA chart indicates that the second
out-of-control sample is 25, not 32. Still, to assign causes of the special cause vari-
ation, we must go back to where the process started to drift away from the target.
As before, the CIO needs to find and remove all assignable causes. Subsequently,
the CIO will have to reset the EWMA control chart before resuming to monitor the
process.

3.3.1 Process regulation using EWMA

So far, we have assumed that we can control a process by finding and removing special
cause variation manually. This approach works well in discrete and stable cases where
out-of-control behaviors occur occasionally. In continuous processes where disturbances
could be frequent, regulating a process manually would be a tedious task. But, if we
could somehow find a variable to compensate for these disturbances, we might be able
to regulate the process automatically. In health care, most of the processes we work with
are discrete, and we can often control them manually. Although, a few processes are
candidates for automatic control such as drug infusions [13, 41] and fast-paced processes
like queues in the emergency department [46, 47].
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An integral control model

Process regulation takes many forms, including fuzzy [37] and Proportional-Integral-
Derivative (PID) techniques [13, 41]. Here, we briefly discuss the integral part of PID
[8, 44]. We begin by imagining 𝑦 to be the process output variable that we are trying to
regulate using the input variable 𝑥 called the set point. Our goal is to adjust variable 𝑥
at time 𝑡 now so 𝑦 remains close to the process target 𝑇 at time 𝑡 +1. If 𝑁 is the amount
of expected disturbance or drift, then at time 𝑡+1 the following mathematical relationship
holds [44]:

𝑦𝑡+1 − 𝑇 =𝑁𝑡+1 (3.13)

We assume that we can use the EWMA function with a discount factor 𝜆 to predict 𝑁𝑡+1
using 𝑁̂𝑡+1, as follows:

𝑁̂𝑡+1 = 𝜆𝑁𝑡 + (1−𝜆)𝑁̂𝑡 (3.14)
= 𝜆𝑁𝑡 + 𝑁̂𝑡 −𝜆𝑁̂𝑡 (3.15)
= 𝑁̂𝑡 +𝜆(𝑁𝑡 − 𝑁̂𝑡) (3.16)
= 𝑁̂𝑡 +𝜆𝑒𝑡 (3.17)

where 𝑁̂𝑡 is the drift that we predicted at 𝑡−1, but the actual drift turned out to be 𝑁𝑡, and
𝑒𝑡 is given by:

𝑒𝑡 = 𝑁𝑡 − 𝑁̂𝑡 (3.18)
≡ 𝑦𝑡 − 𝑇 (3.19)

Our goal is to cancel out the predicted drift 𝑁̂𝑡+1 as follows:

𝑔𝑥𝑡 = −𝑁̂𝑡+1 (3.20)

where 𝑔 is a process gain that expresses how much 𝑁̂𝑡+1 changes for each unit change
in the input 𝑥𝑡. It follows that [44]:

𝑥𝑡 − 𝑥𝑡−1 = −
𝜆
𝑔
𝑒𝑡 ≡ −

𝜆
𝑔
(𝑦𝑡 − 𝑇 ) (3.21)

The cumulative adjustments that we made, up to time 𝑡, are given by the following
integral controller:

𝑥𝑡 = −
𝜆
𝑔

𝑡∑︁
𝑖=1

𝑒𝑖 ≡ −
𝜆
𝑔

𝑡∑︁
𝑖=1

(𝑦𝑖 − 𝑇 ) (3.22)

Example 3.3 (Integral Control)
Table 3.2 contains samples of a clinical process 𝑦𝑡 taken every 10 minutes. The
target for this process is 𝑇 = 100 and the gain is given by 𝑔 = 2. The discount
factor is set to 𝜆 = 0.4.
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Table 3.2: Samples of a clinical process taken every 10 minutes

𝑡 𝑦𝑡 𝑡 𝑦𝑡 𝑡 𝑦𝑡 𝑡 𝑦𝑡

1 96 26 113 51 124 76 155
2 111 27 96 52 122 77 140
3 93 28 92 53 110 78 138
4 110 29 114 54 122 79 130
5 116 30 126 55 125 80 141
6 90 31 97 56 132 81 145
7 116 32 114 57 140 82 180
8 93 33 123 58 132 83 148
9 116 34 123 59 136 84 165
10 107 35 123 60 139 85 163
11 82 36 110 61 143 86 174
12 111 37 143 62 139 87 143
13 87 38 121 63 113 88 174
14 110 39 118 64 110 89 149
15 85 40 145 65 135 90 177
16 98 41 150 66 115 91 162
17 94 42 139 67 133 92 158
18 119 43 117 68 134 93 158
19 92 44 116 69 154 94 155
20 128 45 129 70 144 95 179
21 104 46 145 71 133 96 146
22 126 47 117 72 140 97 166
23 125 48 120 73 142 98 155
24 119 49 125 74 144 99 175
25 124 50 148 75 151 100 159

A line chart of 𝑦𝑡 over time 𝑡 is portrayed in Figure 3.17. From this chart, it is clear
that the process quickly drifts away from the target over time. After implementing an
automatic regulator, we were able to control the process, as shown in Figure 3.14.

Figure 3.13: Unregulated process 𝑦𝑡 with a target 𝑇 = 100
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Figure 3.14: Regulated process 𝑦𝑡 with a target 𝑇 = 100
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We created 𝐼-𝑀𝑅 control charts of the regulated process as illustrated in Figure
3.15. From these charts, we appreciate that the process is statistically stable.

Figure 3.15: The control charts of the regulated process 𝑦𝑡

(a) 𝐼-𝑐ℎ𝑎𝑟𝑡
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(b) 𝑀𝑅-𝑐ℎ𝑎𝑟𝑡
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The dynamics of the integral controller 𝑥𝑡 are plotted in Figure 3.16.

Figure 3.16: The dynamics of the integral controller 𝑥𝑡
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From the dynamics of 𝑥𝑡 in Figure 3.16, it is clear that regulating the process, man-
ually, is tedious. But, it is still possible to design a manual controller using an
adjustment chart created using the following equation:

𝑥𝑡 − 𝑥𝑡−1 = −
0.4
2

(𝑦𝑡 − 100) = −
1
5
(𝑦𝑡 − 100) (3.23)

From Equation 3.23, it follows that the operator would change 𝑥𝑡 by one unit per 5
units deviations from the target. The change would be in the direction that brings
𝑦𝑡 closer to the target 𝑇 .

We used Excel to create the integral controller of the process 𝑦𝑡. To start,
we set up our spreadsheet, as indicated in Figure 3.17. A detailed explanation
follows.

1. Initial columns are 𝐴, 𝐵, 𝐺, and 𝐻 . Column 𝐴 shows the increments of time
𝑡. Column 𝐵 stores the values of the unregulated process denoted as 𝑦𝑡. We
store our parameters in columns 𝐺 and 𝐻 .

2. The derived columns are 𝐷, 𝐸, and 𝐹. Column 𝐷 contains the running differ-
ences of the setpoints, 𝑥𝑡 −𝑥𝑡−1. Column 𝐸 contains the cumulative values of
the setpoint 𝑥𝑡. Column 𝐹 shows the regulated values denoted as 𝑦𝑡

3. We initialize the value of the regulated process in cell 𝐹3 as follows: 𝑦2 = 𝑦2 =
𝐵3.

4. At 𝑡 = 1, 𝑥1 = 0.

5. At 𝑡 = 2, 𝑥2 = 𝑥2 − 𝑥1 since 𝑥1 = 0. Per Equation 3.21, 𝑥𝑡 − 𝑥𝑡−1 = −𝜆𝑔 (𝑦𝑡 − 𝑇 ).
So, at 𝑡 = 2, 𝑥𝑡 − 𝑥𝑡−1 = −𝜆𝑔 (𝑦𝑡 − 𝑇 ) = −

0.4
2 (111 − 100) = −15(111 − 100) =

−2.2. In our Excel spreadsheet, this is programmed in cell 𝐷3 as: =
−($𝐻$1/$𝐻$2) * (𝐹3− $𝐻$3).
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6. The value of 𝑦3 in cell 𝐹4 was obtained using 𝑦𝑡 = 𝑦𝑡+𝑥𝑡, which in our spread-
sheet corresponds to = 𝐵4+𝐸3.

7. The next value of the setpoint 𝑥3, in cell 𝐸4, was found by =𝐷3+𝐸2.

8. The value of 𝑥𝑡 − 𝑥𝑡−1 in cell 𝐷4 was programmed as follows: =
−($𝐻$1/$𝐻$2) * (𝐹4− $𝐻$3).

9. Now we drag down all formulas in cells 𝐷4 to 𝐹4 to populate the rest of the
values.

10. Finally, we insert the line chart of column 𝐹 to recreate the chart shown in
Figure 3.14.

Figure 3.17: The setup of Excel for regulating the process 𝑦𝑡

To recreate the chart in Figure 3.16, we would insert a line chart of column 𝐸 of the
spreadsheet pictured in Figure 3.17.
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3.4 MA charts

The MA chart is the last kind of time-weighted control charts that we consider here. To
set up this chart, we first need to define the moving average span of 𝑤. Subsequently,
we determine the statistic to be monitored, 𝑀𝑖 , and then set up appropriate control limits
as highlighted in Box 3.4.

Box 3.4 MA charts

We set up the MA centerline and control limits as follows:

𝑈𝐶𝐿 = 𝜇0 +𝐿
𝜎
√
𝑤

(3.24)

𝐶𝐿 = 𝜇0 (3.25)

𝑈𝐶𝐿 = 𝜇0 −𝐿
𝜎
√
𝑤

(3.26)

where 𝜇0 is the target, 𝜎 is the process standard deviation, 𝑤 is the span of the
moving averages, and 𝐿 is typically set to 3. When the sample number 𝑖 is less
than 𝑤, we set up the control limits using this interval:

𝜇0 ±𝐿
𝜎
√
𝑖

(3.27)

We monitor the statistic 𝑀𝑖 given by:

𝑀𝑖 =
𝑥𝑖 + 𝑥𝑖−1 + · · ·+ 𝑥𝑖−𝑤+1

𝑤
(3.28)

The wider the span 𝑤, the more sensitive to small shifts the process is [44].

How-To 3.7 (MA charts in Minitab 18)

1. Click on Moving Average as shown in How-To 3.1

2. Input your data > select the subgroup size > change the length of MA as
necessary > click on MA options. See the snapshot in Figure 3.18.
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Figure 3.18: The MA chart options in Minitab 18, the main screen

3. After clicking on the MA options, access the Parameters tab, and input your
mean target. See the snapshot in Figure 3.19

Figure 3.19: The MA chart options in Minitab 18, Parameters tab
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How-To 3.8 (Python 3.6)

Script 3.3: A script for creating an MA chart using Python 3.6

##TIME WEIGHTED CHARTS MA chart

#Import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an excel spreadsheet

data = read_excel(’your directory’)

#parameters

xr = []

w0 = 5#morving range

L = 3.

d2 = 1.128

w = [min(i, w0) for i in range (1,len(data) +1)]

mrbar = mean([abs(data.xt[i] -data.xt[i-1]) for i in range(1,len(data

.xt))])

sigma = mrbar/d2

data = list(data.xt)

target = 10.

xbar = target

for i in range (len(w)):

#j is the beginning and w[i] is the end of the sliding scale

j = 0

if i < w[i]:#beginning of the moving average

j = 0

else:

j = i-w[i]+1

m =data[j:j+w[i]]

n = len(m)

Mi = sum(m)/n

xr.append(Mi)

UCLa = [xbar + L*sigma/sqrt(w[i]) for i in range(len(w))]

LCLa = [xbar - L*sigma/sqrt(w[i]) for i in range(len(w))]

CLa = [xbar]*len(xr0)

markers = []

colors = []

for i in range (len(xr)):

x1 = xr[i]

x2 = UCLa[i]

x3 = LCLa[i]

if (x1 > x2 or x1<x3) :

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)



154 3.4. MA charts

#Plotting

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCLa, ’k-’, alpha = 0.5)

ax1.plot(LCLa, ’k-’,alpha = 0.5)

ax1.plot(CLa, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

#ylim(0, 20)

xlim(-0.9, t[-1]+1)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’MA’)

ax1.annotate (’$UCL=$’+str(round(UCLa[-1],2)), xy = (xlim()[1], list(

UCLa)[-1]), xytext = (xlim()[1],list(UCLa)[-1]),fontsize = 11)

ax1.annotate (’$CL=$’+str(round(CLa[0],2)), xy = (xlim()[1], list(CLa

)[-1]), xytext = (xlim()[1],list(CLa)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCLa[-1],2)), xy = (xlim()[1], list(

LCLa)[-1]), xytext = (xlim()[1],list(LCLa)[-1]),fontsize = 11)

xticks(arange(len(xr), step = 2), arange(1, len(xr)+1, step = 2))

#ax1.legend(fancybox=True,fontsize=’medium’,markerscale=0.8,

labelspacing=0.1).draggable()

ax1.yaxis.set_ticks_position(’left’) #remove yticks from right up

ax1.xaxis.set_ticks_position(’bottom’) #remove yticks from right up

show()

#print LCLa

Example 3.4 (An EWMA chart for the process in scenario 1)
In this last example, we once again revisit scenario 1 about General Hospital and
the CPOE process and attempt to create a corresponding MA chart. We applied
the Python script in How-To 3.8 to generate the 𝑀𝐴 chart in Figure 3.20.
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Figure 3.20: MA chart produced in Python based on the data in Table 3.1
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To reproduce the same chart in Excel, we first set up our spreadsheet, as shown
in Figure 3.21. In our setup, we left rows 2 to 5 blank to initialize the span of the
moving averages. Then, we proceed as follows:

1. We set 𝑤 = 5 in cell 𝐼8, the 𝑡𝑎𝑟𝑔𝑒𝑡 = 10 in cell 𝐼9, and 𝐿 = 3 in cell 𝐼10.

2. We estimated 𝜎 as in Example 3.1.

3. We set up the formula for the moving average statistic 𝑀𝑖 in cell 𝐺6, as fol-
lows: = 𝑆𝑈𝑀(𝐵2 : 𝐵6)/𝑀𝐼𝑁 (𝐴6,$𝐼$8). We obtained the rest of the values
by dragging down this formula.

4. Next, we programmed the formulas for the control limits. For example, the
values of 𝑈𝐶𝐿 and 𝐿𝐶𝐿 in cells D6 and F6 were respectively computed as
= $𝐼$9+ $𝐼$10 * $𝐼$7/𝑆𝑄𝑅𝑇 (𝑀𝐼𝑁 (𝐴6,$𝐼$8)) and
= $𝐼$9−$𝐼$10*$𝐼$7/𝑆𝑄𝑅𝑇 (𝑀𝐼𝑁 (𝐴6,$𝐼$8)). We set 𝐶𝐿 to equal the target.
We dragged down all these formulas to obtain the rest of the values.

5. We created the MA chart by inserting the lines charts of columns C-G.
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Figure 3.21: A setup of Excel to create an MA chart based on the data in Table
3.1

We reproduced a similar MA chart in Minitab 18 by following instructions in How-To
3.7. The resulting chart is portrayed in Figure 3.22.
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Figure 3.22: MA chart in Minitab 18 based on the data in Table 3.1

The MA control chart shows that the process is out-of-control at samples 25 and
27. These results are slightly different than the behaviors that we observed in the
CUSUM and EWMA charts. In the EWMA chart, we found that samples 13 and 25
were out-of-control. In the CUSUM charts, we observed that samples 13 and 32
were out-of-control. Still, a closer look at the MA chart reveals that sample 13 is
also almost out-of-control. We also see that sample 22 coincides with the previously
observed start of the LCL drift in both the CUSUM and EWMA charts.

Remark: In general, there is no major difference in the performance of the time-weighted control
charts that we discussed in this chapter. But, in practice, the CUSUM and EWMA charts are more
widely used [44]
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3.5 EXERCISES

1. Follow Examples 3.1, 3.2, and 3.4 and reproduce the given CUSUM, EWMA, and
MA control charts. Program the formulas in Python or Excel and verify your results
in Minitab.

2. The chief of orthopedic surgery at Metropolis Hospital monitors the proper femorotib-
ial alignment for patients who are post-total knee arthroplasty (TKA). Studies have
shown that bone malalignments post-TKA can lead to long-term poor functional
outcomes, including increased wear and early implant failures. The proper align-
ment is assessed by measuring the medial angle between the axes of the femur
and the tibia [14, 65]. The data in Table 3.3 shows angle measurements of 60
post-TKA patients at this facility. The target is 180%.

(a) Using Excel, Python, and Minitab, create a CUSUM chart for individual angle
measurements in Table 3.3

(b) Use the same dataset to create 𝐼𝑚𝑅 charts.

(c) Compare and contrast your results in (a) and (b). What actions, if any, should
be taken to stabilize the process?

3. Table 3.4 presents data about the time to administration of pain medication to ED
patients with broken bones at Metropolis Hospital. Tracking and reporting this infor-
mation is required by CMS as one of its mandated quality measures about timely
and effective care [17].

(a) Using Excel, Python, and Minitab, create EWMA and MA control charts related
to individual angle measurements in Table 3.4

(b) Use the same dataset to create 𝐼𝑚𝑅 charts.

(c) Compare and contrast your results. What can you conclude?

4. Use the data in Table 3.5 to set up an integral controller for the 𝑦𝑡 nursing process.
Assume 𝑇 = 100, 𝜆 = 0.2, and 𝑔 = 2.

(a) Create 𝐼𝑚𝑅 charts of the uncontrolled process

(b) Create 𝐼𝑚𝑅 charts of the controlled process.

(c) Compare and contrast your results. What can you conclude?

(d) How would you set up an adjustment chart to allow the nurse to control the
process manually?
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Table 3.3: Femorotibial angle measurements of post-TKA patients at Metropolis Hospital

Patient# Angle Patient# Angle

1 193.5 31 169.9
2 170.5 32 183.3
3 176 33 182.3
4 171.4 34 197.8
5 172.5 35 198.8
6 198.3 36 171
7 184.3 37 175.7
8 174 38 179.1
9 170 39 177.5

10 160.4 40 179.9
11 165 41 169.4
12 160.7 42 161.4
13 171.4 43 179.2
14 168.1 44 197.8
15 170.5 45 174.6
16 188 46 184.7
17 163.4 47 167.9
18 180.4 48 177.4
19 179.4 49 171.6
20 190.8 50 196.1
21 199.5 51 175.3
22 198.9 52 200.9
23 200.4 53 169.9
24 189.3 54 189.5
25 181.2 55 176
26 176.3 56 191.5
27 195.8 57 170.1
28 198.2 58 189.6
29 175.2 59 182
30 175.5 60 200.4
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Table 3.4: Time, in minutes, to the administration of pain medication to ED patients with
broken bones at Metropolis Hospital

Patient# Time Patient# Time

1 42 21 40
2 46 22 47
3 17 23 47
4 25 24 9
5 41 25 44
6 38 26 24
7 23 27 8
8 55 28 23
9 28 29 36

10 12 30 55
11 14 31 63
12 26 32 60
13 28 33 53
14 32 34 26
15 11 35 26
16 53 36 13
17 20 37 11
18 5 38 8
19 8 39 29
20 15 40 75

Table 3.5: The dynamics of the 𝑦𝑡 nursing process

𝑡 𝑦𝑡 𝑡 𝑦𝑡 𝑡 𝑦𝑡 𝑡 𝑦𝑡

1 95 14 101 27 95 40 111
2 110 15 99 28 97 41 145
3 97 16 109 29 130 42 126
4 99 17 96 30 97 43 10
5 111 18 110 31 97 44 119
6 109 19 120 32 127 45 139
7 101 20 124 33 120 46 121
8 103 21 114 34 146 47 137
9 114 22 110 35 114 48 134
10 100 23 97 36 121 49 136
11 200 24 97 37 145 50 111
12 91 25 90 38 115
13 118 26 113 39 133



CHAPTER 4

Adjusted control charts

Summary

In this chapter, we study how to adjust control charts for risk and au-
tocorrelation. We also learn how to control multivariate processes. As
in previous chapters, we emphasize practical applications with examples
and How-To clauses to demonstrate how to encode relevant formulas us-
ing Excel and Python software. We also show how to apply the Minitab
statistical package.

Key concepts and tools

Control charts; Risk-adjusted; P chart; CUSUM1 chart; Hotelling 𝑇 2; Au-
tocorrelation; Multivariate normal; Covariance matrix; Time series; Resid-
uals; Lag; ACF2; ARIMA3

Major objectives

After studying this chapter, you will be able to:

1. Define key concepts and tools for adjusted control charts
2. Learn how to recognize risk in health care processes
3. Explain the concept of autocorrelation
4. Recognize the need for multivariate control adjustment
5. Design and construct risk-adjusted control charts
6. Design and construct control charts for autocorrelated data
7. Design and construct multivariate control charts
8. Implement adjusted control charts using Excel, Python, and Minitab
9. Appraise the stability of the process in adjusted control charts

10. Survey implementation strategies for adjusted control charts
1CUSUM: Cumulative sum
2ACF: Auto-correlation function
3ARIMA: Autoregressive integrated moving average

161
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4.1 Introduction

In this chapter, we learn how to adjust control charts when some of our assumptions in
the previous chapters no longer hold. For example, the charts that we have discussed so
far relate to uncorrelated single variables. Additionally, we have been implicitly assuming
the uniformity of inputs, and thus eliminated the need for conditioning quality measures
on anything else but the process. These assumptions are occasionally violated in some
of the processes that we encounter in health care, an incidence that requires us to make
adjustments to the traditional control charts. The first type of adjustment that we consider
relates to risk. We create risk-adjusted charts to alleviate bias in quality measures due
to the patient’s health risk factors. The second type of adjustment we discuss concerns
autocorrelation. When our samples are correlated over time, deploying traditional con-
trol charts may lead to erroneous conclusions. We will demonstrate how to apply time
series techniques to allow us to monitor the process using the model residuals. The last
type of adjustment that we make to traditional control charts pertains to processes where
variables of interest are jointly distributed. To monitor such processes, we employ multi-
variate control charts. One kind of these charts that we review here is the Hotelling 𝑇 2

control chart.

4.2 Risk-adjusted control charts

Risk-adjusted control charts may be applied to any process where the quality of outputs
is affected by uneven inputs. In the manufacturing sector, risk-adjustment may not be
necessary since raw materials tend to be approximately uniform. But, when monitoring
processes related to patient care, there is likely to be a need to adjust traditional control
charts to account for the risk inherent in the patient’s case-mix4 or risk factors [3, 65].
It is imperative to have an accurate measure of this risk for the adjusted control charts
to be of any value. Statistical techniques such as logistic regression are often utilized for
this purpose [65]. To review how to fit a logistic regression model to data, see Sharma
(1995) [56].

As depicted in Figure 4.1, in this section, we only discuss the most common risk-
adjusted control charts, namely 𝑝 and 𝐶𝑈𝑆𝑈𝑀 charts. Possible scenarios where these
charts may be applied are discussed next.

Scenario 1: A quality manager at Metropolis Hospital is interested in monitoring mortal-
ity rates in an intensive care unit (ICU). The manager understands that the patients’
risk factors tend to bias mortality rates. For example, patients with acute renal fail-
ure often have a higher risk of mortality than patients without this condition. Also,
the risk of dying tends to increase with age [21]. Accordingly, the manager has
decided to apply the risk-adjusted charts to monitor the process. See Cook et al.
(2003) [19] for an actual case study where risk-adjusted control charts were em-
ployed to monitor ICU mortality rates.

4Case-mix: a term broadly used to describe the variation in the patient’s quality outcomes due to
intrinsic factors such as comorbidity, sex, age, and health status [19, 31]
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Figure 4.1: A basic decision tree for risk-adjusted charts
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Scenario 2: The administrator of a skilled nursing facility decided to apply risk-adjusted
control charts to monitor patient fall rates. The manager is aware that the risk of
falling tends to increase with age [54]. The manager also had noticed that dementia
patients fell more often as compared to the residents who do not suffer from this
condition [62]. For further discussion about the application of risk-adjusted charts
to monitor patient falls, see Alemi et al. (2001) [3].

Scenario 3: The chief medical officer at Children’s Hospital wants to use risk-adjusted
CUSUM control charts to monitor outcomes of pediatric cardiac surgeries. To mea-
sure risk, the manager decided to apply the standard Parsonnet score, where a
high score indicates an increased risk of dying. See Steiner et al. (2000)[59] for
more discussion about the use of risk-adjusted CUSUM charts to monitor outcomes
of cardiac surgeries.

4.2.1 Risk-adjusted p-charts

Similar to traditional p-charts, risk-adjusted p-charts are generally deployed in phase I
of chart application to monitor processes that generate binomial data. We recall that
p-charts obey the Bernoulli distribution as follows:

𝑝(𝑥) =

⎧⎪⎪⎨⎪⎪⎩𝑝 𝑥 = 1
1− 𝑝 𝑥 = 0

(4.1)

As before, 𝑝 signifies the probability of an event 𝑥. When 𝑥 = 1, an event occurred.
Otherwise, an event did not occur. In both the traditional and risk-adjusted p-charts, we
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monitor 𝑝𝑖 , the probability of an event in sample 𝑖, that we obtain as follows:

𝑝𝑖 =
1
𝑛𝑖

𝑛𝑖∑︁
𝑗=1

𝑥𝑖𝑗 (4.2)

Here, 𝑛𝑖 is the size of sample 𝑖. We can think of 𝑥𝑖𝑗 as the outcome of patient 𝑗 in sample
𝑖. The only difference between the traditional and risk-adjusted p-charts involves control
limits. In traditional p-charts, we construct the control limits using parameter 𝑝̄ that we
obtain like this:

𝑝̄ =

∑︀𝑚
𝑖=1

∑︀𝑛𝑖
𝑗=1𝑥𝑖𝑗∑︀𝑚

𝑖=1𝑛𝑖
(4.3)

As before, 𝑚 is the total number of samples. In risk-adjusted p-charts, we construct the
control limits using the parameter 𝑝̂𝑖𝑗 , the probabilistic risk of a particular outcome for
patient 𝑗 in sample 𝑖. We obtain the expected risk in sample 𝑖 as follows:

1
𝑛𝑖

𝑛𝑖∑︁
𝑗=1

𝑝̂𝑖𝑗 (4.4)

To estimate 𝑝̂𝑖𝑗 , we typically apply logistic regression on outcomes of care given the
patient’s risk factors [65]. In some groupers of medical codes such as APR-DRG5 in
3M [5], the risk of mortality is automatically generated based on the severity of illness
reflected from the coded medical diagnoses and other medical information. Box 4.1
summarizes the typical formulation of risk-adjusted p-charts.

Box 4.1 Risk-adjusted p-charts

For each sample 𝑖, the upper control limit (𝑈𝐶𝐿𝑖), the lower control limit (𝐿𝐶𝐿𝑖),
and the centerline (𝐶𝐿𝑖) are constructed as follows [19, 65]:

𝑈𝐶𝐿𝑖 =
1
𝑛𝑖

⎡⎢⎢⎢⎢⎢⎢⎣ 𝑛𝑖∑︁
𝑗=1

𝑝̂𝑖𝑗 +𝐿

⎯⎸⎷ 𝑛𝑖∑︁
𝑗=1

𝑝̂𝑖𝑗(1− 𝑝̂𝑖𝑗)

⎤⎥⎥⎥⎥⎥⎥⎦ (4.5)

𝐶𝐿𝑖 =
1
𝑛𝑖

𝑛𝑖∑︁
𝑗=1

𝑝̂𝑖𝑗 (4.6)

𝐿𝐶𝐿𝑖 = max

⎛⎜⎜⎜⎜⎜⎜⎝0, 1𝑛𝑖
⎡⎢⎢⎢⎢⎢⎢⎣ 𝑛𝑖∑︁
𝑗=1

𝑝̂𝑖𝑗 −𝐿

⎯⎸⎷ 𝑛𝑖∑︁
𝑗=1

𝑝̂𝑖𝑗(1− 𝑝̂𝑖𝑗)

⎤⎥⎥⎥⎥⎥⎥⎦
⎞⎟⎟⎟⎟⎟⎟⎠ (4.7)

where 𝑝̂𝑖𝑗 is the predicted probabilistic risk of patient 𝑗 in sample 𝑖. As in traditional
p-charts, 𝐿 is the distance from the control limit to the centerline. For mortality
risk-adjustment, it is common to set 𝐿 = 2 [65].

5APR-DRG: All Patient Refined Diagnosis Related Groups
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How-To 4.1 (Risk-adjusted p-charts in Minitab 18)
Minitab 18 does not have an option for creating risk-adjusted p-charts

How-To 4.2 (Risk-adjusted p-charts in Excel 2013)
Excel 2013 does not have a built-in option for creating risk-adjusted p-charts, but
it is possible to manually program the formulas in Box 4.1 as we demonstrate in
Example 4.1.

How-To 4.3 (Python 3.6)

Script 4.1: A script for creating a risk-adjusted p-chart using Python 3.6. language

#RISK-ADJUSTED P-CHART

#import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

data = read_excel(’your directory’)

#initialize parametes

L = 2.

#find unique days

days = data.Day.unique()

#determine control limits, centerline, and the statistic to be

monitored.

UCL = []

CL = []

LCL = []

Day = []

P = []

for i in days:

dayi = data[data.Day==i]

ni = len(dayi)

sumphat1 = dayi.Probability.sum()/ni

sumphat2 = sqrt(sum(dayi.Probability*(1.-dayi.Probability)))/ni

UCLi = sumphat1 + L*sumphat2

CLi = sumphat1

LCLi = max(0,sumphat1 - L*sqrt(sumphat2))

Pi = float(dayi.Died.sum())/ni

#append results

UCL.append(UCLi )

CL.append(CLi)

LCL.append(LCLi)

P.append(Pi)

Day.append(i)

xr = P

#mark red the point that falls outside of the control limits.

Otherwise, mark the point blue.

markers = []

colors = []

for i in range (len(xr)):
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x1 = xr[i]

if (x1 > UCL[i] or x1 < LCL[i]):

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plot the adjusted p-chart using the step function for limits

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(P))

ax1.step(t, UCL, ’k-’, alpha = 0.5, where = ’mid’)

ax1.step(t, LCL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.step(t, CL, ’k-’,alpha = 0.5, where = ’mid’)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’Fraction nonconforming’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[-1],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$\overline{P}=$’+str(round(CL[-1],2)), xy = (xlim()

[1], list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize =

11)

ax1.annotate (’$LCL=$’+str(round(LCL[-1],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(UCL), step = 2), arange(1, len(UCL)+1, step = 2))

show()

Example 4.1 (ICU mortality rates)
Let us revisit scenario 1, where the quality manager at Metropolis Hospital wants
to use risk-adjusted charts to monitor mortality rates in ICU. On each day 𝑖, the
manager records the outcome of the discharged patient 𝑗 as 𝑥𝑖𝑗 = 1, if the patient
died, and 𝑥𝑖𝑗 = 0, if the patient survived. The risk of mortality of each patient 𝑝̂𝑖𝑗
was estimated using logistic regression. So far, the manager has collected data for
5 days, as displayed in Table 4.1. Using the data from Table 4.1, we determine the
daily statistic 𝑝𝑖 per Equation 4.2. Our results are as follows:

𝑝1 = 1/5; 𝑝2 = 0/4; 𝑝3 = 1/6; 𝑝4 = 1/3; 𝑝5 = 2/9

We use Equations 4.5 - 4.7 to calculate 𝑈𝐶𝐿𝑖 , 𝐶𝑖 , and 𝐿𝐶𝐿𝑖 for each day 𝑖. For
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example, on day 1 with 𝐿 = 2, we obtained the following results:

𝑈𝐶𝐿1 =
1
5

[︁
0.878+2

√
0.236

]︁
= 0.370

𝐶𝐿1 =
1
5
(0.020+0.008+0.040+0.010+0.800) =

0.878
5

= 0.176

𝐿𝐶𝐿1 = max
(︂
0,

1
5

[︁
0.878− 2

√
0.236

]︁)︂
=max(0,−0.019) = 0

Table 4.1: Daily tracking of ICU deaths, Metropolis Hospital, 2018

𝐷𝑎𝑦𝑖 𝑃 𝑎𝑡𝑖𝑒𝑛𝑡𝑗 𝑝̂𝑖𝑗 𝑥𝑖𝑗 𝐷𝑎𝑦𝑖 𝑃 𝑎𝑡𝑖𝑒𝑛𝑡𝑗 𝑝̂𝑖𝑗 𝑥𝑖𝑗

1 1 0.020 0 4 1 0.001 0
1 2 0.008 0 4 2 0.029 0
1 3 0.040 0 4 3 0.139 1

1 4 0.010 0 5 1 0.060 0
1 5 0.800 1 5 2 0.140 0

2 1 0.062 0 5 3 0.010 0
2 2 0.260 0 5 4 0.150 1
2 3 0.110 0 5 5 0.040 0
2 4 0.013 0 5 6 0.100 0

3 1 0.040 0 5 7 0.010 0
3 2 0.280 0 5 8 0.210 0
3 3 0.050 0 5 9 0.410 1

3 4 0.738 1
3 5 0.030 0
3 6 0.051 0

After running the Python script in How-To 4.3, we produced the risk-adjusted p-
chart illustrated in Figure 4.2.

Figure 4.2: A risk-adjusted p-chart based on the data in Table 4.1
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To reproduce a similar chart in Excel, we begin by setting up our spreadsheet, as
illustrated in Figure 4.3.

Figure 4.3: A setup of an Excel spreadsheet to construct a risk-adjusted p-chart
based on the data in Table 4.1

In our spreadsheet setup, we computed the value in cell 𝐹2 this way:

= (1/𝐶𝑂𝑈𝑁𝑇 (𝐴2 : 𝐴6)) * (𝑆𝑈𝑀(𝐶2 : 𝐶6) + 2 * (𝑆𝑄𝑅𝑇 (𝑆𝑈𝑀(𝐸2 : 𝐸6)))) (4.8)

Here, we used the 𝐶𝑂𝑈𝑁𝑇 () function to determine the number of discharged
patients on each day. We used the 𝑆𝑈𝑀() function to aggregate the number of
deaths. We applied the 𝑆𝑄𝑅𝑇 () function to calculate the square root of a given
quantity. We present the summary of statistics for constructing a risk-adjusted p-
chart in Table 4.2.

Table 4.2: Statistics for a risk-adjusted p-chart based on the data in Table 4.1

Day 𝑈𝐶𝐿 𝐶𝐿 𝐿𝐶𝐿 p

1 0.37 0.18 0 0.20
2 0.41 0.11 0 0.00
3 0.45 0.20 0 0.17
4 0.31 0.06 0 0.33
5 0.33 0.13 0 0.22

Subsequently, we can insert line charts of columns UCL, CL, LCL, and 𝑝 in Table
4.2 to generate a control chart similar to the one shown in Figure 4.2.
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From the chart in Figure 4.2, we notice that the process was out-of-control
on day 4 since a point fell outside of 𝑈𝐶𝐿4. One possible interpretation of this
result is that the mortality rate on day 4 was statistically high given the expected
risk on that day. The manager should go back on this day and investigate what
happened and correct any assignable causes.

For comparison purposes, let us create a traditional p-chart using the same
dataset in Table 4.1. We start by summarizing the statistics to be plotted in Table
4.3.

Table 4.3: Statistics for the traditional p-chart based on the data in Table 4.1

Day UCL CL LCL p

1 0.53 0.19 0 0.20
2 0.57 0.19 0 0.00
3 0.50 0.19 0 0.17
4 0.63 0.19 0 0.33
5 0.44 0.19 0 0.22

We calculated the quantities in Table 4.3 by following the formulas in Box 2.4 with
𝐿 = 2. We produced the p-chart presented in Figure 4.4.

Figure 4.4: A traditional p-chart based on the data in Table 4.3
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From the chart in Figure 4.4, we notice no out-of-control behaviors. In other words,
the traditional p-chart failed to capture the low risk and high mortality rate on day
4. We should note that the number of samples is too small here to make any
conclusive inferences. In general, the sample number should be at least 25 before
inferring about the stability of the process, unless the standard 𝑝 was given.
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4.2.2 Risk-adjusted CUSUM charts

We use risk-adjusted CUSUM charts to detect small shifts in the processes that have
been adjusted for risk. Given an indicator process that obeys a Bernoulli distribution, the
outcome of patient 𝑗 can be classified as 𝑥𝑗 = 1 if an event occurred, and 𝑥𝑗 = 0, if no
event happened. In our discussion, we confine ourselves to the event of morality and
assume individual observations where the sample size 𝑛 = 1. To create a risk-adjusted
CUSUM chart for mortality, we must be able to calculate the weight 𝑊𝑗 as follows:

𝑊𝑗 = 𝑥𝑗 · log(𝑂𝑅)− 𝑙𝑜𝑔(1− 𝑝̂𝑗0 +𝑂𝑅 · 𝑝̂𝑗0) (4.9)

where 𝑂𝑅 symbolizes the odds ratio of mortality given by:

𝑂𝑅 =
𝑝̂𝑗1(1− 𝑝̂𝑗0)
𝑝̂𝑗0(1− 𝑝̂𝑗1)

(4.10)

Here, 𝑝̂𝑗0 is the probability that patient 𝑗 dies under the null hypothesis 𝐻0 : 𝑂𝑅 = 1,
whereas 𝑝̂𝑗1 is the probability that patient 𝑗 dies under the alternative hypothesis 𝐻1 :
𝑂𝑅 , 1 [65]. In general, we use logistic regression to approximate 𝑝̂𝑗0, and we postulate
the value of 𝑂𝑅. For example, if we assume that 𝑂𝑅 = 2 and a point falls outside of the
upper control limit, we can say that the odds of mortality have doubled. Likewise, if we
assume 𝑂𝑅 = 0.5 and the CUSUM statistic falls outside of the lower control limit, we can
conclude that the odds of mortality have been halved [19].

Box 4.2 summarizes the statistics that we monitor in risk-adjusted CUSUM charts. We
obtain control limits like in traditional CUSUM charts by setting the limits to ±𝐻 , where
𝐻 = ℎ𝜎 and ℎ ranges between 4 or 5. If not given, we estimate 𝜎 from the process
(review Box 3.1)

Box 4.2 Risk-adjusted CUSUM charts

For each patient 𝑗, we compute and monitor the following statistics:

𝐶+
𝑗 =max(0,𝐶𝑗−1 +𝑊𝑗), if OR ≥ 1 (4.11)

𝐶−𝑗 =min(0,𝐶𝑗−1 −𝑊𝑗), if OR < 1 (4.12)

We determine 𝑊𝑗 per Equation 4.9. 𝐶−𝑗 and 𝐶+
𝑗 are cumulative sums of 𝑊𝑗 and

𝐶+
0 = 𝐶−0 = 0. We apply 𝐶−𝑗 to monitor the odds of the decrease in mortality,

whereas 𝐶+
𝑗 helps us monitor the odds of the increase in mortality [19]. After the

CUSUM chart signals out-of-control behaviors, we address any assignable causes
and reset the chart to 𝐶+

0 = 𝐶−0 = 0 [19].

How-To 4.4 (Risk-adjusted CUSUM charts in Minitab 18)
Minitab 18 does not have an option for creating risk-adjusted CUSUM charts
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How-To 4.5 (Risk-adjusted CUSUM charts in Excel 2013)
Excel 2013 does not have a built-in option for creating risk-adjusted CUSUM charts,
but it is possible to manually program the formulas in Box 4.2 as we demonstrate in
Example 4.2.

How-To 4.6 (Python 3.6)

Script 4.2: A script for creating a risk-adjusted CUSUM chart using Python 3.6

#RISK-ADJUSTED CUSUM

#import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns

#import data from an Excel spreadsheet. The column of "Probability"

represents the risk, and the column of "Died" represents the

outcome.

data = read_excel(’your directory’)

#initialize parameters

OR1 = 2.

OR2 = 0.5

h1 = 4.5

#estimate the variance

N = len(data)+1

ssquare = sum(data.Probability*(1.-data.Probability))

sigma =sqrt(ssquare)/N

H = h1*sigma

#create control limits

UCL = [H]*N

CL = [0.]*N

LCL = [-H]*N

#compute C_^+ and C^- statistics to be monitored

Wa = [0]

Wb = [0]

for i in range(len(data)):

xj = data.Died.iloc[i]

pj = data.Probability.iloc[i]

w1 = xj*log(OR1) -log(1.-pj + OR1*pj)

w2 = xj*log(OR2) -log(1.-pj + OR2*pj)

Wa.append(w1)

Wb.append(-w2)

#cumsum is a cumulative function in python

cum1 = cumsum(Wa)

cum2 = cumsum(Wb)

cplus = [max(i,0) for i in cum1]

cminus = [min(i,0) for i in cum2]

c1 = cplus

c2 = cminus

#mark red the point that falls outside of the control limits.

Otherwise, mark the point blue.

markers = []



172 4.2. Risk-adjusted control charts

colors = []

markers1 = []

colors1 = []

for i in range (N):

x1 = c1[i]

if x1 > UCL[i]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

for i in range (N):

x2 = c2[i]

if x2 <LCL[i]:

markers1.append(’o’)

colors1.append(’r’)

else:

markers1.append(’o’)

colors1.append(’g’)

#plotting the adjusted CUSUM chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(CL))

ax1.plot(UCL, ’k-’, alpha = 0.5)

ax1.plot(LCL, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(c1,’b-’,zorder=1)

ax1.plot(c2,’g-’,zorder=1)

for x,y,c,m in zip(t, c1, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

for x,y,c,m in zip(t, c2, colors1, markers1):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Patient number’)

ax1.set_ylabel(’Cumulative risk’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL=$’+str(round(UCL[0],2)), xy = (xlim()[1], list(

UCL)[-1]), xytext = (xlim()[1],list(UCL)[-1]),fontsize = 11)

ax1.annotate (’$CL=$’+str(round(abs(CL[0]),2)), xy = (xlim()[1], list

(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL=$’+str(round(LCL[0],2)), xy = (xlim()[1], list(

LCL)[-1]), xytext = (xlim()[1],list(LCL)[-1]),fontsize = 11)

#set xticks to start from one since Python starts counting from zero

xticks(arange(N, step = 1), arange(1, N+1, step = 1))

show()

Example 4.2 (A Risk-adjusted CUSUM chart)
In this example, we use the data from Example 4.1 and attempt to create a related
risk-adjusted CUSUM chart for individual patients. We set ℎ = 4.5 and approximate
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𝜎 as follows:

𝜎 =
1
𝑛

⎯⎸⎷ 𝑛∑︁
𝑗=1

𝑝̂𝑗(1− 𝑝̂𝑗) (4.13)

where 𝑛 is the total number of patients and 𝑝̂𝑗 is the predicted mortality risk of
patient 𝑗. From Table 4.1, we obtained 𝜎 = 0.054, meaning that 𝐻 = 0.054(4.5) =
±0.2452. Next, we calculate 𝑊𝑗 for the upper CUSUM chart with 𝑂𝑅 = 2. For
example, for patient 1, 𝑊1 = 0log(2)− log(1− 0.020 + 2(0.020)) = −0.020, and for
patient 5, 𝑊5 = 1log(2)− log(1− 0.8+2(0.8)) = 0.105. We implemented the same
procedure to determine the lower CUSUM where 𝑂𝑅 = 0.5. We applied the Python
script in How-To 4.6 to produce the chart illustrated in Figure 4.5.

Figure 4.5: A risk-adjusted CUSUM chart for individual patients in Table 4.1.
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From the CUSUM chart in Figure 4.5, we can conclude that from patient number 7
up until patient number 12, the risk of mortality was halved. We also notice that from
patient number 27 to patient number 28, the risk of mortality doubled. The manager
should attempt to find the reasons for these out-of-control behaviors by going back
to the sample number where the process started to drift away from zero. Next, the
manager should reset the charts to 𝐶+

0 = 𝐶−0 = 0 before resuming the monitoring
procedure.

4.3 Control charts for autocorrelated data

Both the traditional Shewhart and time-weighted charts assume independence of sam-
ples. When this assumption no longer holds, and autocorrelation exists, we utilize con-
trol charts for autocorrelated data to monitor the process. One approach for creating
these charts involves fitting an appropriate time series model to the data and then ap-
plying traditional charts to monitor the process using the model residuals [44]. Figure 4.6
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presents a basic decision tree for selecting an appropriate control chart for autocorrelated
data.

Figure 4.6: A basic decision tree for control charts of autocorrelated data
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Autocorrelation tends to occur in processes that generate continuous data such as
in chemical plants [44]. In health care, most of the processes we deal with for quality
improvement are discrete. But, autocorrelation can still manifest as we entertain in the
following scenarios.

Scenario 1: A lab manager at General Hospital has observed that current measure-
ments of creatinine assays could be predicted from previous measurements over
time. Therefore, for monitoring and controlling the process, the manager has de-
cided to adopt control charts for autocorrelated data. See Winkel et al. (2007) [65]
for a discussion about a scenario of autocorrelation in lab assays.

Scenario 2: A lab manager at Metropolis Hospital has been getting several complaints
from emergency department physicians about delays in the turn-around-time (TAT)
of CBC 6 orders. Knowing that delayed lab results are often associated with in-
creased patient length of stay [58], the manager took these concerns very seriously
and started monitoring TAT of CBC orders using 𝐼𝑚𝑅 charts. The initial assess-
ment of these charts revealed a stationary mean but with obvious trends in the
data. Before proceeding any further, the manager decided to test for autocorrela-
tion in the samples. Autocorrelation was detected, and subsequently, the manager
decided to monitor the process using charts for autocorrelated data.

6CBC: Complete Blood Count
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4.3.1 How to measure autocorrelation?

We measure autocorrelation using a function of the correlation between successive
samples over time. To motivate our discussion, let’s assume that over time 𝑡 we have
collected data 𝑥𝑡 about a given process. After plotting 𝑥𝑡 against 𝑡, we observed trend
behaviors, and thus suspected that autocorrelation existed. To validate this suspicion,
we can, for instance, calculate the Pearson’s correlation coefficient in the data given one-
time lag. That is, we determine the relationship between 𝑥𝑡 and 𝑥𝑡−1. We conclude that
autocorrelation exists when the Pearson coefficient is significant. Given 𝑘 lags, we write
a general autocorrelation function (ACF), 𝜌𝑘, as follows [45]:

𝜌𝑘 =
𝐶𝑜𝑣(𝑥𝑡,𝑥𝑡−𝑘)

𝜎𝑡𝜎𝑡−𝑘
(4.14)

where 𝐶𝑜𝑣() symbolizes the covariance function and 𝜎 denotes the standard devia-
tion. We recall that a Pearson correlation coefficient obeys this inequality: −1 < 𝜌𝑘 < 1. If
the process is stationary, to imply that the mean and the variance are relatively constant,
the denominator in Equation 4.14 will simply be the variance of 𝑥𝑡, given by 𝜎𝑡𝜎𝑡 = 𝜎2

𝑡 . If
𝜎2
𝑡 is not known, we estimate it using 𝑠2𝑡 , the sample variance of 𝑥𝑡. Accordingly, we can

approximate ACF this way:

𝜌𝑘 ≈ 𝜌̂𝑘 =
𝐶𝑜𝑣(𝑥𝑡,𝑥𝑡−𝑘)

𝑠2𝑡
(4.15)

We conclude that 𝜌̂𝑘 is statistically significant when its value exceeds two standard devi-
ations [44]. For example, for the lag 𝑘 = 1, autocorrelation exists when:

|𝜌̂1| >
2
√
𝑛

(4.16)

where 𝑛 is the number of observations in the series and 1/
√
𝑛 is the approximate stan-

dard deviation of 𝜌̂1 [8, 65]. Let’s define 𝐾 as the number of lags needed to conclude
autocorrelation. It follows that 𝐾 ≤ 𝑛

4 is big enough to detect any significant autocorrela-
tion in the data [44].

4.3.2 Time series model and residuals

When ACF is not statistically significant, the following Shewhart model applies [44]:

𝑥𝑡 = 𝜇+ 𝑒𝑡, 𝑡 = 1,2, . . . (4.17)

where 𝑒𝑡 is the residuals term that is normally distributed with mean 0 and a constant
standard deviation 𝜎 . When ACF is statistically significant, the model in Equation 4.17
no longer applies, unless autocorrelation was removed. We can remove autocorrelation
by sampling less frequently since, as the time lag increases, this decreases autocor-
relation. While this approach may work, a lot of process data are discarded, which may
impose a longer period to detect out-of-control behaviors [44]. An alternative way is to
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fit an autoregressive integrated moving average (ARIMA) model to data and then
use the model residuals 𝑒𝑡 to monitor the process using traditional control charts [44]. A
typical ARIMA model is denoted as 𝐴𝑅𝐼𝑀𝐴(𝑝,𝑑,𝑞), where 𝑝 characterizes the degrees
of the autoregressive (𝐴𝑅) term, 𝑑 represents the degrees of the differencing term, and
𝑞 denotes the degrees of the moving average term. A term for the seasonal effects can
also be added as appropriate [45]. For simplicity, we only consider 𝐴𝑅𝐼𝑀𝐴(1,0,0) where
all other arguments are zero except the 𝐴𝑅 term. This model is equivalent to 𝐴𝑅(1) and
can be written this way:

𝑥𝑡 = 𝜇+𝜑𝑥𝑡−1 + 𝑒𝑡 (4.18)

where 𝜇 is the stationary mean, 𝑥𝑡 is the observation at time 𝑡, 𝑥𝑡−1 is the previous
observation at time 𝑡−1, and 𝜑 is a constant coefficient of autocorrelation that is between
-1 and 1, and is obtained from fitting the model. In words, this model says that 𝜇 is the
intercept and 𝑥𝑡 depends on 𝑥𝑡−1 at rate 𝜑. We calculate, 𝑒𝑡, the residuals term, like this:

𝑒𝑡 = 𝑥𝑡 − 𝑥𝑡 (4.19)

where 𝑥𝑡 is the fitted value of 𝑥𝑡 that we obtain as follows:

𝑥𝑡 = 𝜇+𝜑𝑥𝑡−1 (4.20)

To fit an 𝐴𝑅𝐼𝑀𝐴(1,0,0) model using Minitab, see How-To 4.7. To fit this model, using
the Statsmodels module in Python, see How-To 4.8. It is also possible to use Excel to
approximate a simple ARIMA model like 𝐴𝑅𝐼𝑀𝐴(1,0,0). For that, we use the regression
option as expressed in How-To 4.9.

How-To 4.7 (ACF and ARIMA (1,0,0) in Minitab 18)

• To generate ACF in Minitab, click on Stat > Time Series > Autocorrelation. To
fit an 𝐴𝑅𝐼𝑀𝐴(1,0,0) model, click on Stat > Time Series > ARIMA. See the
snapshot in Figure 4.7.
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Figure 4.7: ARIMA, main screen, Minitab 18

• To view ACF for residuals, click on Graphs > check ACF of residuals. See the
next snapshot

Figure 4.8: ARIMA, Autoregressive and Graphs screen, Minitab 18

• Your ARIMA model coefficients will be displayed in a table titled Final Esti-
mates of Parameters, as illustrated in the next snapshot.
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Figure 4.9: ARIMA, Parameter Estimates, Minitab 18

How-To 4.8 (Python 3.6)

Script 4.3: A script for fitting an ARIMA model in Python 3.6

#ARIMA

#import modules

from pandas import *
from pylab import *
import seaborn as sns

import statsmodels.api as sm

from statsmodels.tsa.arima_model import ARIMA

from pandas.plotting import autocorrelation_plot

#import data from an Excel spreadsheet where xt is the column

containing individual observations

data = read_excel(’your directory’)

series = data.xt

dates = sm.tsa.datetools.dates_from_range(’1980m1’, length=len(series

))

y = series

arma_mod = sm.tsa.ARIMA(y, order=(1,0,0))

arma_res = arma_mod.fit()

print(arma_res.summary())

autocorrelation_plot(series)

pyplot.show()

#plot main results

fig = plt.figure()

ax1 = fig.add_subplot(111)

fig = sm.graphics.tsa.plot_acf(series.values.squeeze(), lags=25, ax=

ax1)

sns.despine(offset=10, trim = False)

#set xticks to start from one since Python starts counting from zero

xticks(arange(len(series), step = 1), arange(0, len(series), step =

1))

#label y-axis and x-axis

ax1.set_xlabel(’$Lag$ $k$’)

ax1.set_ylabel(r’$\hat{\rho}_k$’, size = 14)

show()
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How-To 4.9 (Regression in Excel 2013)

• To fit a linear regression model using the Data Analysis add-in, click on Data
Analysis > Regression > Upload 𝑥𝑡 data for InputY Range and 𝑥𝑡−1 data for
Input X Range > OK. See the snapshot illustrated in Figure 4.10. If the Data
Analysis add-in is not loaded, you can add it by clicking on File >Options
> Add-ins > Analysis ToolPak > Manage: Excel Add-in > Check the box of
Analysis ToolPak >OK.

Figure 4.10: Regression options in the Data Analysis add-in, Excel 2013

• To create a scatter plot between 𝑥𝑡 and 𝑥𝑡−1, select your data >Click on th
Insert tab > Click on the Scatter plot in the charts menu. To fit a linear
function to the scatter plot, right-click on any point in the scatter plot and then
click on Add Trendline.... To display the fitted linear function, select Display
Equation on chart. You can also display the 𝑅2 measure.

Example 4.3 (ARIMA(1,0,0))
The lab manager at General Hospital is interested in monitoring the process of
assays for substance X. The current standard is 175 mml/l. Table 4.4 presents
assay data for the past 26 days..
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Table 4.4: Assay data in mml/l for substance X

𝑡 𝑥𝑡 𝑡 𝑥𝑡

1 185.8 14 185.2
2 174.8 15 187.7
3 175.0 16 179.9
4 170.0 17 163.0
5 165.0 18 179.0
6 163.9 19 190.0
7 160.4 20 182.5
8 165.6 21 190.7
9 169.1 22 186.7

10 172.4 23 185.1
11 165.0 24 177.8
12 167.9 25 174.2
13 175.6 26 165.3

Subsequently, the manager created 𝐼𝑚𝑅 control charts as displayed in Figure 4.11.

Figure 4.11: Control chart for individual and moving ranges of the assay data in
Table 4.4

(a) 𝐼-𝑐ℎ𝑎𝑟𝑡
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(b) 𝑀𝑅-𝑐ℎ𝑎𝑟𝑡
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The manager did not detect any out-of-control behaviors in the 𝐼𝑚𝑅 charts and
was satisfied that the mean of individual observations was close to the target. But,
the seemingly non-random behaviors in the 𝐼-𝑐ℎ𝑎𝑟𝑡 made the manager suspicious
of small shifts or autocorrelation in the process. To validate this suspicion, the
manager proceeded to set 𝜆 = 0.2 and calculate 𝜎 = 𝑀𝑅

𝑑2
to create an EWMA chart

shown in Figure 4.12.

Figure 4.12: EWMA control chart based on the data in Table 4.4
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As the manager had suspected, the EWMA chart in Figure 4.12 showed several
out-of-control points, likely due to small shifts in the process, but trends in the data
persisted. To test for autocorrelation, the manager created a scatter plot between
𝑥𝑡 and 𝑥𝑡−1 as displayed in Figure 4.13.

Figure 4.13: A scatter plot of 𝑥𝑡 and 𝑥𝑡−1 in Excel based on the data in Table 4.4
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The scatter plot in Figure 4.13 shows a positive correlation between 𝑥𝑡 and 𝑥𝑡−1.
From this result, the manager decided to plot ACF in both Python and Minitab, as
shown in Figure 4.14.

Figure 4.14: ACF of the data in Table 4.4

(a) ACF in Python
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(b) ACF in Minitab 18

From the ACF plots in Figures 4.14, we notice that 𝜌̂1 falls outside of the two stan-
dard deviation limit, which makes it statistically significant at the 5% significance
level. The result of 𝜌̂0 = 1 in Subfigure 4.14a is expected since the data is being
covaried on itself (e.g., 𝐶𝑜𝑣(𝑥𝑡,𝑥𝑡)). No other lags of ACF are significant. Accord-
ingly, the manager decided to fit 𝐴𝑅(1) model in Minitab as displayed in Table 4.5.
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Table 4.5: Final Estimates of Parameters of 𝐴𝑅(1) in Minitab 18 based on the data
in Table 4.4

Type Coef SE Coef T-Value P-Value

AR 1 0.68 0.156 4.36 0
Constant 56.06 1.41 39.7 0

Mean 175.33 4.42

The first p-value in Table 4.5 indicates that the coefficient of the 𝐴𝑅(1) model is
statistically significant. The actual 𝐴𝑅(1) model can be written as follows:

𝑥𝑡 = 56.06+0.68𝑥𝑡−1 + 𝑒𝑡 (4.21)

From this model, the manager obtained the residuals by 𝑒𝑡 = 𝑥𝑡−(56.06+0.68𝑥𝑡−1),
as displayed in Table 4.6.

Table 4.6: Residuals (𝑒𝑡) based on the 𝐴𝑅(1) model in Equation 4.21

t 𝑥𝑡 𝑥𝑡 𝑒𝑡 t 𝑥𝑡 𝑥𝑡 𝑒𝑡

1 185.8 14 185.2 175.468 9.732
2 174.8 182.404 -7.604 15 187.7 181.996 5.704
3 175 174.924 0.076 16 179.9 183.696 -3.796
4 170 175.06 -5.06 17 163 178.392 -15.392
5 165 171.66 -6.66 18 179 166.9 12.1
6 163.9 168.26 -4.36 19 190 177.78 12.22
7 160.4 167.512 -7.112 20 182.5 185.26 -2.76
8 165.6 165.132 0.468 21 190.7 180.16 10.54
9 169.1 168.668 0.432 22 186.7 185.736 0.964
10 172.4 171.048 1.352 23 185.1 183.016 2.084
11 165 173.292 -8.292 24 177.8 181.928 -4.128
12 167.9 168.26 -0.36 25 174.2 176.964 -2.764
13 175.6 170.232 5.368 26 165.3 174.516 -9.216

The ACF of the residuals shows no further autocorrelation, as Figure 4.15 indicates.
Accordingly, the manager has decided to monitor the process using the EWMA
chart on the residuals of the 𝐴𝑅(1) model. The resulting chart is illustrated in
Figure 4.16. This new chart indicates that the process is stable.
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Figure 4.15: ACF of Residuals in Minitab 18

Figure 4.16: EWMA control chart based on the residuals in Table 4.6
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Following instructions in How-To 4.9, we approximate the 𝐴𝑅(1) model in Excel
using the regression option. We use 𝑥𝑡−1 for Input X Range and 𝑥𝑡 for Input Y
Range. The summary of Excel outputs is presented in Table 4.7.
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Table 4.7: A summary of the regression output for the process 𝑥𝑡, Excel 2013

Regression Statistics

Multiple R 0.649112
R Square 0.421346
Adjusted R Square 0.396187
Standard Error 7.199552
Observations 25

ANOVA

df SS MS F Significance F

Regression 1 868.0786 868.0786 16.74743 0.00044715
Residual 23 1192.172 51.83356
Total 24 2060.25

Coefficients Standard Error t Stat P-value Lower 95% Upper 95% Lower 95.0% Upper 95.0%

Intercept 61.13115 27.83072 2.196535 0.038398 3.558911799 118.7034 3.558912 118.7034
AR(1) 0.647388 0.158194 4.092362 0.000447 0.320138207 0.974637 0.320138 0.974637

From Table 4.7, we notice that the coefficients of this model are slightly different,
but this does not affect the significance of the model since the p-value is still less
than 0.05. Additionally, comparing the model coefficient to two standard deviations,
given by 2/

√
25 = 0.4, we observe that 0.65 > 0.4. Hence per Equation 4.16, we

can still conclude that the 𝐴𝑅(1) model in Excel is statistically significant. To run
the ARIMA (1,0,0) using Python, use the script in How-To 4.8.

4.4 Multivariate control charts

In this section, we discuss how to monitor a process with dependent variables using
multivariate control charts. In the previous section, we discussed how dependence in
the process samples could lead to incorrect control results if one failed to account for
autocorrelation. The same outcome is likely if a multivariate process has dependent
variables, and one monitors them separately, instead jointly. In general, paired variables
based on the same process are likely to be dependent. But, if these variables are found
to be independent, they can be monitored disjointedly.

Several techniques exist for monitoring multivariate processes. Examples include
multivariate EWMA charts to detect small shifts in the process [44], and multivariate at-
tribute control charts to monitor processes with dependent binomial variables [40]. Here,
we focus on one type of multivariate charts known as Hotelling 𝑇 2. This chart is the
multivariate version of the 𝑋-𝑏𝑎𝑟 Shewhart control chart. We apply the 𝑇 2 chart when
variables are jointly distributed according to a multivariate normal random variable [44].

Figure 4.17 shows a basic decision tree for deciding whether the 𝑇 2 chart is appro-
priate.
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Figure 4.17: When is the 𝑇 2 chart appropriate?
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Next, we present possible scenarios of health care processes where multivariate pro-
cess control charts may be applicable.

Scenario 1: A quality manager at Metropolis Imaging Center is interested in monitoring
the amount of radiation that patients are exposed to during cardiac angiogram pro-
cedures. The variables of interest are the dose area product (measured in 𝑚𝐺𝑦-𝑐𝑚
squared)7, fluoroscopy time (measured in minutes), and the number of digital im-
ages (measured using the count of frames captured). Since these variables are
related according to a multivariate normal distribution, the manager has decided
to use the 𝑇 2 chart to monitor this process. See Waterhouse et al. (2010)[64] for
further discussion about the use of multivariate control charts to monitor radiation
in patients.

Scenario 2: An office manager at a community clinic is trying to monitor the health status
of patients with chronic respiratory conditions. From consulting with clinicians, the
manager decided to control three output variables: partial pressure oxygen (PaO2),
partial pressure carbon dioxide (PaCO2), and the body mass index (BMI). Since
these variables are believed to be correlated and jointly distributed according to a
multivariate normal random variable, the manager decided to apply the 𝑇 2 chart to
monitor this process. See Correia (2011) [20] for further discussion about the use
of multivariate control charts to monitor the health status of patients with chronic
respiratory conditions.

Scenario 3: A clinical data manager at General Hospital is concerned about data entry
errors and would like to set up control charts to monitor the accuracy, completeness,
and consistency of the data captured at the point-of-care. Since these variables are

7𝑚𝐺𝑦-𝑐𝑚: milligray- centimeter
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likely dependent, the manager is looking into applying multivariate control charts for
attribute data, as suggested in Lu (1998) [40]. For more discussion about the use
of control charts to monitor data quality, see Jones et al. (2014) [33].

4.4.1 How to set up the 𝑇 2 chart?

Monitoring mean behaviors

Let’s assume that a process has a 𝑝−component vector of 𝑥 variables that are jointly
distributed according to the multivariate normal denoted as follows:

𝑓 (𝑥) =
1

(2𝜋)𝑝/2|Σ|1/2
𝑒−

1
2 (𝑥−𝜇)

′Σ−1(𝑥−𝜇) (4.22)

where the ′ symbol signifies transpose, |Σ| denotes the determinant of the 𝑝×𝑝 covariance
matrix Σ, and 𝜇 is a 𝑝 × 1 mean vector. When 𝜇 and Σ are given, we monitor:

𝜒2
0 = 𝑛(𝑥 −𝜇)Σ−1(𝑥 −𝜇) (4.23)

where 𝑥 is a 𝑝 × 1 mean vector, and 𝑛 is the constant sample size. The statistic 𝜒2
0 is

distributed according to Chi-square (𝜒2). The corresponding 𝐿𝐶𝐿 is always zero, and we
obtain 𝑈𝐶𝐿 as follows:

𝑈𝐶𝐿 = 𝜒2
𝛼,𝑝 (4.24)

Here, 𝛼 is the upper percentage of the 𝜒2 distribution, and 𝑝 denotes the degrees of
freedom [44].

When 𝜇 and Σ are not known, we can estimate them from the process using ¯̄𝑥 and 𝑆,
where ¯̄𝑥 is a p-component vector of sample means and 𝑆 is the corresponding covariance
matrix that is determined from averages of sample variances and covariances [44]. In this
case, the 𝑇 2 statistic that we monitor is given by:

𝑇 2 = 𝑛(𝑥 − ¯̄𝑥)′𝑆−1(𝑥 − ¯̄𝑥) (4.25)

The formulation in Equation 4.25 is referred to as Hotelling. This chart only has one
limit, the 𝑈𝐶𝐿, and no centerline. But, one can always use the median of the data for the
centerline, as it is done in Minitab 18. Box 4.3 summarizes techniques for calculating the
𝑈𝐶𝐿 of the Hotelling 𝑇 2 chart when 𝑛 > 1. Box 4.4 presents similar calculations when
𝑛 = 1.
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Box 4.3 Hotelling 𝑇 2 control chart when 𝑛 > 1

When 𝑛 > 1, we obtain the 𝑈𝐶𝐿 of the 𝑇 2 chart as follows:

𝑈𝐶𝐿𝑃 ℎ𝑎𝑠𝑒𝐼 =
𝑝(𝑚− 1)(𝑛− 1)
𝑚𝑛−𝑚− 𝑝+1

𝐹𝛼,𝑝,𝑚𝑛−𝑚−𝑝+1 (4.26)

𝑈𝐶𝐿𝑃 ℎ𝑎𝑠𝑒𝐼𝐼 =
𝑝(𝑚+1)(𝑛− 1)
𝑚𝑛−𝑚− 𝑝+1

𝐹𝛼,𝑝,𝑚𝑛−𝑚−𝑝+1 (4.27)

where 𝛼 is the upper percentage of 𝐹 distribution, 𝑚 is the number of subgroups
(each with size 𝑛 > 1), and 𝑝 is the number of variables. For a large 𝑚 (e.g.,
𝑚 > 100), we set up the 𝑈𝐶𝐿 per Equation 4.24 [44].

Box 4.4 Hotelling 𝑇 2 control chart when 𝑛 = 1

When 𝑛 = 1, we obtain the 𝑈𝐶𝐿 of the 𝑇 2 chart as follows:

𝑈𝐶𝐿𝑃 ℎ𝑎𝑠𝑒𝐼 =
𝑝(𝑚− 1)
𝑚− 𝑝

𝐹𝛼,𝑝,𝑚−𝑝 (4.28)

𝑈𝐶𝐿𝑃 ℎ𝑎𝑠𝑒𝐼𝐼 =
(𝑚− 1)2

𝑚
𝛽𝛼,𝑝/2,(𝑚−𝑝−1)/2 (4.29)

where 𝛼 is the upper percentage of 𝐹 and 𝛽 distributions, 𝑚 is the number of
subgroups (each with size 𝑛 = 1), and 𝑝 is the number of variables. For a large 𝑚
(e.g., 𝑚 > 100) we set up the UCL per Equation 4.24 [44].

Monitoring variability

Monitoring variability in multivariate processes requires monitoring the determinant of the
covariance matrix in each sample. To do that, we apply the generalized variance (GV)
control chart that we construct per Box 4.5 [44].
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Box 4.5 GV control chart

Given sample 𝑖 and covariance matrix 𝑆𝑖 , the statistic to be monitored is:

|𝑆𝑖 | (4.30)

where the |.| symbols here indicate determinant, not an absolute value. The control
limits are obtained by:

𝑈𝐶𝐿 =
|𝑆 |
𝑏1

(︁
𝑏1 +3

√
𝑏2

)︁
(4.31)

𝐶𝐿 = |𝑆 | (4.32)

𝐿𝐶𝐿 =
|𝑆 |
𝑏1

(︁
𝑏1 − 3

√
𝑏2

)︁
(4.33)

where 𝑆 is the overall covariance matrix and

𝑏1 =
1

(𝑛− 1)𝑝

𝑝∏︁
𝑖=1

(𝑛− 𝑖) (4.34)

𝑏2 =
1

(𝑛− 1)2𝑝

𝑝∏︁
𝑖=1

(𝑛− 𝑖)

⎡⎢⎢⎢⎢⎢⎢⎣
𝑝∏︁

𝑗=1

(𝑛− 𝑗 +2)−
𝑝∏︁

𝑗=1

(𝑛− 𝑗)

⎤⎥⎥⎥⎥⎥⎥⎦ (4.35)

4.4.2 How does the 𝑇 2 chart work?

Setup

Unlike in univariate control charts where single variable calculus is applicable, much of
the mathematical machinery behind multivariate control relates to linear algebra. This
circumstance makes the computation of the control statistics a bit different than in the
univariate case. We demonstrate with a bivariate case of individual observations where
the related variables are 𝑥1 and 𝑥2. We obtain 𝑇 2 as follows:

𝑇 2 = 𝑛(𝑥 − 𝑥)′𝑆−1(𝑥 − 𝑥) (4.36)

From Equation 4.36, 𝑥 is a vector of 𝑥1 and 𝑥2 given by 𝑥′ = [𝑥1,𝑥2], and 𝑥 is a mean
vector of 𝑥1 and 𝑥2 given by 𝑥′ = [𝑥1,𝑥2]. Let 𝑠21 be the variance of 𝑥1, 𝑠22 the variance
of 𝑥2, and 𝑠21 = 𝑠12 the covariance of 𝑥1 and 𝑥2. We obtain the covariance matrix 𝑆 this
way:

𝑆 =
[︃
𝑠21 𝑠12
𝑠12 𝑠22

]︃
(4.37)
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We obtain the inverse of 𝑆, denoted as 𝑆−1, like this [36]:

𝑆−1 =
[︃
𝑠21 𝑠12
𝑠12 𝑠22

]︃−1
=

1
|𝑆 |

[︃
𝑠22 −𝑠12
−𝑠12 𝑠21

]︃
=

1

𝑠21𝑠
2
2 − 𝑠

2
12

[︃
𝑠22 −𝑠12
−𝑠12 𝑠21

]︃
(4.38)

Subsequently, we can compute the 𝑇 2 statistic this way:

𝑇 2 = 𝑛[𝑥1 − 𝑥1,𝑥2 − 𝑥2]
[︃
𝑠21 𝑠12
𝑠12 𝑠22

]︃−1 [︃
𝑥1 − 𝑥1
𝑥2 − 𝑥2

]︃
(4.39)

=
𝑛

𝑠21𝑠
2
2 − 𝑠

2
12

[𝑥1 − 𝑥1,𝑥2 − 𝑥2]
[︃
𝑠22 −𝑠12
−𝑠12 𝑠21

]︃[︃
𝑥1 − 𝑥1
𝑥2 − 𝑥2

]︃
(4.40)

=
𝑛

𝑠21𝑠
2
2 − 𝑠

2
12

[︁
𝑠22(𝑥1 − 𝑥1)

2 + 𝑠21(𝑥2 − 𝑥2)
2 − 2𝑠12(𝑥1 − 𝑥1)(𝑥2 − 𝑥2)

]︁
(4.41)

To compute the 𝑇 2
𝑖 statistic for sample 𝑖, we substitute 𝑥1 and 𝑥2 with their respective

numeric values. All other parameters remain constant.

Interpretation

The detection of out-of-control behaviors in multivariate control charts is as before. That
is, if the test statistic falls outside of the UCL, the process has special cause variation.
But, unlike in the univariate case, it is challenging to pinpoint assignable causes in mul-
tivariate control charts due to the interdependence of the variables. The 𝐺𝑉 chart adds
one more layer of complexity since the determinant of the covariance in different samples
may be the same even though the variances in respective variables are quite different.
Hence, it is recommended to monitor the variance of each variable, in addition to moni-
toring the joint generalized variance [44].

How-To 4.10 (Multivariate charts in Minitab 18)
Click on Stat > Multivariate Charts. See the snapshot in Figure 4.18.
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Figure 4.18: Multivariate control charts in Minitab 18

How-To 4.11 (Python 3.6)

Script 4.4: A script for creating a multivariate control chart using Python 3.6

#MUTLIVARIATE CONTROL CHART

#import modules

import scipy.stats

from pandas import *
from pylab import *
import operator

import seaborn as sns

from functools import reduce

data = read_excel(’your directory’)

#iniliaze parameters and statistics for the control T^2 chart

u1 = data.mean()[’Coding’]

u2 = data.mean()[’Abstracting’]

s1 = data.mean()[’VarC’]

s2 = data.mean()[’VarA’]

s12 = data.mean()[’CovCA’]

n = 10 #given sample size in Example 4.4. Change this parameter as

necessary

for i, j in zip(data.Coding, data.Abstracting):

T2 = (n/((s1*s2) -s12**2))*(s2*(i-u1)**2 + s1*(j - u2)**2 - 2*s12

*(i - u1)*(j-u2))

df_cov = DataFrame(array([[s1, s12],[s12,s2]]))

df_inv = array(DataFrame(np.linalg.inv(df_cov.values), df_cov.columns

, df_cov.index))

df_det = np.linalg.det(df_cov.values)

p = len(df_cov)
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m = len(data)*1.

a = p*(m-1)*(n-1.)

b = m*n-m-p+1.

d = a/float(b)

v1 = p

v2 = b

alpha = 0.001

F = scipy.stats.f.ppf(q=1-alpha, dfn=v1, dfd=v2)

#calculate control limits

UCLm = [d*F]*len(data)

LCLm = [0]*len(data)

#mark red the point that falls outside of the UCL. Otherwise, mark

the point blue.

mv = []

markers = []

colors = []

for i in range (len(data)):

x1 = data.ix[i][’Coding’]

x2 = data.ix[i][’Abstracting’]

row = array([x1-u1,x2-u2])

dot1 = dot(df_inv,row)

dot2 = dot(row.T,dot1)

mv.append(dot2*n)

if dot2*n > UCLm[0]:

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#Plotting the T^2 chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCLm, ’k-’, alpha = 0.5)

ax1.plot(LCLm, ’k-’,alpha = 0.5)

ax1.plot(mv,’b-’,zorder=1)

for x,y,c,m in zip(t, mv, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

ax1.set_xlabel(’Sample number’)

ax1.set_ylabel(’$T^2$’)

ax1.annotate (’$UCL$’, xy = (xlim()[1], list(UCLm)[-1]), xytext = (

xlim()[1],list(UCLm)[-1]))

ax1.annotate (’$LCL$’, xy = (xlim()[1], list(LCLm)[-1]), xytext = (

xlim()[1],list(LCLm)[-1]))

#set xticks to start from one since Python starts counting from zero

N = len(UCLm)

xticks(arange(N, step = 1), arange(1, N+1, step = 1))

show()

#

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
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# GV chart for variability

prodlist1 = []

prodlist2 = []

for i in range(1, p+1):

prodlist1.append(n-i)

for i in range(1, p+1):

prodlist2.append(n-i + 2.)

prod1 = reduce(operator.mul, prodlist1, 1)*1.

prod2 = reduce(operator.mul, prodlist2, 1)*1.

b1 = (1./((n-1.)**p))*prod1

b2 = ((1./((n-1.)**(2*p)))*prod1)*(prod2 - prod1)

UCLgv = [(df_det/b1)*(b1+3.*sqrt(b2))]*len(data)

LCLgv = [max(0,(df_det/b1)*(b1-3.*sqrt(b2)))]*len(data)

CLgv = [df_det]*len(data)

#mark red the point that falls outside of the UCL. Otherwise, mark

the point blue.

gv = []

markers = []

colors = []

for i in range(len(data)):

s1i = float(data.ix[i][’VarC’])

s2i = float(data.ix[i][’VarA’])

s12i = float(data.ix[i][’CovCA’])

Si = DataFrame(array([[s1i, s12i],[s12i,s2i]]))

Ai = Si

DAi = np.linalg.det(Ai)

gv.append(DAi)

if (DAi > UCLgv[0] or DAi < LCLgv[0]):

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

#plot the GV chart

fig=figure()

ax1 = fig.add_subplot(111)

t = arange(len(data))

ax1.plot(UCLgv, ’k-’, alpha = 0.5)

ax1.plot(LCLgv, ’k-’,alpha = 0.5)

ax1.plot(CLgv, ’k-’,alpha = 0.5)

ax1.plot(gv,’b-’,zorder=1)

for x,y,c,m in zip(t, gv, colors, markers):

ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

ax1.set_xlabel(’Sample number ($i$)’)

ax1.set_ylabel(’$|S_i|$’)

ax1.annotate (’$UCL$’, xy = (xlim()[1], list(UCLgv)[-1]), xytext = (

xlim()[1],list(UCLgv)[-1]))

ax1.annotate (’$CL$’, xy = (xlim()[1], list(CLgv)[-1]), xytext = (

xlim()[1],list(CLgv)[-1]))

ax1.annotate (’$LCL$’, xy = (xlim()[1], list(LCLgv)[-1]), xytext = (

xlim()[1],list(LCLgv)[-1]))
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#set xticks to start from one since Python starts counting from zero

N = len(UCLgv)

xticks(arange(N, step = 1), arange(1, N+1, step = 1))

show()

Example 4.4 (Multivariate control in medical coding)
A medical coding process involves two major sub-processes: the transformation of
medical diagnoses and surgeries into codes, which is referred to as coding, and
the reporting of administrative data (e.g., patient discharge disposition), which is
known to as abstracting [11].
The medical coding manager at Metropolis Hospital would like to monitor the daily
averages of the time it takes to code and abstract an inpatient record. Given that
these two sub-processes are likely correlated, the manager has decided to use the
𝑇 2 chart to monitor the process. It is assumed that the performance of all coders is
statistically the same. Additionally, it is assumed that patient records are statistically
independent. To proceed, the manager sampled 10 inpatient records daily and
determined the average, variance, and covariance statistics for coding (variable 𝑥1)
and abstracting (variable 𝑥2). The data that the manager has collected so far are
displayed in Table 4.8. Here, 𝑥1 and 𝑠21 represent the average and variance of the
coding time, and 𝑥2 and 𝑠22 represent the average and variance of the abstracting
time. The daily covariance is denoted by 𝑠12.

Table 4.8: Daily statistics for coding (𝑥1) and abstracting (𝑥2) at Metropolis Hospital

Sample# 𝑥1 𝑥2 𝑠21 𝑠22 𝑠12 Sample# 𝑥1 𝑥2 𝑠21 𝑠22 𝑠12

1 17 5 30 17 15 16 14 5 15 8 6
2 13 5 22 19 18 17 19 7 10 7 5
3 14 2 21 9 8 18 14 4 19 15 14
4 16 3 30 17 15 19 12 5 31 11 10
5 19 9 31 11 10 20 20 4 32 12 11
6 14 4 20 20 19 21 14 5 24 19 18
7 13 3 16 19 15 22 13 4 21 7 5
8 20 5 31 12 11 23 14 4 21 8 6
9 15 5 16 18 14 24 17 4 15 7 6
10 16 5 20 6 4 25 14 4 28 7 6
11 13 4 25 14 13 26 17 5 13 20 11
12 13 5 10 7 5 27 20 6 30 16 14
13 18 6 28 15 14 28 13 3 31 8 7
14 19 4 24 12 11 29 14 5 28 17 15
15 18 7 10 12 8 30 13 3 11 8 7

To create the 𝑇 2 chart, the manager applied the Python script in How-To 4.11 and
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obtained the following statistics:

¯̄𝑥 =
[︃
¯̄𝑥1
¯̄𝑥2

]︃
=

[︃
16
5

]︃
𝑆 =

[︃
𝑠21 𝑠12
𝑠12 𝑠22

]︃
=

[︃
22.1 10.7
10.7 12.6

]︃
(4.42)

Since the process is still in phase I, the manager established 𝑈𝐶𝐿𝑝ℎ𝑎𝑠𝑒𝐼 as follows:

𝑈𝐶𝐿 =
𝑝(𝑚− 1)(𝑛− 1)
𝑚𝑛−𝑚− 𝑝+1

𝐹𝛼,𝑝,𝑚𝑛−𝑚−𝑝+1 (4.43)

=
2(30− 1)(2− 1)
30(2)− 30− 2+1

𝐹0.001,2,269 (4.44)

=
522
269

(7.088) (4.45)

= 13.75 (4.46)

where n = 10, p = 2, m = 30, and 𝛼 = 0.001. The value of 7.088 was determined
using the Scipy module in Python, but an approximate value can be found in any 𝐹
table with 𝛼 = 0.001, 𝑣1 = 2, and 𝑣2 = 269. The resulting 𝑇 2 chart is portrayed in
Figure 4.19a. The corresponding 𝐺𝑉 chart is illustrated in Figure 4.19b.

Figure 4.19: 𝑇 2 and 𝐺𝑉 charts based on the data in Table 4.8
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The dynamics of the chart in Figure 4.19a reveal two out-of-control points. The
manager is going to investigate the cause of this special cause variation. After
fixing any assignable issues, the manager will omit these points and create new
control limits to monitor the future process. The 𝐺𝑉 chart in Figure 4.19b is stable.

We now use Excel to reproduce the 𝑇 2 chart in Figure 4.19a. To do that,
we begin by setting up our Excel spreadsheet, as shown in Figure 4.20.

Figure 4.20: A setup of Excel to reproduce the 𝑇 2 chart based on the data in Table
4.8

We calculated the 𝑇 2 statistic for each day. For example the 𝑇 2 value in cell
C2 was obtained by: =(𝐻6/(𝐽2*𝐾3-𝐽3*𝐾2))*((𝐾3*(A2-𝐻2)*(A2-𝐻2))+(𝐽2*(B2-
𝐻3)*(B2-𝐻3))-2*(𝐾2*(A2-𝐻2)*(B2-𝐻3))). We determined the diagonal elements
of the covariance matrix in Figure 4.20 by taking the averages of 𝑠1 and 𝑠2 to obtain
22.10 and 12.6, respectively. The off-diagonal element is the average of the 𝑠12
column, which equals 10.7. The mean vector is composed of averages of 𝑥1 and
𝑥2. We programmed the 𝑈𝐶𝐿 formula for phase I per Box 4.3. As before, n = 10, p
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= 2, m = 30 and the 𝐹 value at 𝛼 = 0.001 is 7.088.

To reproduce the 𝐺𝑉 chart in Excel, we start by setting up our spreadsheet
as pictured in Figure 4.21.

Figure 4.21: A setup of Excel to reproduce the 𝐺𝑉 chart based on the data in
Table 4.8

We calculated the 𝐺𝑉 statistics per Box 4.5. For example, we determined row 2 in
Figure 4.21 as follows:

𝑈𝐶𝐿 = ((𝐿2 *𝑀3−𝐿3 *𝑀2)/𝐽8) * (𝐽8+3 * 𝑆𝑄𝑅𝑇 (𝐽9)) (4.47)
𝐶𝐿 = 𝐿2 *𝑀3−𝐿3 *𝑀2 (4.48)
|𝑆 | = 𝐴2 *𝐵2−𝐶2 *𝐶2 (4.49)

We set 𝐿𝐶𝐿 to zero since it was originally negative.
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4.5 EXERCISES

1. Use Excel to recreate both the risk-adjusted and traditional p charts in Example
4.1.

2. Use Excel to recreate the risk-adjusted CUSUM in Example 4.2.

3. The administrator of Metropolis Skilled Nursing Facility is interested in using risk-
adjusted control charts to monitor the rate of resident falls. To estimate the risk, the
administrator will use the Morse Fall Scale [52] of each resident. Table 4.9 presents
the data that the manager has collected so far. The 𝐶𝑒𝑛𝑠𝑢𝑠 column indicates the
total number of residents on any given day. The 𝐹𝑎𝑙𝑙𝑠 column shows the daily
number of residents who fell at least once. The 𝑅𝑖𝑠𝑘 column contains the averages
of the daily probabilistic measures of the Morse Fall Scale, and the 𝑆𝑡𝐷𝑒𝑣 column
represents the corresponding standard deviation.

(a) Estimate the process standard deviation

(b) Create a risk-adjusted p-chart with 𝐿 = 2

(c) Create a traditional p-chart with 𝐿 = 2. Explain the difference in your p charts.

(d) Create a risk-adjusted CUSUM chart of the expected daily falls. Use ℎ = 4.5
and 𝑂𝑅 = 2 for upper CUSUM, and 𝑂𝑅 = 0.5 for lower CUSUM. What can
you conclude?

4. Using Minitab, Excel, and Statsmodels in Python, recreate the results in Example
4.3.

5. The data in Table 4.10 represents queue times, in minutes, of IT tickets related to
a clinical decision support system (CDSS) at Metropolis Hospital. The CIO of this
hospital has set a goal of 30 minutes, on average, to respond to users’ questions.

(a) Using Excel or Minitab, create 𝐼𝑚𝑅 and 𝐸𝑊𝑀𝐴 control charts of this process.
What can you conclude?

(b) Using Python Statsmodels or Minitab, fit AR(1) and AR(2) models. What can
you conclude from your results?

(c) Create the final control chart to monitor the process. Discuss your results.

6. Consider the sample data of a bivariate process in Table 4.11, where the 𝑥1 column
represents the mean behavior of variable 𝑥1 and the 𝑥2 column represents the
mean behavior of variable 𝑥2. From an in-control process with 𝑚 = 50 samples and
the constant sample size of 𝑛 = 10, we are given the following statistics:

¯̄𝑥 =
[︃
15
5

]︃
𝑆 =

[︃
21 9
9 15

]︃
(4.50)

Use Excel or Python to create a phase II 𝑇 2 and 𝐺𝑉 charts. Assume 𝛼 = 0.001.
What can you conclude?
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Table 4.9: Falls at Metropolis Skilled Nursing Facility

𝐷𝑎𝑦 𝐶𝑒𝑛𝑠𝑢𝑠 𝐹𝑎𝑙𝑙𝑠 𝑅𝑖𝑠𝑘 𝑆𝑡𝐷𝑒𝑣 𝐷𝑎𝑦 𝐶𝑒𝑛𝑠𝑢𝑠 𝐹𝑎𝑙𝑙𝑠 𝑅𝑖𝑠𝑘 𝑆𝑡𝐷𝑒𝑣

1 83 5 0.48 0.38 26 94 6 0.28 0.22
2 75 9 0.14 0.11 27 76 10 0.1 0.08
3 93 6 0.26 0.2 28 86 15 0.1 0.08
4 76 9 0.23 0.18 29 95 10 0.8 0.64
5 72 12 0.12 0.1 30 92 3 0.55 0.44
6 88 4 0.06 0.05 31 99 8 0.85 0.68
7 99 6 0.24 0.19 32 79 3 0.85 0.68
8 91 6 0.35 0.28 33 94 7 0.08 0.06
9 92 7 0.26 0.2 34 91 9 0.4 0.32

10 85 9 0.45 0.36 35 98 6 0.21 0.17
11 87 4 0.05 0.04 36 98 8 0.2 0.16
12 90 20 1 0.8 37 85 9 0.28 0.22
13 73 4 0.6 0.48 38 73 3 0.18 0.14
14 83 7 0.86 0.68 39 87 9 0.23 0.18
15 83 9 0.72 0.58 40 88 8 0.85 0.68
16 85 4 0.06 0.05 41 82 6 0.26 0.21
17 77 4 0.2 0.16 42 94 7 0.7 0.56
18 76 6 0.53 0.42 43 98 5 0.28 0.22
19 77 3 0.28 0.22 44 80 7 0.23 0.18
20 77 6 0.45 0.36 45 80 9 0.8 0.64
21 75 8 0.2 0.16 46 97 6 0.44 0.35
22 99 10 0.4 0.32 47 73 6 0.8 0.64
23 93 7 0.14 0.11 48 75 9 0.44 0.35
24 78 8 0.27 0.22 49 92 3 0.11 0.08
25 95 10 0.3 0.24 50 100 5 0.06 0.05
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Table 4.10: Queue times of IT tickets for CDSS-related questions

𝑡 𝑥𝑡 𝑡 𝑥𝑡 𝑡 𝑥𝑡 𝑡 𝑥𝑡

1 35.9 19 30.7 37 34.1 55 33.6
2 33 20 30.3 38 28.9 56 31.2
3 33.5 21 29.5 39 27.6 57 31.3
4 29.1 22 27.8 40 24.5 58 27.1
5 26.8 23 30.8 41 29.2 59 31
6 25.7 24 35.3 42 31.8 60 31
7 24.3 25 29.1 43 29.4 61 34.6
8 22.9 26 30.2 44 29.3 62 33.8
9 27.3 27 31.3 45 31.3 63 31.7
10 26.9 28 27.3 46 29.3 64 31.6
11 22.9 29 27.9 47 26.1 65 30.2
12 22.1 30 33.7 48 29.6 66 30.5
13 25.6 31 37.5 49 30.3 67 28.9
14 22.5 32 37.8 50 31.5 68 28.6
15 25.7 33 35.8 51 31.1 69 25.7
16 29.5 34 34.8 52 34.1 70 23.7
17 33.2 35 34.1 53 35.9
18 32.5 36 34 54 32.3

Table 4.11: Sample statistics of a bivariate medical process at Metropolis Hospital

Sample# 𝑥1 𝑥2 Sample# 𝑥1 𝑥2

1 20 6 16 15 5
2 19 7 17 14 8
3 20 5 18 15 5
4 16 8 19 18 7
5 14 6 20 14 5
6 14 6 21 20 6
7 20 4 22 19 8
8 20 6 23 15 6
9 18 6 24 13 4
10 17 6 25 13 4
11 13 5 26 20 7
12 15 3 27 13 5
13 14 3 28 14 5
14 14 5 29 17 7
15 20 6 30 17 3
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7. Consider individual clinical measurements in Table 4.12, where 𝑚 = 45 and 𝑛 = 1.
Additionally, we are given these statistics:

𝑥 =
[︃
82.5
39.1

]︃
𝑆 =

[︃
14 13
13 25

]︃
(4.51)

Use Excel or Python to create phase II 𝑇 2 and 𝐺𝑉 charts. Assume 𝛼 = 0.001.
What can you conclude?

Table 4.12: Individual clinical measurements

Sample# 𝑥1 𝑥2 Sample# 𝑥1 𝑥2

1 82.2 45.1 11 82.6 48.3
2 81.1 48.55 12 74.7 38.35
3 89.2 44.6 13 73.4 43.7
4 89.9 53.95 14 75.7 45.85
5 80.5 41.25 15 81.5 46.75
6 78.4 43.2 16 84.9 45.45
7 76.8 40.4 17 85.5 43.75
8 74.4 38.2 18 74.8 41.4
9 79.7 43.85 19 89.1 49.55

10 85 45.5 20 71.8 43.9



CHAPTER 5

Tools related to control charts

In this last chapter, we examine quality improvement tools that are re-
lated to control charts. Among the topics we discuss are capability anal-
ysis and run charts. We also consider benchmarking methods such as
funnel charts and analysis of means (ANOM). We demonstrate how to
create and implement these concepts using Excel, Python, and Minitab
software.

Key concepts and tools: Capability analysis; Run charts; Benchmarking quality;
Analysis of means (ANOM); Analysis of variance (ANOVA); League tables; Funnel
charts

Major objectives
After studying this chapter, you will be able to:

1. Define key concepts and tools related to control charts

2. Recognize the need for capability analysis

3. Differentiate between ANOVA and ANOM techniques

4. Compare and contrast run charts to control charts

5. Implement capability analysis ratios using Excel and Minitab

6. Explain the notion of benchmarking quality

7. Create funnel charts using Excel and Python

8. Conduct ANOM using Minitab

9. Develop run charts using Excel, Python, and Minitab

10. Interpret the significance of the results from the tools discussed in this chapter

202



Chapter 5. Tools related to control charts 203

5.1 Introduction

In this last chapter, we review a few of the methods related to control charts. We be-
gin with a discussion about capability analysis to help answer the question of whether
our process is capable of meeting the customer’s specification limits. Next, we consider
benchmarking techniques that we can employ to compare quality outcomes among sev-
eral health care providers. One of these techniques that we discuss is funnel charts that
we create using a quality target and control limits. Another benchmarking technique that
we consider is ANOM. We can use this tool to compare mean statistics in a process us-
ing a centerline and decision limits. The last topic we consider relates to run charts. We
create such charts using only a centerline and then attempt to deduce out-of-control be-
haviors using run statistics and visual inspections of non-random behaviors. We typically
implement the methods that we discuss here during the Analyze and Improve phases of
DMAIC1.

5.2 Process capability analysis

During quality improvement efforts, we conduct capability analysis to help answer the
question of whether our process is capable of meeting the customer’s specification limits
or standards. For example, in health care, we want to know whether our process can meet
various guidelines from regulating and accrediting agencies. An important pre-requisite
to capability analysis is the stability of the process.

Definition 5.1 Capability analysis is a technique that involves measuring the uni-
formity of the process, given the specification limits and variability in the process
[44].

Several techniques for conducting capability analysis exist. Here, we emphasize the
use of graphical techniques such as histograms and process capability ratios (PCRs) like
𝐶𝑝.

5.2.1 The 𝐶𝑝 ratio

Given the customer’s upper specification limit (USL) and lower specification limit (LSL),
we utilize the 𝐶𝑝 ratio to measure the potential capability of a process. We formulate this
ratio as follows:

𝐶𝑝 =
𝑈𝑆𝐿−𝐿𝑆𝐿

6𝜎
(5.1)

where 𝜎 represents the process variability in standard deviation units. We obtain 6𝜎
from the sum of 3𝜎 below the mean 𝜇 and 3𝜎 above the mean. We recall that 99.73% of
the normally distributed process falls within 𝜇 ± 3𝜎 . Since 𝜇 is not part of the formula in

1DMAIC: Define, Measure, Analyze, Improve, and Control
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Equation 5.1, we cannot conclude anything about the process mean using the 𝐶𝑝 ratio.
To make such a conclusion, we apply other PCRs such as 𝐶𝑝𝑢, 𝐶𝑝𝑙 , and 𝐶𝑝𝑘.

5.2.2 The 𝐶𝑝𝑢, 𝐶𝑝𝑙, and 𝐶𝑝𝑘 ratios

Like the 𝐶𝑝 ratio, the 𝐶𝑝𝑢, 𝐶𝑝𝑙 , and 𝐶𝑝𝑘 ratios also allow us to measure the capability of
the process. But unlike the 𝐶𝑝 ratio, these new ratios account for the process mean 𝜇.

1. The 𝐶𝑝𝑢 ratio, formulated as

𝐶𝑝𝑢 =
𝑈𝑆𝐿−𝜇

3𝜎
, (5.2)

measures the process capability of satisfying the USL given the mean 𝜇 and 3𝜎 .

2. The 𝐶𝑝𝑙 ratio, formulated as

𝐶𝑝𝑙 =
𝜇−𝐿𝑆𝐿

3𝜎
, (5.3)

measures the process capability of meeting the LSL given the mean 𝜇 and 3𝜎 .

3. The 𝐶𝑝𝑘 ratio, computed as

𝐶𝑝𝑘 =min
(︁
𝐶𝑝𝑢 ,𝐶𝑝𝑙

)︁
, (5.4)

measures the actual capability of the process. Here, min() symbolizes the mini-
mum function.

When 𝐶𝑝𝑘 = 𝐶𝑝, we deduce that the process mean 𝜇 is about centered between 𝑈𝑆𝐿
and 𝐿𝐶𝐿. When 𝐶𝑝𝑘 < 𝐶𝑝, the process is off-center. For cases of 𝐶𝑝𝑘 < 0, the process is
completely outside of the specification limits.

5.2.3 Implementing PCRs

Before we can implement PCRs, we must be given the process standard deviation 𝜎 or
be able to estimate this statistic from the process sample. We also may need to know the
process mean 𝜇. We can estimate both of these parameters, as previously discussed in
Chapter 1.

Interpretation

In general, any PCR greater than 1 implies that the process is capable of meeting the
given standard. Otherwise, to improve the capability measure of interest, we must de-
crease the variability in the process given by 𝜎 . For an existing process, it is recom-
mended that a PCR measure be at least 1.33 in a two-sided measure or 1.25 in a one-
sided measure. For a new process, the recommended PCR values are 1.50 for a two-
sided measure and 1.45 for a one-sided measure. In a two-sided, centered, and normally
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distributed process, a 𝐶𝑝 of 0.25 implies 453,255 ppm2, a 𝐶𝑝 of 1 implies 2,700 ppm, and
a 𝐶𝑝 of 2 signifies about 0.0018 ppm [44]. Another practical interpretation of the 𝐶𝑝 ratio
follows from:

𝑃 =
(︃
1
𝐶𝑝

)︃
(5.5)

where 𝑃 is the percentage of the specification bandwidth being used by the process.

1. If 𝑃 ≤ 1: the process is capable of meeting the specification limits.

2. If 𝑃 > 1: the process is using more than the allowed bandwidth and is therefore not
capable of meeting the specification limits.

Besides measuring the process capability, the 𝐶𝑝 ratio can also be utilized to evaluate
the acceptability of the 𝑔𝑎𝑢𝑔𝑒 instrument [44].

Remark: When a process is not in control, performance indices like 𝑃𝑝, 𝑃𝑝𝑢 , 𝑃𝑝𝑙 , and 𝑃𝑝𝑘 are
sometimes used to measure the capability. These indices are essentially similar to the PCRs
discussed earlier except that 𝜎 is replaced with the process standard deviation 𝑠. These ratios
should be applied with caution, or not be used at all, due to possible misleading conclusions that
may result when the process is not stable [44].

How-To 5.1 (PCRs in Minitab 18) Click on Stat > Quality Tools > Capability Analysis
> Normal > upload your data. See the snapshot in Figure 5.2. You can change the
distribution as necessary.

Figure 5.1: Capability analysis options in Minitab 18

For additional graphical results, click on Stat > Quality Tools > Capability Sixpack

2ppm: defective parts per million
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> select the appropriate distribution > upload your data > OK. To change the 𝜎
estimation method, click on Estimate > Select the preferred technique (see the
snapshot in Figure 5.2)

Figure 5.2: 𝜎 estimation options in Minitab 18

Table 5.1: Processing times of inpatient records at Metro City Hospital in 2018

Sample 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5 Sample 𝑥1 𝑥2 𝑥3 𝑥4 𝑥5

1 32 25 23 37 30 21 27 23 33 24 32
2 37 31 35 36 33 22 31 33 37 30 32
3 37 27 30 33 26 23 30 36 31 26 25
4 36 32 27 21 31 24 36 28 30 26 30
5 34 40 40 26 30 25 23 22 28 17 32
6 32 33 38 30 29 26 30 26 37 32 23
7 20 35 34 28 22 27 32 30 31 28 34
8 35 21 35 33 25 28 29 36 30 25 27
9 36 29 41 27 26 29 27 32 27 32 30
10 33 27 35 31 20 30 29 24 23 26 29
11 30 29 33 24 31 31 28 30 25 27 31
12 31 27 27 32 35 32 31 31 28 30 31
13 26 24 38 32 25 33 24 26 37 30 35
14 37 26 21 41 31 34 26 31 30 25 28
15 33 24 31 33 29 35 28 26 25 38 26
16 26 30 35 32 22 36 30 29 30 30 28
17 29 37 34 34 24 37 32 33 28 25 35
18 33 34 25 33 31 38 21 38 32 30 30
19 26 30 29 26 41 39 35 27 31 34 37
20 33 24 33 32 35 40 33 45 23 28 39
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Example 5.1 (Capability analysis)
For the past 40 days, the medical coding manager at Metro City Hospital has been
sampling five inpatient records daily (𝑥1, . . . ,𝑥5) to track the processing times in
minutes (mins). The manager would like to test the process capability to meet the
rate of USL = 45 minutes and LSL = 15 minutes. The process is statistically stable.
Table 5.1 shows the data collected so far.
To help the manager analyze the capability of this process, we start by estimating
parameters 𝜎 and 𝜇. We approximate 𝜇 using ¯̄𝑥, which is the average of all sample
averages. To approximate 𝜎 , we utilize Equation 1.20 since 𝑛 ≤ 10. Using Excel,
we obtain the range by 𝑀𝐴𝑋(𝑠𝑎𝑚𝑝𝑙𝑒)−𝑀𝐼𝑁 (𝑠𝑎𝑚𝑝𝑙𝑒). We calculate the average
of each sample using the 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝑠𝑎𝑚𝑝𝑙𝑒) function. We illustrate the setup of
our spreadsheet in Figure 5.3.

Figure 5.3: A spreadsheet setup for calculating the ranges and averages of the
data in Table 5.1

.
A B C D E F G H

1 Sample x1 x2 x3 x4 x5 Range Mean

2 1 32 25 23 37 30 14 29.4

3 2 37 31 35 36 33 6 34.4

4 3 37 27 30 33 26 11 30.6

… … … … … … … …

40 39 35 27 31 34 37 10 32.8

41 40 33 45 23 28 39 22 33.6

11.15 30.115

About Figure 5.3, we obtained the range of sample 1 by = 𝑀𝐴𝑋(𝐵2 : 𝐹2) −
𝑀𝐼𝑁 (𝐵2 : 𝐹2) = 14. We obtained the average of sample 1 by = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐵2 :
𝐹2) = 29.4. We applied the same formulas to other samples. In the end, we cal-
culated 𝑅̄ using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐺2 : 𝐺41) = 11.15 and ¯̄𝑥 using = 𝐴𝑉𝐸𝑅𝐴𝐺𝐸(𝐻2 :
𝐻41) = 30.115. To approximate 𝜎 , we proceeded as follows:

𝜎 ≈ 𝜎 =
𝑅̄
𝑑2

=
11.15
2.326

= 4.80 (5.6)

We obtained the value of 𝑑2 = 2.326 from Appendix Table 12 when 𝑛 = 5. We
proceeded to calculate the PCRs of interest as follows:

𝐶𝑝 =
𝑈𝑆𝐿−𝐿𝑆𝐿

6𝜎
=
45− 15
6(4.80)

= 1.043 (5.7)

𝐶𝑝𝑢 =
𝑈𝑆𝐿−𝜇

3𝜎
=
45− 30.115
3(4.80)

= 1.035 (5.8)

𝐶𝑝𝑙 =
𝜇−𝐿𝑆𝐿

3𝜎
=
30.115− 15
3(4.80)

= 1.051 (5.9)

𝐶𝑝𝑘 = min
(︁
𝐶𝑝𝑢 ,𝐶𝑝𝑙

)︁
=min(1.035,1.051) = 1.035 (5.10)
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Given that all ratios are greater than 1, the process is capable. Furthermore, we
can deduce that the process mean is about centered between USL and LSL, since
𝐶𝑝 ≈ 𝐶𝑝𝑘. We estimate the amount of the bandwidth that the process is utilizing
this way:

𝑃 =
(︃
1
𝐶𝑝

)︃
100 =

(︂ 1
1.043

)︂
100 = 96%. (5.11)

The 96% utilization rate of the allowed bandwidth is not desirable since it leaves
little to no room for error. To improve the capability, the process variability must
be decreased. Figure 5.4 portrays a Minitab capability report. The histogram in
this figure confirms that the process is about centered, but is using almost all of
the allowed bandwidth between LSL and USL. The Capability Plot substantiates
this claim. The intervals in this plot portray different estimations of the spread in
the process. The within interval follows from the unbiased estimation of 𝜎 using
sample data.
Figure 5.5 depicts additional Minitab results related to the sixpack report. The Xbar
and R charts in Figure 5.5 indicate that the process is stable since points move
randomly around the centerline, and no point falls outside of the control limits. The
Last 25 Subgroups chart validates the conclusion about the random behavior of
the sample mean since no clear pattern is discernible. But, we do notice that sam-
ple 40 seems to show more variability than other points. The Normal Probability
Plot portrays points falling alongside the fitted line, an indication that the process is
about normally distributed.

Figure 5.4: Process capability report in Minitab 18 based on the data in Table 5.1
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Figure 5.5: Process capability sixpack report in Minitab 18 based on the data in
Table 5.1

5.3 Benchmarking quality

In this section, we discuss how to benchmark quality from multiple health care organi-
zations using tools that utilize the concept of control charts. Specifically, we consider
funnel charts and analysis of means (ANOM). We briefly also review the concepts of
the analysis of variance (ANOVA) to demonstrate the difference between this test and the
ANOM tool.

5.3.1 Funnel charts

Like control charts, funnel charts are constructed using control limits and a centerline. A
typical funnel chart tends to look like a 𝑝 chart and is structured as follows [53]:

𝑈𝐶𝐿 = 𝑝+𝐿

√︃
𝑝(1− 𝑝)

𝑛𝑖
(5.12)

𝐶𝐿 = 𝑝 (5.13)

𝐿𝐶𝐿 = 𝑝 −𝐿

√︃
𝑝(1− 𝑝)

𝑛𝑖
(5.14)
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Here, 𝑝 is the target, 𝐿 is the number of standard deviations away from the centerline,
commonly chosen to create a 95% or 99.8% confidence interval [65]. The notation of 𝑛𝑖
signifies the sample size of organization 𝑖, for 𝑖 : 1,2, . . . , 𝑘, where 𝑘 is the total number of
organizations being compared. The acronyms UCL, CL, and LCL, stand for upper control
limit, centerline, and lower control limit respectively. If a point falls outside of a particular
limit, we conclude that the deviation of the corresponding sample number, away from the
target or the grand mean, is statistically significant. The only difference between a funnel
chart and a 𝑝 chart is that in the former, we have to sort samples in ascending order, a
practice that we do not adhere to in the latter. Review Chapter 2 about how to create 𝑝
charts.

5.3.2 ANOM

ANOM, not to be confused with ANOVA (see Subsection 5.3.3), is a statistical technique
that we can employ to benchmark quality from several health care organizations. The
main difference between ANOVA and ANOM is that the former compares the equality of
means, whereas the latter compares each mean to the overall mean. Just like in funnel
charts, the formulas for ANOM charts often look like those of a p-chart [53]. In Minitab
18, the formulas for the binomial ANOM chart look like this [1]:

𝑈𝐷𝐿 = 𝑝+𝐿

√︂
𝑝(1− 𝑝)

𝑛
*
√︂

𝑘 − 1
𝑘

(5.15)

𝐿𝐷𝐿 = 𝑝 −𝐿
√︂

𝑝(1− 𝑝)
𝑛

*
√︂

𝑘 − 1
𝑘

(5.16)

Here, 𝑈𝐷𝐿 stands for upper decision limit and 𝐿𝐷𝐿 means lower decision limit. The
notation of 𝑛 symbolizes a constant sample size, and 𝑘 represents the number of orga-
nizations in the study. As before, 𝐿 represents the number of standard deviations away
from the centerline 𝑝. Minitab 18 determines 𝐿 as follows:

𝐿 = Φ−1(1−𝛼/(2 * 𝑘)) (5.17)

where * symbol characterizes multiplication and Φ(.) is the cumulative density function
of a standard normal. As before, 𝛼 is the given significance level. As in funnel charts,
if a point falls outside of a particular limit, we conclude that the corresponding sample is
statistically different from the target or the grand mean.

How-To 5.2 (Python 3.6)

Script 5.1: A script for creating funnel charts using Python 3.6

#FUNNEL CHARTS

#import modules

from pandas import*
from pylab import*
from numpy import*
import seaborn as sns
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#import data from Excel where columns are named: ID, Discharges, and

Readmits. Discharges are considered the sample size.

data = read_excel(your directory)

#Initialize parameters

data[’xt’] = data.Readmits/data.Discharges

data = data.sort_values(by=’Discharges’)

data = data.reset_index()

nbar = mean(data.Discharges)

xr = data.xt

CL = [pbar]*(len(xr))

t = arange(len(xr) )

#L = 3

pbar = 1.*data.Readmits.sum()/ data.Discharges.sum()

UCL2 = [pbar + 3.*sqrt(pbar*(1.-pbar)/data.Discharges[i]) for i in

range(len(xr))]

LCL2 = [pbar - 3.*sqrt(pbar*(1.-pbar)/data.Discharges[i]) for i in

range(len(xr))]

#L =2

UCL1 = [pbar + 2.*sqrt(pbar*(1.-pbar)/data.Discharges[i]) for i in

range(len(xr))]

LCL1 = [pbar - 2.*sqrt(pbar*(1.-pbar)/data.Discharges[i]) for i in

range(len(xr))]

#mark red the point that falls outside of the outer control limits.

Otherwise, mark the point blue.

#mark black the point that falls outside of the inner control limits.

Otherwise, mark the point blue.

markers = []

colors = []

for i in range (len(xr)):

x1 = xr[i]

if (x1 > UCL2[i] or x1 < LCL2[i]):

markers.append(’o’)

colors.append(’r’)

else:

markers.append(’o’)

colors.append(’b’)

colors = array(colors)

for i in range (len(xr)):

x1 = xr[i]

if (x1 > UCL1[i] and x1 < UCL2[i]):

colors[i]=’k’

if (x1 < LCL1[i] and x1 > LCL2[i]):

colors[i]=’k’

#Plotting the funnel chart

fig=figure()

ax1 = fig.add_subplot(111)

ax1.plot(t, UCL2, ’k-’, alpha = 0.5)

ax1.plot(t, LCL2, ’k-’,alpha = 0.5)

ax1.plot(t, UCL1, ’k-’, alpha = 0.5)

ax1.plot(t, LCL1, ’k-’,alpha = 0.5)

ax1.plot(CL, ’k-’,alpha = 0.5)

ax1.plot(xr,’b-’,zorder=1)

for x,y,c,m in zip(t, xr, colors, markers):
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ax1.scatter(x,y,c=c, marker=m, s =45, alpha = 1.,zorder=2)

xlim(-0.5, t[-1]+1)

sns.color_palette("Blues")

sns.despine(offset=10, trim=False)

#label y-axis and x-axis

ax1.set_xlabel(’Hospital ID sorted by Sample Size’)

ax1.set_ylabel(’Fraction nonconforming’)

#annotate the values of UCL, LCL, and CL

ax1.annotate (’$UCL2=$’+str(round(UCL2[0],3)), xy = (xlim()[1], list(

UCL2)[-1]), xytext = (xlim()[1],list(UCL2)[-1]),fontsize = 11)

ax1.annotate (’$\overline{P}=$’+str(round(CL[0],3)), xy = (xlim()[1],

list(CL)[-1]), xytext = (xlim()[1],list(CL)[-1]),fontsize = 11)

ax1.annotate (’$LCL2=$’+str(round(LCL2[0],3)), xy = (xlim()[1], list(

LCL2)[-1]), xytext = (xlim()[1],list(LCL2)[-1]),fontsize = 11)

ax1.annotate (’$UCL1=$’+str(round(UCL1[0],3)), xy = (xlim()[1], list(

UCL1)[-1]), xytext = (xlim()[1],list(UCL1)[-1]),fontsize = 11)

ax1.annotate (’$LCL1=$’+str(round(LCL1[0],3)), xy = (xlim()[1], list(

LCL1)[-1]), xytext = (xlim()[1],list(LCL1)[-1]),fontsize = 11)

#set xticks to reflect hospital IDs sorted by sample size

xticks(arange(len(data), step = 1), data.ID)

show()

How-To 5.3 (Funnel charts in Excel 2013)
Excel does not have built-in options for creating either ANOM or funnel charts, but
we can manually program the respective formulas as we demonstrate how to create
funnel charts in Example 5.2.

Example 5.2 (A funnel chart in Excel 2013 and Python 3.6)
The league table given in Table 5.2 depicts the ranking of 20 hospitals in Central
City, regarding the rates of pneumonia patients readmitted within 30 days of dis-
charge. The lower the rate, the better. The average readmission rate is 13.7%.
Hospitals that are above this average are marked in red. Table 5.3 demonstrates
the setup of an Excel spreadsheet for creating a funnel chart based on the data in
Table 5.2. In this setup, 𝐼𝐷 denotes the hospital ID column, 𝑛𝑖 symbolizes the col-
umn of Pneumonia Discharges or sample size, 𝑥𝑖 represents the column of Readmit
with 30 days, and 𝑥𝑖/𝑛𝑖 represents to the 𝑅𝑎𝑡𝑒 column. We calculated the average
rate using 𝑝 =

∑︀𝑘
𝑖=1𝑥𝑖/𝑛𝑖 , where 𝑘 is the total number of hospitals. Before plotting

the funnel chart, we sorted Table 5.3 by the sample size 𝑛𝑖 . We applied Equations
5.12 - 5.14 to create inner control limits (𝐿𝐶𝐿1 and 𝑈𝐶𝐿1 using 𝐿 = 2) and outer
control limits (𝐿𝐶𝐿2 and 𝑈𝐶𝐿2 using 𝐿 = 3). For example, we obtained the value
of 𝐿𝐶𝐿1 in cell 𝐸2 using = 𝐼2− 2 * 𝑆𝑄𝑅𝑇 (𝐼2 * (1− 𝐼2)/𝐵2) and the value of 𝑈𝐶𝐿2
in cell 𝐻2 using = 𝐼2 + 3 * 𝑆𝑄𝑅𝑇 (𝐼2 * (1− 𝐼2)/𝐵2). From Table 5.3, we can create
a funnel chart by inserting line charts of columns D to I. The resulting chart would
look like Figure 5.6 that we plotted using the Python script in How-To 5.2. From
this chart, we see that hospitals with IDs 3, 8, and 9 fail 𝑈𝐶𝐿2. Also, we see that
hospitals with IDs 7, 13, 17, and 18 fail 𝐿𝐶𝐿1.
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Figure 5.6: A funnel chart based on the data in Table 5.2
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Table 5.2: Pneumonia patients readmitted within 30 days of discharge in Central
City, 2018

Hospital ID Pneumonia Discharges Readmit with 30 days Rate Rank

13 80 2 2.5% 1

17 68 2 2.9% 2

18 98 4 4.1% 3

7 71 3 4.2% 4

19 90 6 6.7% 5

5 26 2 7.7% 6

16 76 7 9.2% 7

14 96 9 9.4% 8

4 43 5 11.6% 9

11 73 9 12.3% 10

15 128 19 14.8% 11

12 46 7 15.2% 12

6 96 15 15.6% 13

20 84 14 16.7% 14

10 118 20 16.9% 15

2 78 16 20.5% 16

1 32 8 25.0% 18

3 59 17 28.8% 17

8 88 28 31.8% 19

9 28 10 35.7% 20
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Table 5.3: A setup of an Excel spreadsheet for creating a funnel chart based on
the data in Table 5.2

A B C D E F G H I

1 𝐼𝐷 𝑛𝑖 𝑥𝑖 𝑥𝑖/𝑛𝑖 𝐿𝐶𝐿1 𝑈𝐶𝐿1 𝐿𝐶𝐿2 𝑈𝐶𝐿2 𝑝

2 5 26 2 7.7% 0.2% 27.2% -6.5% 34.0% 13.7%

3 9 28 10 35.7% 0.7% 26.7% -5.8% 33.2% 13.7%

4 1 32 8 25.0% 1.6% 25.9% -4.5% 32.0% 13.7%

5 4 43 5 11.6% 3.2% 24.2% -2.0% 29.5% 13.7%

6 12 46 7 15.2% 3.6% 23.9% -1.5% 29.0% 13.7%

7 3 59 17 28.8% 4.8% 22.7% 0.3% 27.2% 13.7%

8 17 68 2 2.9% 5.4% 22.1% 1.2% 26.3% 13.7%

9 7 71 3 4.2% 5.6% 21.9% 1.5% 26.0% 13.7%

10 11 73 9 12.3% 5.7% 21.8% 1.6% 25.8% 13.7%

11 16 76 7 9.2% 5.8% 21.6% 1.9% 25.6% 13.7%

12 2 78 16 20.5% 5.9% 21.5% 2.0% 25.4% 13.7%

13 13 80 2 2.5% 6.0% 21.4% 2.2% 25.3% 13.7%

14 20 84 14 16.7% 6.2% 21.2% 2.5% 25.0% 13.7%

15 8 88 28 31.8% 6.4% 21.1% 2.7% 24.7% 13.7%

16 19 90 6 6.7% 6.5% 21.0% 2.8% 24.6% 13.7%

17 14 96 9 9.4% 6.7% 20.8% 3.2% 24.3% 13.7%

18 6 96 15 15.6% 6.7% 20.8% 3.2% 24.3% 13.7%

19 18 98 4 4.1% 6.8% 20.7% 3.3% 24.2% 13.7%

20 10 118 20 16.9% 7.4% 20.1% 4.2% 23.2% 13.7%

21 15 128 19 14.8% 7.6% 19.8% 4.6% 22.9% 13.7%

In contrast to the hospital ranking in Table 5.2 where ten hospitals may be con-
sidered deficient since they are above the average, the funnel chart indicates that
only a few hospitals fail the control limits at 99.73% confidence interval. In typical
applications, the negative part of the funnel limits is set to zero; we plotted it here
only to demonstrate the funnel shape from which the name funnel chart is derived.

5.3.3 ANOVA

ANOVA is a powerful statistical test that we use to examine the equality of the means
in more than two independent samples. We assume that the samples are normally dis-
tributed with equal variances. The two types of ANOVA test that we consider here are
one-way ANOVA and two-way ANOVA. In both cases, we work with the sum of squares
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(𝑆𝑆) to formulate the statistical tests of interest.

One-way ANOVA

In a one-way ANOVA test, we obtain the total sum of squares (𝑆𝑆𝑡𝑜𝑡𝑎𝑙) in the data as
follows:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (5.18)

The word 𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 is used to denote independent samples. The 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 term
represents the between samples variation, whereas the 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 term symbolizes the
within samples variation. Let’s assume that we have 𝑎 number of samples, each with
size 𝑛. We determine the corresponding sum of squares as follows:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 =
𝑎∑︁

𝑖=1

𝑛∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦..)2 (5.19)

𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = 𝑛
𝑎∑︁

𝑖=1

(𝑦𝑖. − 𝑦..)2 (5.20)

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑎∑︁

𝑖=1

𝑛∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦𝑗.)2 (5.21)

where 𝑦𝑖𝑗 is the entry in row 𝑖 and column 𝑗, 𝑦.. is the overall mean of the data, 𝑦𝑖. is the
mean of row 𝑖, and 𝑦𝑗. is the mean of column 𝑗. The degrees of freedom (𝑑𝑓 ) are given
by:

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑎𝑛− 1 (5.22)
𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = 𝑎− 1 (5.23)

𝑑𝑓𝑒𝑟𝑟𝑜𝑟 = 𝑎(𝑛− 1) (5.24)

It follows that:

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑑𝑓𝑒𝑟𝑟𝑜𝑟 (5.25)

Using the sum of squares and the degrees of freedom, we obtain the mean squares (𝑀𝑆)
this way:

𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 =
𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠
(5.26)

𝑀𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑑𝑓𝑒𝑟𝑟𝑜𝑟

(5.27)

The 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 term estimates the variance in treatments. The 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 term is the
unbiased estimator of the variance of the model residuals in Equation 5.18 [44]. We use
the ratio between 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 and 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 to obtain the following F-test statistic:

𝐹0 =
𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑒𝑟𝑟𝑜𝑟
(5.28)
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A one-tailed critical value is given by:

𝐹𝛼, 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠, 𝑑𝑓𝑒𝑟𝑟𝑜𝑟 ≡ 𝐹𝛼, 𝑎−1, 𝑎(𝑛−1) (5.29)

At the significance level 𝛼, we reject the null hypothesis when 𝐹0 > 𝐹𝛼, 𝑎−1, 𝑎(𝑛−1). Our
conclusion implies that at least one mean is different. The ANOVA test does not identify
the different mean in question.

Two-way ANOVA

In a two-way ANOVA test, we add a blocking variable 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 and 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 becomes:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (5.30)

The 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 term represents different blocks or conditions under which the sample
data were collected. If data were arranged in a table format, we could view treatments
as independent rows and blocks as independent columns. Given 𝑎 number of treatments
and 𝑏 number of blocks, we formulate the sum of squares of a two-way ANOVA this way:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 =
𝑎∑︁

𝑖=1

𝑏∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦..)2 (5.31)

𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = 𝑏
𝑎∑︁

𝑖=1

(𝑦𝑖. − 𝑦..)2 (5.32)

𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 = 𝑎
𝑏∑︁

𝑖=1

(𝑦.𝑗 − 𝑦..)2 (5.33)

𝑆𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑎∑︁

𝑖=1

𝑏∑︁
𝑗=1

(𝑦𝑖𝑗 − 𝑦𝑖. − 𝑦.𝑗 + 𝑦..)
2 (5.34)

≡ 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 − 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 − 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 (5.35)

As earlier, we can view 𝑦𝑖𝑗 as the entry in row 𝑖 and column 𝑗, 𝑦.. is the overall mean
of the data, 𝑦𝑖. is the mean of row 𝑖, and 𝑦𝑗. is the mean of column or block 𝑗. To obtain
the degrees of freedom (𝑑𝑓 ), we proceed as follows:

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑎𝑏 − 1 (5.36)
𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 = (𝑎− 1) (5.37)
𝑑𝑓𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 = (𝑏 − 1) (5.38)

𝑑𝑓𝑒𝑟𝑟𝑜𝑟 = (𝑎− 1)(𝑏 − 1) (5.39)

where

𝑑𝑓𝑡𝑜𝑡𝑎𝑙 = 𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑑𝑓𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 + 𝑑𝑓𝑒𝑟𝑟𝑜𝑟 (5.40)

We summarize the two-way mean squares and the corresponding 𝐹0 statistics in Table
5.4.
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Table 5.4: Mean Squares and the 𝐹0 statistics of a two-way ANOVA test

Source of variation Mean Square 𝐹0

Treatments 𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑒𝑚𝑒𝑛𝑡𝑠 =
𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑑𝑓𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠

𝑀𝑆𝑒𝑟𝑟𝑜𝑟

Blocks 𝑀𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 =
𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔
𝑑𝑓𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔

𝑀𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔
𝑀𝑆𝑒𝑟𝑟𝑜𝑟

Error 𝑀𝑆𝑒𝑟𝑟𝑜𝑟 =
𝑆𝑆𝑒𝑟𝑟𝑜𝑟
𝑑𝑓𝑒𝑟𝑟𝑜𝑟

Just like in a one-way ANOVA test, we draw conclusions about our hypothesis by
comparing the 𝐹0 statistic to the critical value. We could also use p-values to interpret
the significance of the test.

In some applications such as in designed experiments and gauge analysis, we can
further decompose 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 to include the term representing the interaction between
treatments and the blocking variables. With this new component, 𝑆𝑆𝑡𝑜𝑡𝑎𝑙 becomes:

𝑆𝑆𝑡𝑜𝑡𝑎𝑙 = 𝑆𝑆𝑡𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡𝑠 + 𝑆𝑆𝑏𝑙𝑜𝑐𝑘𝑖𝑛𝑔 + 𝑆𝑆𝑖𝑛𝑡𝑒𝑟𝑎𝑐𝑡𝑖𝑜𝑛 + 𝑆𝑆𝑒𝑟𝑟𝑜𝑟 (5.41)

From the model in Equation 5.41, the degrees of freedom of the interaction term are given
by (𝑎−1)(𝑏−1). We obtain the test statistic by taking the ratio between 𝑀𝑆𝑖𝑛𝑡𝑒𝑟𝑎𝑐𝑡𝑖𝑜𝑛 and
𝑀𝑆𝑒𝑟𝑟𝑜𝑟 . The conclusion about the null hypothesis would be as before.

5.4 Run charts

5.4.1 A general concept

Run charts are like control charts but without limits. Moreover, the centerline in the run
charts is typically the median of the data, not the mean. While, whenever possible, we
should utilize control charts to monitor processes, using run charts has its advantages
such as the simpler setup. Also, in run charts, we do not have to assume any particular
probability distribution, meaning that we could use these tools to monitor any process.
The major downside of run charts is that the interpretation requires a bit more effort
since there is no easy way to tell that a particular sample is out-of-control. Figure 5.7
portrays an example of a run chart that relates to the control chart in Figure 1.18.

From the control chart in Figure 1.18 , we have previously concluded that there were
two areas of special cause variation due to a point falling outside of LCL and a violation of
one of the sensitizing rules since 2 out of 3 consecutive points were between the second
and third standard deviation limits on the same side. Now the question at hand is that
since there are no limits in the run chart in Figure 5.7, how do we go about detecting
out-of-control behaviors?
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Figure 5.7: An example of a run chart based on the chart in Figure 1.17
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5.4.2 Interpreting run charts

We detect out-of-control behaviors in run charts by finding instances of non-randomness
in the process. We utilize two techniques to accomplish this task: visual examination
and statistical run tests.

Visual examination

We can use a visual examination to detect special cause variation in run charts by apply-
ing the following rules [50]:

1. Seven or more points on the same side of the median signify a likely shift in the
process.

2. Seven or more points that are either increasing or decreasing indicate a trend in
the process.

We can also visually detect other likely special causes, such as a cluster of points and
zig-zag or oscillation behaviors. To test the significance of these out-of-control behav-
iors, we apply statistical run tests.

Run tests

We conduct statistical run tests to determine the significance of non-randomness in the
process. Our null hypothesis is that the sequence of the process measurements is ran-
dom. Run tests work for both the metric and non-metric data. For our purposes, a
sequence of groups of data points that are above (run-ups +) or below (run-downs -)
the centerline constitute non-metric data. In contrast, a sequence of successive numeri-
cal differences in the process constitutes metric data. We define the term run as follows:

Definition 5.2 (Run) A run is a sequence of identical signs (+ or −) until a different
sign occurs or the series terminates [63].
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To construct a run test, we assume that there are 𝑅 total number of runs in the data,
given by:

𝑅 = 𝑦1 + 𝑦2 (5.42)

where 𝑦1 is the number of run-ups and 𝑦2 is the number of run-downs. We use 𝑛1 to
symbolize the total count of points in the set 𝑦1 and 𝑛2 to denote the total count of points
in the set 𝑦2. We calculate 𝑝(𝑦1, 𝑦2), the probability of obtaining exactly 𝑦1 runs and 𝑦2
runs this way [65]:

𝑝(𝑦1, 𝑦2) =

(︀𝑛1−1
𝑦1−1

)︀(︀𝑛2−1
𝑦2−1

)︀(︀𝑛1+𝑛2
𝑛1

)︀ (5.43)

We obtain the probability of 𝑅 being less or equal to some value 𝑘, that is 𝑝(𝑅 ≤ 𝑘)
by adding together the probabilities of different combinations of 𝑦1 and 𝑦2 that produce
𝑦1 + 𝑦2 ≤ 𝑘. We use 𝑝(𝑅 ≤ 𝑘) to establish the confidence interval for 𝑅. If 𝑅 falls outside
of our interval, we reject the null hypothesis, which implies that out-of-control behaviors
exist. For small sample sizes of 𝑛1 and 𝑛2, we can establish the confidence interval of 𝑅
by consulting reference tables of run statistics that are often found in standard statistical
textbooks (e.g., see Wackerly et al. (2007)[63]). As 𝑛1 and 𝑛2 get larger (e.g., when
both 𝑛1 and 𝑛2 are greater than 10), we assume a normal distribution and establish the
confidence interval as follows [63]:

𝐸(𝑅)− |𝑍 |
√︀
𝑉 (𝑅) ≤ 𝑅 ≤ 𝐸(𝑅) + |𝑍 |

√︀
𝑉 (𝑅) (5.44)

where 𝑍 is a standard value given by:

𝑍 =
𝑅−𝐸(𝑅)√︀

𝑉 (𝑅)
(5.45)

Here, 𝐸(𝑅) symbolizes the expectation of runs, and 𝑉 (𝑅) represents the variance of runs.
When the process generates non-metric data, we obtain 𝐸(𝑅) and 𝑉 (𝑅) this way [65]:

𝐸(𝑅) =
2𝑛1𝑛2

𝑛
+1 (5.46)

𝑉 (𝑅) =
2𝑛1𝑛2(2𝑛1𝑛2 −𝑛)

(𝑛− 1)𝑛2
(5.47)

where 𝑛 is the total number of observations given. For metric data, we approximate 𝐸(𝑅)
and 𝑉 (𝑅) as follows [65]:

𝐸(𝑅) ≈ 2𝑛− 1
3

(5.48)

𝑉 (𝑅) ≈ 16𝑛− 29
90

(5.49)
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Interpretation

When 𝑅 < 𝐸(𝑅)−|𝑍 |
√︀
𝑉 (𝑅), we have too few runs, whereas 𝑅 > 𝐸(𝑅)+|𝑍 |

√︀
𝑉 (𝑅) implies

that we have too many runs. In general, having too many or too few runs is indicative
of non-randomness in the process data [63]. In non-metric data, having too few runs
signals the tendency of the data to cluster above or below the centerline. The result of
too many runs implies zig-zag behaviors, which may mean a mixture of two processes.
It follows that [43]:

(p-value for mixtures) + (p-value for clustering) = 1 (5.50)

For metric data, having too few runs implies the tendency of the data to form trends
above or below the centerline. Having too many runs suggests that oscillation behav-
iors exist in the process. It is given that [43]:

(p-value for trends) + (p-value for oscillation) = 1 (5.51)

How-To 5.4 (Run charts in Minitab 18)
Click on Stat > Quality Tools> Run Chart > check the single column radio option >
select your data > Input the subgroup size > Plot subgroup medians > OK.

Figure 5.8: The options for run charts in Minitab 18

How-To 5.5 (Python 3.6)

Script 5.2: A script for calculating run statistics in Python 3.6

#RUN Statistics

#Import modules

from pandas import *
import numpy as np
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from scipy.stats import norm

#import data using Pandas. The spreadsheet has a column named "Run"

to represent the data to be monitored.

data = read_excel(your directory)

#initialize parameters

lenData = len(data.Run)

alpha = 0.05#significance level

Z = norm.ppf(alpha)

#count runs from running differences

signs = [0]

for i in range(1, lenData ):

s = np.sign(data.Run[i]-data.Run[i-1])

if s>0:

signs.append(1)

else:

signs.append(-1)

runs = array([1. for i in range(1, lenData ) if signs[i] !=signs[i

-1]])

rundown = array([1. for i in signs if i==-1])

runup= array([1. for i in signs if i==1])

R = runs.sum()

R1 = rundown.sum()

R2 = runup.sum()

n1 = len(rundown)

n2 = len(runup)

n = lenData

ER = (2.*n - 1.)/3.

VR = (16.*n - 29.)/90.

lower = ER-Z*sqrt(VR)

upper = ER+Z*sqrt(VR)

Z0 = (R - ER)/sqrt(VR)

p_value_trend= norm.cdf(Z0)

p_value_oscillation = 1.- p_value_trend

print (’------------------------------------------------------’)

#print run statistics

if p_value_trend < alpha:

if R<lower:

print (’Reject the null hypothesis for trends. There are too

few runs.’)

print (’The p-value for trends is %s’%round(p_value_trend ,3))

print (’The p-value for oscillation is %s’%round(1.-

p_value_trend ,3))

print (’The confidence interval is supposed to be ’+str(round

(min(lower, upper),2))+ ’ <= R <= ’+str(round(max(lower,

upper),2))+’, but R = ’ +str(round(R,2))+’.’)

else:

print (’Reject the null hypothesis for trends. There are too

many runs.’)

print (’The p-value for trends is %s’%round(p_value_trend ,3))

print (’The p-value for oscillation is %s’%round(1.-

p_value_trend, 3))

print (’The confidence interval is supposed to be ’+str(round

(min(lower, upper),2))+ ’ <= R <= ’+str(round(max(lower,



222 5.4. Run charts

upper),2))+’, but R = ’ +str(round(R,2))+’.’)

else:

print (’Failed to reject the null hypothesis for trends’)

if p_value_oscillation <alpha:

print (’Reject the null hypothesis for oscillation’)

print (’The p-value for trends is %s’%round(p_value_trend ,3))

print (’The p-value for oscillation is %s’%round(1.-

p_value_trend ,3))

print (’The confidence interval is ’+str(round(min(lower, upper)

,2))+ ’ <= R <= ’+str(round(max(lower, upper),2))+’ and R = ’

+str(round(R,2))+’.’)

#

****************************************************************************

#count runs above and below the median statistic

median = np.median(data.Run)

signs = [0]

for i in range(0, lenData ):

s = np.sign(data.Run[i]-median)

if s>0:

signs.append(1)

else:

signs.append(-1)

runs = 0

for i,j in enumerate(signs):

try:

if signs[i+1]!=signs[i]:

runs+=1

except:

pass

rundown = array([1. for i in signs if i==-1])

runup= array([1. for i in signs if i==1])

R = runs

R1 = rundown.sum()

R2 = runup.sum()

n1 = len(rundown)

n2 = len(runup)

n = lenData

ER = (2.*n1*n2/n) + 1.

VR = 2.*n1*n2*(2.*n1*n2 - n)/((n-1.)*(n**2))

lower = ER-Z*sqrt(VR)

upper = ER+Z*sqrt(VR)

Z0 = (R - ER)/sqrt(VR)

p_value_cluster = norm.cdf(Z0)

p_value_mixture = 1.- p_value_cluster

#print run statistics

print (’------------------------------------------------------’)

if p_value_cluster < alpha:

if R<lower:

print (’Reject the null hypothesis for clustering. There are

too few runs.’)

print (’The p-value for clustering is %s’%round(

p_value_cluster ,3))
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print (’The p-value for mixtures is %s’%round(1.-

p_value_cluster ,3))

print (’The confidence interval is supposed to be ’+str(round

(min(lower, upper),2))+ ’ <= R <= ’+str(round(max(lower,

upper),2))+’, but R = ’ +str(round(R,2))+’.’)

else:

print (’Reject the null hypothesis for clustering. There are

too many runs.’)

print (’The p-value for clustering is %s’%round(

p_value_cluster ,3))

print (’The p-value for mixtures is %s’%round(1.-

p_value_cluster ,3))

print (’The confidence interval is supposed to be ’+str(round

(min(lower, upper),2))+ ’ <= R <= ’+str(round(max(lower,

upper),2))+’, but R = ’ +str(round(R,2))+’.’)

else:

print (’Failed to reject the null hypothesis for clustering’)

if p_value_mixture <alpha:

print (’Reject the null hypothesis for mixtures’)

print (’The p-value for clustering is %s’%round(p_value_cluster

,3))

print (’The p-value for mixtures is %s’%round(1.-p_value_cluster

,3))

print (’The confidence interval is ’+str(round(min(lower, upper)

,2))+ ’ <= R <= ’+str(round(max(lower, upper),2))+’ and R = ’

+str(round(R,2))+’.’)

print (’------------------------------------------------------’)

How-To 5.6 (Run charts in Excel 2013)
Excel does not have a built-in option to create run charts, but we can manually
program the given formulas as we demonstrate in Examples 5.3 - 5.5.

Example 5.3 (Binary process data)
Metropolis Hospital monitors patient satisfaction. On the survey questionnaire, pa-
tients are asked whether they are satisfied (Y) or not satisfied (N) with their hospital
stay. The following is the sequence of the responses from the most recent ten
discharges:

𝑌 ,𝑌 ,𝑁 ,𝑌 ,𝑁 ,𝑁,𝑌 ,𝑌 ,𝑁 ,𝑌 (5.52)

The officials at Metropolis Hospital have asked us to help answer the question of
whether these responses are random. To answer this question, we begin by enu-
merating the runs in the data as follows:

𝑌 ,𝑌⏟ ⏞ 
R1

,

R2⏞ ⏟ 
𝑁 , 𝑌⏟ ⏞ 

R3

,

R4⏞ ⏟ 
𝑁,𝑁 , 𝑌 ,𝑌⏟ ⏞ 

R5

,

R6⏞ ⏟ 
𝑁 , 𝑌⏟ ⏞ 

R7

(5.53)

Expression 5.53 indicates that we have 7 runs meaning that 𝑅 = 7. We represent
run-downs (𝑅1,𝑅3,𝑅5, and 𝑅7) with 𝑦1. We notice that the number of data points
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in 𝑦1 corresponds to 𝑛1 = 6. We represent run-ups (𝑅2,𝑅4, and 𝑅6) with 𝑦2 where
𝑛2 = 4. By consulting reference tables of runs, when 𝑛1 = 6 and 𝑛2 = 4, we estab-
lish the confidence interval of 𝑝(𝑅 ≤ 2 = 0.010) and 𝑝(𝑅 > 8) = 1−𝑝(𝑅 ≤ 8) = 0.024.
Given that 𝑅 = 7 falls within this confidence interval, we fail to reject the null hy-
pothesis that the sequence of patient responses is random.

Example 5.4 (Non-metric data from run charts)
We revisit the run chart depicted in Figure 5.7 and attempt to identify out-of-control
behaviors in this chart. We start by counting the number of runs above and below
the median, as we illustrate in Figure 5.9.

Figure 5.9: Counting the number of runs in the chart portrayed in Figure 5.7

From Figure 5.9, we identify 9 run-ups with 20 data points. We represent this
information with 𝑦1 = 9 and 𝑛1 = 20. Coincidentally, the information for run-downs
is identical as follows: 𝑦2 = 9 and 𝑛2 = 20. The total number of runs is given by
𝑅 = 𝑦1 + 𝑦2 = 9 + 9 = 18. We use Equations 5.45 - 5.47 to construct the following
confidence interval:

𝐸(𝑅) = 21 (5.54)
𝑉 (𝑅) = 9.74 (5.55)
|𝑍 | = 1.96 (5.56)

15 ≤ 𝑅 ≤ 27 (5.57)

We set the significance level to 𝛼 = 0.05. Given that 𝑅 = 18 falls within the resulting
confidence interval, we fail to reject the null hypothesis that this sequence is
random. We compute the corresponding p-value for clustering as follows:

𝑝-𝑣𝑎𝑙𝑢𝑒 ≡Θ−1(𝑍0) = 0.168 (5.58)

where 𝑍0 is the test statistic obtained this way:

𝑍0 =
18− 21
√
9.74

= −0.96108 (5.59)

Since 𝑝-𝑣𝑎𝑙𝑢𝑒 > 0.05, we reject the null hypothesis that the process does not have
clusters. The p-value for mixtures is given by 1− 0.168 = 0.832, which leads us to
conclude that there is no statistically significant process mixture in this example.



Chapter 5. Tools related to control charts 225

Example 5.5 (Metric data from run charts)
Let us revisit Example 5.4, but this time investigate the randomness in the sequence
of successive numerical differences using the data in Table 5.5.

Table 5.5: Data related to the run chart in Figure 5.9

Sample Data Sample Data

1 66.36 21 33.92
2 36.08 22 48.2
3 45.72 23 31.2
4 69.2 24 36.24
5 5.0 25 52.0
6 21.64 26 71.6
7 42.56 27 63.92
8 19.56 28 32.92
9 44.12 29 25.52
10 51.0 30 27.0
11 59.84 31 28.88
12 51.28 32 43.16
13 13.36 33 61.04
14 63.24 34 47.36
15 41.4 35 26.32
16 47.32 36 14.84
17 48.0 37 13.04
18 71.96 38 64.12
19 30.72 39 66.24
20 21.04 40 11.96

We begin by determining the signs of the running differences, as illustrated in Table
5.6. This table has two derived columns. We use the column of 𝑆𝐼𝐺𝑁 to track
the signs of the differences and the column of 𝐶𝑂𝑈𝑁𝑇 𝑆𝐼𝐺𝑁 to identify runs.
For example, we determined the sign in cell B3 using the 𝑆𝐼𝐺𝑁 () function in Excel
as follows: 𝑆𝐼𝐺𝑁 (36.08 − 66.36) = −. Likewise, we obtained the sign in cell B4
this way: 𝑆𝐼𝐺𝑁 (45.72− 36.08) = +. To automate this procedure, we encoded the
following formula in cell B3:

= 𝐼𝐹(𝑆𝐼𝐺𝑁 (𝐴3−𝐴2) = 1,” + ”,”− ”) (5.60)

Next, we dragged down this formula to populate the rest of the signs. In the
𝐶𝑂𝑈𝑁𝑇 𝑆𝐼𝐺𝑁 column, we encoded 1 if a run existed per Definition 5.2. For
example, the value of 1 in cell C3 was obtained using 𝐼𝐹(𝐵4 = 𝐵5,0,1). Dragging
down this formula allowed us to populate the rest of the values. The sum of the
𝐶𝑂𝑈𝑁𝑇 𝑆𝐼𝐺𝑁 column gave us the total number of runs 𝑅. To find the number in
the run-ups (+) or 𝑛1, we used this formula:

= 𝐶𝑂𝑈𝑁𝑇 𝐼𝐹(𝐵3 : 𝐵41,” + ”) (5.61)

Correspondingly, we found the number of the run-downs(-) or 𝑛2 like this:

= 𝐶𝑂𝑈𝑁𝑇 𝐼𝐹(𝐵3 : 𝐵41,”− ”) (5.62)
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In the end, we determined that 𝑅 = 19, 𝑛1 = 22, and 𝑛2 = 17.

Table 5.6: A spreadsheet setup for creating run tests of the data in Table 5.5

A B C

1 Data SIGN COUNT SIGN

2 66.36

3 36.08 - 1

4 45.72 + 0

5 69.2 + 1

6 5.0 - 1

7 21.64 + 0

8 42.56 + 1

9 19.56 - 1

10 44.12 + 0

11 51.0 + 1

. . . . . . . . . . . .

Finally, we applied the formulas in Equations 5.45, 5.48, and 5.49 to find:

𝐸(𝑅) = 26.3 (5.63)
𝑉 (𝑅) = 6.78 (5.64)
|𝑍 | = 1.96 (5.65)

21.2 ≤ 𝑅 ≤ 31.4 (5.66)

Since 𝑅 = 19 falls outside of the confidence interval, we reject the null hypothesis
at the significance level of 0.05. Additionally, since 𝑅 < 𝐸(𝑅) − |𝑍 |

√︀
𝑉 (𝑅), that is

19 < 21.2, we conclude that a trend is likely in the process. To estimate the 𝑝-
𝑣𝑎𝑙𝑢𝑒 for the trend, we proceed this way:

𝑍0 =
19− 26.3
√
6.78

= −2.814 (5.67)

We obtain the probability of interest this way:

𝑝-𝑣𝑎𝑙𝑢𝑒 ≡Θ−1(𝑍0) = 0.002 (5.68)

Since 𝑝-𝑣𝑎𝑙𝑢𝑒 < 0.05, we reject the null hypothesis that there is no trend in the
data. We obtain the 𝑝-𝑣𝑎𝑙𝑢𝑒 for oscillation by 1 − 0.002 = 0.998. Since 𝑝-𝑣𝑎𝑙𝑢𝑒
> 0.05, we conclude that no statistically significant oscillation exists in this process.
By following instructions in How-To 5.4, we reproduced similar results in Minitab, as
portrayed in Figure 5.10. We used a subgroup of size 1.
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Figure 5.10: The run chart in Minitab based on the data in Table 5.5

The boxed area in Figure 5.10 shows sequences that exhibit trend-like behaviors.
As noted earlier, unlike control charts, run charts don’t allow us to pinpoint special
cause variation to a particular sample number.
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5.5 EXERCISES

1. At the confidence interval of 99.73%, what is the LDL of an ANOM chart in Minitab
with p = 0.10, the constant sample size of 100, and 10 health care organizations in
the study?

2. From an audit of 30 orders for the diagnostic test Z, you found the average entry
time in the CPOE system to be 7 minutes with 𝑅̄ = 3. Given LSL = 5 minutes and
USL = 10 minutes:

(a) What is the capability of this process?

(b) What can you conclude about the central tendency of this process?

3. After further analysis, it was determined that hospitals with the IDs of 3, 8, and 9
were not in the same statistical state as the rest of the hospitals. Remove these
hospitals from Table 5.2. Next,

(a) Create a new funnel chart using Excel or Python

(b) Approximate your results using the ANOM chart in Minitab.

(c) Estimate the 𝐶𝑝𝑢 ratio of the process given 𝑈𝑆𝐿 = 15%.

(d) What can you conclude?

4. From 25 samples, each with size 10, you estimated that your hospital’s EHR av-
erage downtime was 30 minutes with the standard deviation of 2 minutes. Your
process is assumed stable and normally distributed. Given 𝐿𝑆𝐿 = 10 minutes and
𝑈𝑆𝐿 = 45 minutes:

(a) What is the potential capability of the system?

(b) What is the actual capability of the system?

(c) What is the percentage of the allowed bandwidth is the process using?

(d) What is the probability of observing a downtime period longer than 45 min-
utes?

5. Using Excel or Python, reproduce the run statistics in Examples 5.4 and 5.5.

6. The Chief Nursing Officer (CNO) at Metropolis Hospital has just asked you to help
create an appropriate monitoring mechanism for urinary tract infections (UTIs) at
the hospital. The CNO knows that UTIs are rare at this hospital and, therefore
would like you to monitor the number of days between events. The CNO handed
you the data presented in Table 5.7.

(a) Create an appropriate control chart

(b) Create a corresponding run chart

(c) Compare and contrast your results. What can you conclude?
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Table 5.7: Days between UTI infections at Metropolis Hospital, 2014 - 2018

UTI#
Days

UTI#
Days

Between Between

1 61 17 25
2 46 18 17
3 46 19 15
4 102 20 35
5 38 21 14
6 11 22 20
7 22 23 24
8 91 24 62
9 18 25 31
10 31 26 60
11 77 27 18
12 17 28 43
13 94 29 30
14 2 30 16
15 31 31 43
16 66 32 29

7. The Chief Financial Officer (CFO) at Central City Hospital would like to start mon-
itoring the costs for total hip replacements. Table 5.8 presents samples of 40 indi-
vidual patients. Using Excel, create appropriate control and run charts for the CFO.
What can you conclude from both charts?

8. At Gotham Hospital, the CIO keeps track of the queue time of IT tickets. Table 5.9
portrays the samples that the manager has collected. Use this data to create an
appropriate run and control chart.

(a) What new insights did the run chart reveal as compared to control charts?

(b) Is the process capable of meeting USL = 180 minutes? Show your work and
explain your results.

9. The Chief Medical Officer (CMO) at Metropolis Hospital keeps track of the time to
extubation of ICU patients. Table 5.10 presents monthly sample statistics of this
process. The sample size is 𝑛 = 13, 𝜇 = 6, and 𝜎 = 3. Create appropriate control
charts, with and without the standards.

(a) What can you conclude about the stability of the process?

(b) What can you infer about the capability of the process given specification limits
set to 𝜇±𝐿𝜎 where 𝐿 = 2.878?

(c) Any ideas about how to improve the stability and capability of the process?
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Table 5.8: Costs in thousand for total hip replacements at Central City Hospital, 2018

Sample# X Sample# X

1 34 21 33
2 41 22 35
3 40 23 28
4 36 24 39
5 37 25 37
6 35 26 36
7 42 27 36
8 37 28 48
9 31 29 39

10 42 30 33
11 44 31 27
12 35 32 28
13 37 33 25
14 26 34 34
15 27 35 42
16 49 36 31
17 29 37 47
18 30 38 29
19 40 39 38
20 39 40 37

10. Table 5.11 presents the frequency of the monthly overrides of critical alerts in the
CPOE system at Metro City Hospital.

(a) Using Excel or Python, create the corresponding run chart. What out-of-
control behaviors can you visually detect?

(b) Use Excel or Python to calculate run statistics and any appropriate confidence
intervals with 𝛼 = 0.05. What can you conclude about the hypothesis of the
process being stable? Explain.

(c) Create an appropriate control chart.

(d) Compare and contrast the results from your control chart to those from the
run chart. What can you conclude?
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Table 5.9: Queue time in minutes, clinical IT tickets at Gotham Hospital, 2018

Sample# x1 x2 x3 x4 x5 x6 x7

1 110 45 84 86 58 75 38
2 80 70 110 148 32 84 42
3 22 111 37 100 109 62 63
4 82 67 55 30 129 63 57
5 74 40 82 59 82 43 84
6 38 40 139 100 59 44 85
7 80 123 52 80 48 45 96
8 76 97 54 64 65 75 110
9 64 47 66 135 65 79 91
10 80 35 47 59 50 119 44
11 65 76 118 64 38 49 66
12 60 67 41 86 73 128 88
13 105 49 87 68 105 63 42
14 104 138 50 67 102 54 122
15 51 54 58 81 79 143 61
16 47 60 90 61 66 58 145
17 61 94 104 60 83 50 96
18 32 79 79 99 61 70 84
19 32 101 111 85 48 103 40
20 55 23 97 123 58 47 54
21 46 32 47 55 88 103 80
22 52 130 63 32 50 141 105
23 108 66 104 101 103 100 95
24 90 38 64 64 107 44 84
25 102 48 51 93 55 53 58
26 33 64 57 110 41 114 67
27 37 81 84 90 69 113 52
28 99 96 80 112 84 131 32
29 94 89 114 80 41 96 83
30 78 44 118 58 75 107 63
31 74 123 61 95 109 68 114
32 102 45 63 49 127 78 70
33 79 130 122 51 32 61 62
34 102 31 68 97 68 109 99
35 122 62 56 87 38 70 77
36 81 104 85 52 57 40 28
37 79 43 86 72 57 110 50
38 49 95 71 132 90 112 82
39 200 46 99 150 90 103 80
40 83 72 46 80 44 87 36
41 123 44 108 73 56 51 86
42 96 114 106 33 56 90 101
43 37 53 44 46 50 70 82
44 71 82 112 85 102 43 119
45 126 37 40 31 47 100 120
46 104 87 113 79 59 79 59
47 89 95 54 64 61 102 66
48 61 44 50 59 33 63 73
49 43 53 66 94 95 82 80
50 45 65 56 84 62 24 107
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Table 5.10: Monthly sample statistics of the time to extubation process, Metropolis Hos-
pital, 2015-2018

Week # 𝑥 𝑠 Week # 𝑥 𝑠

1 5.2 2.4 16 6.3 3.8
2 6.3 4.5 17 6.9 3.4
3 6.5 3.9 18 7.2 5.8
4 7.5 2.9 19 6.5 2.4
5 6.9 3.1 20 6.1 3.1
6 5.7 3.3 21 5.6 2.7
7 7.3 2.1 22 5.3 2.7
8 6.8 3.9 23 7.9 7.9
9 5 2.3 24 5.8 3.6

10 6.8 2.5 25 3.4 2
11 5.9 3.7 26 6.7 4.6
12 8.3 3.5 27 7.5 2.7
13 5.1 4.2 28 6.2 2.3
14 5.5 3.7 29 5 3.4
15 5.6 3.2 30 6.1 1.9

Table 5.11: Critical alert overrides in the CPOE system at Metro City Hospital, 2014-2018

Month #Overrides Month #Overrides

1 42 21 40
2 46 22 47
3 17 23 47
4 25 24 9
5 41 25 44
6 38 26 24
7 23 27 8
8 55 28 23
9 28 29 36

10 12 30 55
11 14 31 63
12 26 32 60
13 28 33 53
14 32 34 26
15 11 35 26
16 53 36 13
17 20 37 11
18 5 38 8
19 8 39 29
20 15 40 75
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Table 12: Factors for Constructing Variable Control Charts

Chart for
Averages

Chart for standard deviations Chart for Ranges

Factors forControl Limits
Factors for:

Factors for CL Factors for Control LimitsCL Control Limits

𝑛
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

𝐴
2.121
1.732
1.500
1.342
1.225
1.134
1.061
1.000
0.949
0.905
0.866
0.832
0.802
0.775
0.750
0.728
0.707
0.688
0.671
0.655
0.640
0.626
0.612
0.600

𝐴2
1.880
1.023
0.729
0.577
0.483
0.419
0.373
0.337
0.308
0.285
0.266
0.249
0.235
0.223
0.212
0.203
0.194
0.187
0.180
0.173
0.167
0.162
0.157
0.153

𝐴3
2.659
1.954
1.628
1.427
1.287
1.182
1.099
1.032
0.975
0.927
0.886
0.850
0.817
0.789
0.763
0.739
0.718
0.698
0.680
0.663
0.647
0.633
0.619
0.606

𝑐4
0.7979
0.8862
0.9213
0.9400
0.9515
0.9594
0.9650
0.9693
0.9727
0.9754
0.9776
0.9794
0.9810
0.9823
0.9835
0.9845
0.9854
0.9862
0.9869
0.9876
0.9882
0.9887
0.9892
0.9896

𝐵3
0
0
0
0
0.030
0.118
0.185
0.239
0.284
0.321
0.354
0.382
0.406
0.428
0.448
0.466
0.482
0.497
0.510
0.523
0.534
0.545
0.555
0.565

𝐵4
3.267
2.568
2.266
2.089
1.970
1.882
1.815
1.761
1.716
1.679
1.646
1.618
1.594
1.572
1.552
1.534
1.518
1.503
1.490
1.477
1.466
1.455
1.445
1.435

𝐵5
0
0
0
0
0.029
0.113
0.179
0.232
0.276
0.313
0.346
0.374
0.399
0.421
0.440
0.458
0.475
0.490
0.504
0.516
0.528
0.539
0.549
0.559

𝐵6
2.606
2.276
2.088
1.964
1.874
1.806
1.751
1.707
1.669
1.637
1.610
1.585
1.563
1.544
1.526
1.511
1.496
1.483
1.470
1.459
1.448
1.438
1.429
1.420

𝑑2
1.128
1.693
2.059
2.326
2.534
2.704
2.847
2.970
3.078
3.173
3.258
3.336
3.407
3.472
3.532
3.588
3.640
3.689
3.735
3.778
3.819
3.858
3.895
3.931

1/𝑑2
0.8862
0.5908
0.4857
0.4299
0.3946
0.3698
0.3512
0.3367
0.3249
0.3152
0.3069
0.2998
0.2935
0.2880
0.2831
0.2787
0.2747
0.2711
0.2677
0.2647
0.2618
0.2592
0.2567
0.2544

𝑑3
0.852
0.888
0.879
0.864
0.848
0.833
0.819
0.807
0.797
0.787
0.778
0.770
0.763
0.756
0.750
0.744
0.738
0.733
0.728
0.724
0.719
0.715
0.712
0.708

𝐷1
0
0
0
0
0
0.206
0.389
0.548
0.688
0.813
0.924
1.026
1.119
1.204
1.283
1.357
1.425
1.490
1.550
1.607
1.661
1.712
1.761
1.807

𝐷2
3.686
4.357
4.697
4.918
5.078
5.203
5.306
5.392
5.467
5.533
5.593
5.646
5.695
5.739
5.781
5.819
5.855
5.888
5.920
5.950
5.978
6.004
6.030
6.055

𝐷3
0
0
0
0
0
0.076
0.137
0.184
0.223
0.256
0.284
0.307
0.328
0.347
0.363
0.378
0.392
0.404
0.415
0.425
0.435
0.444
0.452
0.460

𝐷4
3.266
2.574
2.281
2.114
2.003
1.924
1.863
1.816
1.777
1.744
1.716
1.693
1.672
1.653
1.637
1.622
1.608
1.596
1.585
1.575
1.565
1.556
1.548
1.540

For 𝑛 > 25:

𝐴 =
3
√
𝑛

𝑐4 ≈
4(𝑛− 1)
4𝑛− 3

𝐴3 =
𝐴
𝑐4

𝐵3 = 1− 3

𝑐4
√︀
2(𝑛− 1)

𝐵4 = 1+
3

𝑐4
√︀
2(𝑛− 1)

𝐵5 = 𝑐4 −
3

2(𝑛− 1)

𝐵6 = 𝑐4 +
3

2(𝑛− 1)

For 𝑛 ≤ 25 see Table 12.
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Actual capability, 204
Adjusted control charts, 162
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Multivariate processes, 185
Risk-adjusted, 162

Adjusting control charts, 51
Adjustment chart, 149
Analysis of means, see ANOM
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ANOM, 209, 210
ANOVA, 22, 42, 214

One-way ANOVA, 215

Two-way ANOVA, 216
APR-DRG, 164
ARIMA, 176, 178, 182, 185
ARL, 49
Assignable cause, 51
Autocorrelation, 173, 175
Autocorrelation function (ACF), 175
Autoregressive integrated moving average,

see ARIMA176
Average run length, see ARL

Capability
Improvement, 204

Capability analysis, 203
Case-mix, 162
Cause-and-effect diagrams, 16
Central limit theorem, 20
Checksheets, 16
Coefficient of determination, 41
Common cause variation, 51
Confidence interval, 24
Control charts, 16, 44

Attribute, 45
Autocorrelation, 51
Choosing 𝐿 , 49
Multivariate, 51
Time-weighted

CUSUM, 48
EWMA, 48
MA, 48

Variable, 45
Correlation, 37
Correlation analysis, 36
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Covariance, 39

Defect concentration diagram, 16
Defective parts per million, see DPMO
Degrees of freedom, 18
Demerit system, 51, 105
DMAIC, 13
DOE, 15, 37, 217
Donabedian, 11
DPMO, 16, 205

Electronic Health Record, 89
Examples

CBC orders, 84
Computer-assisted coding, 104
CPOE, 136, 143, 146, 154
Hospital denials, 95
Hospital-acquired conditions, 115, 118
ICU mortality rates, 166, 172
Medical coding, 76, 194
Potassium orders, 68
Substance X, 179

F-test, 35
False alarm, 29
Funnel charts, 209

Goodness-of-fit, 41

Histograms, 16
Hotelling, 162, 188
Hypothesis testing, 27

KPIV, 15
KPOV, 15

Lag, 175

Moving average, 151
Multivariate control charts, 185

Nelson’s transformation, 109

OCAP, 52
Operating-characteristic curves, 30
Out-of-control plan, see OCAP15

P-value, 29, 43

Paired t-test, 32
Pareto charts, 16
PCE, 15
PCR, 203–205, 207
PDCA, 13
PDSA, see PDCA
Pearson coefficient, 38
Phases of control charts

Phase I, 50, 61
Phase II, 50, 130

PID, 146
Point estimators, 23
Potential capability, 203
Power test, 30
Probability distributions

Bernoulli, 19, 20
Binomial, 19, 20
Chi-square, 21
Exponential, 19, 20
F-distribution, 21
Geometric, 19, 20
Normal, 19, 20
Poisson, 19, 20
t-distribution, 21

Probability plots, 22
Process capability analysis, 203
Process cycle efficiency, see PCE15
Process gain, 146
Process sampling, 17
Project charter, 15
Proportional–integral–derivative, see PID
Python scripts listing, 233

Quality
Dimensions, 10
Improvement, 11, 12
Variability, 11

Random sampling, 17
Rare events, 109, 110
Rational subgroups, 18, 48
Regression, 40
Repeated measures, 33
Residual plots, 42
Residuals, 173
Risk, 51, 162
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Risk-adjusted CUSUM charts, 170
Risk-adjusted p-charts, 163
Run charts, 217

Sample statistics
Mean, 18
Variance, 18
Standard deviation, 18

Scatter diagrams, 16, 36
Scatter plots, see Scatter diagrams16
Scenarios

Cardiac angiogram, 186
CBC orders, 174
Chronic respiratory conditions, 186
CPOE, 89, 131
Creatinine assays, 174
Data quality, 186
Document imaging technology, 89
Emergency severity index, 61
Health Informatics Department, 62
ICU mortality rates, 162
Labor and Delivery , 88
Parsonnet score, 163
Patient falls, 162
Picture Archiving and Communication

System, 61
Quality measures, 131
Relative value unit, 131
Restraints and seclusions, 89
Revenue cycle, 62
SNOMED-CT, 132
Surgery center, 88

Sensitizing rules, 46
Set point, 146
Shewhart, 44
Shewhart control charts, 60

Attribute, 61, 87
𝑐, 98, 105
𝑔, 108
ℎ, 108
𝑛𝑝, 89
𝑝, 89
𝑢, 98

Variable, 61
𝐼𝑚𝑅, 64

𝑋𝑏𝑎𝑟𝑅, 72
𝑋𝑏𝑎𝑟𝑆, 80

Shewhart cycle, see PDCA
Shewhart model, 175
SIPOC diagram, 15
Six-Sigma, 16
SPC, 10
Spearman coefficient, 39
Special cause variation, 48, 51
Specification limits, 203
Stationary, 175
Statistical process control (SPC), 16
Stem-and-leaf diagrams, 16
Structure-Process-Outcome model, 11
Sum of squares, 18

t-test, 28
Time series, 173
Time-Weighted Control Charts

𝐶𝑈𝑆𝑈𝑀, 132
𝐸𝑊𝑀𝐴, 140
𝑀𝐴, 151
Small shifts, 130

Total Quality Improvement (TQM), 15
Type I error, 29
Type II error , 29

Unimodal, 13

VOC, 15
Voice of the Customer, see VOC

WIP, 15
Work-in-Process, see WIP

Z-score, 21
Z-test, 28
zig-zag, 218
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